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All of One Lambda software products are designed to assist personnel experienced in HLA analysis by suggesting 

typing results. However, any clinical or diagnostic results must be carefully reviewed by a person qualified in HLA 

typing to assure correctness. This software may be used to aid in suggesting results, but should not be used as the 

sole method for determining reportable results. This software is meant as a laboratory aid, not as a source of de-

finitive results. The software design does not mitigate hazards associated with the software. The laboratory direc-

tor or technologist trained in histocompatibility testing is required to review all data to detect any problems with 

the software. Please note that this document was prepared in advance of the HLA Fusion software release. There-

fore, you may notice slight differences in the content of the actual application screens.

  For In Vitro Diagnostic Use.

21001 Kittridge Street, 
Canoga Park, CA 91303-2801
Tel: 818.702.0042 • Fax: 818.702.6904
www.onelambda.com

© 2015 Thermo Fisher Scientific Inc. All rights reserved. Luminex is a trademark of Luminex Corporation. Windows is a trademark of Microsoft Corporation. All other trademarks 

are the property of Thermo Fisher Scientific and its subsidiaries. Specifications, terms and pricing are subject to change. Not all products are available in all countries. Please con-

sult your local sales representative for details. 
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Introduction

What is HLA Fusion
™

Software?

HLA Fusion Software is a companion to One Lambda’s molecular typing and antibody screening 
products. This software runs in both stand-alone (on a single computer) and network environments. 

The features of this software allow you to do the following:

 Import raw data from the LABScan 100 flow analyzer

 Manually enter reaction patterns for Micro SSP and LABScan 3D, FlowPRA, LAT and LCT 
products

 Read ELISA results for LAT products

 Analyze the raw data and review the results in graphical form

 Adjust cut-off values to clarify the results

 Easily update product information, (i.e., new product and lot information)

 Search for specific data and create standard or custom reports

Note: Make sure you have downloaded the most up to date Nomenclature and/or Serology 
Equivalent files before you import catalogs or attempt to analyze sessions/samples.

Also, please make sure your collation of SQL Server matches the collation of client 
instances, (a collation encodes the rules governing the proper use of characters for a 
language or an alphabet). If you are not certain, please verify with your system/database 
administrator.
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Product Documentation and Update Files

The HLA Fusion help contains the most current HLA Fusion information and procedures. It is 
accessible from within the Fusion software application by pressing the F1 key or by selecting Help : 
HLA Fusion Help. The most recent copy of the HLA Fusion help file can also be downloaded from 
the OLI download website. Simply download the latest help file  and copy it into your local Fusion 
installation help folder, replacing the existing file ending in extension .CHM. 

While this document, the HLA Fusion User Manual, is kept as current as possible, it must be delivered 
well in advance of the software in order to allow for translations.

Generally, product update information, such as new features and issue resolution is located in the HLA 
Fusion Release Notes. If a software release is minor and the release notes are not updated, a README 
file is provided with a list of changes to the software and pertinent information that is not yet included 
in the user’s manual.

In addition, you can always access the most current product update information from the Help > 
Product Update Notes menu option within the HLA Fusion Software application, or from the OLI 
download site.
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Program Updates

Note: For best results, always make sure you are using the latest version of HLA Fusion™ 
Software.

HLA Fusion will automatically (if configured) detect if there is a software update/patch available and 
inform you of the availability. You may also obtain updates of HLA Fusion by request. Please contact 
your One Lambda, Inc. representative for a copy of the software, or see the Technical Support section 
below for more contact information. Product information updates, (catalog files, etc.) for HLA Fusion 
are available through your One Lambda Inc. representative, or from the One Lambda website:

http://download.onelambda.com
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Limitations of the Program

All One Lambda software products are designed to assist personnel experienced in HLA analysis by 
suggesting typing and antibody screening results. However, results must be carefully reviewed by a 
person qualified in HLA typing or antibody screening to assure correctness. This software may be 
used to aid in suggesting results, but should not be used as the sole method for determining 
reportable results. This software is meant as a laboratory aid, not as a source of definitive results.

For the reliability of patient information stored in the database, users must ensure that the identifier 
for each patient is unique and that each sample identifier is unique. The storage capacity of HLA 
Fusion is limited by your version of Microsoft SQL Server. Please see the Fusion Database Utility 
Users Guide, or the Microsoft website, (www.microsoft.com) for more information about the storage 
capacity of the various versions of SQL Server.

HLA Fusion assumes that data for each required input is in standard format that has not been 
modified. Raw data files must be in a Comma Separated Values (CSV) file format and must follow 
these guidelines:

 The data file is a CSV generated by LABScan 100, using software versions 2.3 or xPONENT 3.1
or xPONENT 4.2.

 All HD products must be acquired on software version  2.3, or xPONENT 3.1 or xPONENT 
4.2.

 The data file name,(also known as a Session ID) must be 40 characters or less in length and 
include the .csv file extension.

 The data is generated based on original, unmodified templates provided by One Lambda, Inc.

 The user is responsible for final assignments and must review all suggested results.
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Technical Support

For technical support or to report software problems, contact your One Lambda representative. From 
the United States, call 800-822-8824, or in the Greater Los Angeles Area, call 818-702-0042. Contact 
us by e-mail at: techsupport@onelambda.com

For system requirements, see the HLA Fusion Software Installation Guide.
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Scope of this Manual

This manual provides information on how to import raw data, make changes in cut-off values and other 
configuration and control adjustments as necessary for analysis, as well as how to track and report 
analysis results. It is very important to recognize that the QC, (Quality Control) data used with this 
program and the defaults set in this program are based on One Lambda’s experience with the product in 
a tightly-controlled research and development environment. Thus, a laboratory performing HLA typing 
or antibody screening in another environment may need to reset cut-off values to meet specific 
laboratory requirements. 

From the Main Menu of HLA Fusion, you can access the three major components of the program:

 Analyze Data

 Reports

 Manage Records

 Manage Samples

In addition, you may also access the following features:

 Patient Information

 Utilities

 Help

 Exit

This manual helps you start using One Lambda’s HLA Fusion. It includes an overview of the system and 
then takes you into the process of analyzing data. 

See the HLA Fusion Software Installation Guide for installation instructions.
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Navigation

This section describes the various ways to access the HLA Fusion software menus and functions, as 
well as how to use the Navigator tool to access and move between sessions and samples.
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Logging on to Fusion

1. Double-click the HLA Fusion Icon on your computer desktop. You can also open the 
program from the Windows menu: Start > Programs > One Lambda > HLA Fusion.

The Security Login dialog box is displayed.

Enter your HLA Fusion User Name and Password.

Click the Log In button to open the program. A message asks you to wait.

Note: The Database field displays the database to which you are currently connected.

TThhee FFuussiioonn SSeeccuurriittyy LLooggiinn SSccrreeeenn

DDaattaabbaassee tthhaatt
FFuussiioonn iiss uussiinngg

DDaattaabbaassee
CCoollllaattiioonn

VVeerrssiioonn ooff SSQQLL
SSeerrvveerr uusseedd
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Retrieving a Forgotten User Name or Password

 If you forget your HLA Fusion User Name, click the Forgot User Name link, enter your first 
and last name and select your lab role, (supervisor or technician). The system displays the 
user name matching the data you provide:

 If you forget your HLA Fusion password, click the Forgot Password link and answer the 
two security questions you were asked when you set up your user profile.

 The password is displayed when the questions are answered correctly.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 23

MMiinniimmuumm SSccrreeeenn RReessoolluuttiioonn

Key System Settings

Screen Resolution

HLA Fusion software requires a screen resolution of 1280 x 960. The software displays a message if 
your current resolution is less than the expected settings.

Note: You can choose to suppress this message through the Edit link on the General 
Configurations section of the Home page.

You can select Yes to have the continue to start the application. Or, you can select No to exit the 
program.

In addition, if your computer is running Microsoft® Windows 7® or Windows 8®, the text display size 
setting must be set to Smaller - 100% (default). Take these steps if you need to adjust this setting:

1. Right-click on the computer desktop. Select the Screen Resolution option.

The Screen Resolution window displays.

WWiinnddoowwss 77 SSccrreeeenn RReessoolluuttiioonn wwiinnddooww
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WWiinnddoowwss -- SSeelleeccttiinngg SSmmaalllleerr

Select the Make text and other items larger or smaller, (see previous).

2. Select Smaller sized text.

File Permissions

All HLA Fusion users must have read and write permissions to the following directories and files:

 C:\Program Files (x86)\One Lamda\

 OneLambda.Fusion.Interface.exe.config

 ReportMap.xml

 C:\OLI Fusion\(and all the sub directories and the files in these directories)
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User Interface

Fusion Home Pages

This user interface option gives you access to the individual product home pages, import data and view 
analysis windows. It also allows you to view or access system or product data, reference file downloads 
and configuration settings.

This interface is what you will see when you first log in to HLA Fusion if the default configuration is set.

Note: If the current page does not show updated information upon modifications or downloads, 
go back to the main Home page, then return to the product home page to see the 
changes.

TThhee FFuussiioonn
EExxpplloorreerr ––

cclliicckk aannyy
bbuuttttoonn ttoo
ooppeenn tthhee

ccoorrrreessppoonndd--
iinngg pprroodduucctt

SSttaattuuss BBaarr

OOppeennss tthhee
UUsseerrss IInnffoo

SSccrreeeenn

OOppeennss tthhee NNaavviiggaattoorr
SSeeaarrcchh CCrriitteerriiaa

wwiinnddooww

GGrreeeenn iiff AAuuddiitt
LLooggggiinngg iiss oonn,,
RReedd iiff iitt’’ss ooffff

OOppeennss tthhee FFuussiioonn sseettuupp wwiinn--
ddooww ffoorr ggeenneerraall,, ((aauuddiitt ttrraaiill,,
aauuttoo--ddoowwnnllooaadd eennaabbllee,, ppaa--
ttiieenntt ttyyppee,, eettcc..)) pprriinntteerr,, UURRLL’’ss
aanndd ddiirreeccttoorryy ppaatthh sseettuupp

OOppeennss tthhee
pprriinntteerr sseettuupp
wwiinnddooww

OOppeennss tthhee RReeffeerreennccee
FFiillee UUppddaattee wwiinnddooww

OOppeennss tthhee CCaattaalloogg
MMaannaaggeemmeenntt wwiinnddoowwNNoottiiffiieess ooff CCaattaalloogg

UUppddaatteess
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To display the home page for one of the products listed in the bottom left area of the page, click the 
button or menu option.  For LABScreen:

 From the main Fusion home page, click the LABScreen button, or
click the LABScreen button on the HLA Fusion toolbar at the top of 
the screen.

OR,

 Select Analyze Data > LABScreen from the Fusion Menu Bar.

Notice how the screen changes to fit the selected One Lambda product?

Note: Migrated and upgraded databases also use the same interface.

If you want to make one of the product home pages the default home page so that each time you login to 
HLA Fusion, that particular home page is displayed, do the following:

1. On the top second row of the screen, click the               button.

OR,

2. Click the word Utilities on the Fusion Taskbar.

3. On the General Settings tab, click the drop-down 
arrow and select from the drop-down list in the 
Default Home Page field to select your default home 
page.

4. Click Save and then Close.
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TThhee FFuussiioonn NNaavviiggaattoorr TTrreeee

SSeessssiioonnss
iinn tthhee

NNaavviiggaattoorr

HHLLAA FFuussiioonn
PPrroodduuccttss

Launching Navigator

If the Navigator tab is not already displayed on the right of the application window, click the 
Show Navigator toolbar button to activate the Navigator function,

Or,

Move your cursor over the Navigator tab on the right border of the 
application window to slide the Navigator into view.

Navigator Tree

Using the Navigator tree, you can easily move between
analysis products, sessions, samples and test dates.

Note: Double-click on a session, or click the + sign to the left of the Catalog, Date or Product
module to display the list of sessions.

Click a sample name to display it in the analysis window.
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SSeessssiioonnss nnoott
yyeett aannaallyyzzeedd
aarree BBLLUUEE..

AAnnaallyyzzeedd
sseessssiioonnss aarree
BBLLAACCKK..

RReevviieewweedd//UUnnrreevviieewweedd SSeessssiioonnss

SSaammppllee FFaaiilleedd iinn BBaattcchh AAnnaallyyssiiss

Results Grouping

The sessions and samples displayed though the Navigator tool can be sorted by various criteria:

 Product type

 Session Date

 Catalog

 Test Date

The default is to group by Product. See the next few sections for details about the various display 
options.

Group by Product

The Navigator displays imported sessions for each product type, 
based on the date range and other criteria set in the Find
option. If you are already in the analysis mode for a certain 
product, just the sessions that fit within the date range for that 
product will display.

Click the + sign next to the product type you are interested in to
display its sessions.

 The sessions displayed in blue are the ones that have not yet been 
analyzed. Once you analyze a session, its color on the Navigator list 
changes to black.

 Click a session name to display the samples within that session. For LABType and LABScreen, the 
system also performs a batch analysis and displays the results in 
the Session Summary.

If a session sample is listed in Red, it means the 

sample failed in the Analysis.

 Click a Sample Name to display it in an analysis
window.
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Group by Catalog

When you select the Catalog group option in the Navigator,
sessions are displayed in alphanumeric order by
Catalog Name.

Group by Test Date

When you select the Test Date group option, sessions are displayed in 
chronological order by their test dates.

Otherwise, the use of this tool is the same as described previously in Group 
by Product.

Group by Session Date

When you select the Session Date option, sessions are displayed in order of 
their creation dates.

Otherwise, the use of this tool is the same as described above in Group by Product

GGrroouupp bbyy CCaattaalloogg
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MMeennuu BBaarr:: SSaammppllee

Accessing HLA Fusion
™

Software Functions

Main Menu Options

You can access HLA Fusion functionality at any time from the toolbar’s Main Menu, which is displayed 
at the top of all HLA Fusion application windows. See the following sections for a list of the options 
available under each main menu item.

Analyze Data

Each option under this menu item is either a molecular or antibody product for 
which you can import CSV files, or manually enter reactions and analyze data. For 
details, see the individual product analysis sections in this user manual.

Reports

When you select this menu item, the Reports Page is displayed, allowing you to create reports of your 
analysis data.

Data

When you select this menu item, a Data Window is displayed that allows you to manage, (i.e., delete,
archive, activate or move) sessions and samples, map session alleles to a new IMGT V3 nomenclature, 
and view/print log files of session data.

Sample

Options under this menu item pertain to importing, creating, managing, 
and exporting sample information. This is also the menu to use for 
managing Luminex test lists and for creating sample work lists and plate 
designs.

MMeennuu BBaarr:: AAnnaallyyzzee DDaattaa

OOppttiioonnss oonn tthhee FFuussiioonn MMeennuu BBaarr
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MMeennuu BBaarr:: HHeellpp

MMeennuu BBaarr:: UUttiilliittiieess

Patient Info

Options under this menu item pertain to importing patient/donor lists, 
managing individual patient/donor information and tracking patient antibody 

data.

Profile

There are options under this menu item for creating and managing your own user 
profile, lists of system users and privileges and lab information. There is also an 
option for switching between the home page options depending on your system and 
navigation preference.

Utilities   

The options under this menu item pertain 
to importing catalog, code and serology 
files, configuring the molecular and 
antibody products you analyze, 
setting up your HLA Fusion system, and 
system validation.

Help

This menu item allows you to access the following HLA Fusion 
Software information:

 Online help, which provides guidance in using HLA 
Fusion Software.

 Links to tutorial, “Show Me” videos.

 Notification of updates and a description of new
features in the latest HLA Fusion software.

MMeennuu BBaarr:: PPaattiieenntt IInnffoo

MMeennuu BBaarr:: PPrrooffiillee
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 Dynamically updated Frequently Asked Questions (FAQ’s) about HLA Fusion software.

 The build and version number of the HLA Fusion Software application you are currently using.

Note: The online help can be accessed from anywhere within the HLA Fusion application when 
you press the key on your keyboard. Occasionally, updates are made to the online help 
between releases of the HLA Fusion. To ensure you have the most current help file, check 
the OLI download site
at:download.onelambda.com/pub/tray_info/Windows/HLA_Fusion_Catalogs/Documen
t/

Exit

When you select this menu item, a dialog box displays that allows you 
either to select Yes to exit and close the HLA Fusion application, or select 
No to keep the current session open.

Toolbar Buttons

HLA Fusion provides a toolbar, displayed just below the main menu bar options with access to 
commonly used functions.

 You can also hover your mouse over the buttons and a label will pop-up with the name of each 
button.

 Please note that some of these buttons are only available to use when you’re on an Analysis 
Screen.

The following table describes each toolbar button:

EExxiitt CCoonnffiirrmmaattiioonn MMeessssaaggee

FFuussiioonn TToooollbbaarr bbuuttttoonnss



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 33

Click the Find button to open the HLA Fusion Search 
Window to look for records using various criteria. 

You can choose to search by Patient ID, Sample ID, Session ID, 
Catalog ID, (and specificity), or Other. 

Other allows you to provide multiple search criteria including: date 
range, session status, and catalog type.

The Find dialog box also allows you to modify the Navigator Session sort and display criteria.

The Side by Side Comparison and Related Records buttons are visible only during sample 
analysis.

Button Name

Home

Find

Print 

Print Preview

Print Screen

Magnify

Reports

Show 

Navigator

Patient

Related

Records

Side by Side 

Comparison

Other Buttons and Controls

Product Data Analysis

Sample Navigation Tools (Only visible during sample analysis).
The <<Summary link returns to the associated sample 
summary table.

Displays the date of 
the current sample in 
the analysis window.
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EExxaammppllee ooff PPrriinntt RReeppoorrtt OOppttiioonnss

AAfftteerr cchhoooossiinngg yyoouurr sseeaarrcchh ccrriitteerriiaa,, cclliicckk tthhee
FFiinndd bbuuttttoonn ttoo bbeeggiinn tthhee sseeaarrcchh..

SSeett tthhee oorrddeerr
tthhaatt yyoouurr
sseeaarrcchh rreessuullttss
wwiillll bbee ddiiss--
ppllaayyeedd..

CChhoooossee wwhhiicchh
iinnffoorrmmaattiioonn
yyoouu wwaanntt ttoo bbee
sshhoowwnn..

SSeelleecctt tthheessee
sseeaarrcchh ccrriitteerriiaa

ffoorr bbaassiicc
sseeaarrcchhiinngg..

SSeelleecctt OOtthheerr ttoo
eennaabbllee tthhee SSoorrtt

aanndd FFiieelldd ddiiss--
ppllaayyss..

SSeeaarrcchh bbyy
DDaattee rraannggee,,
SSeessssiioonn SSttaa--
ttuuss,, oorr CCaattaa--

lloogg ttyyppee..

FFuussiioonn SSeeaarrcchh SSccrreeeenn

Note: The date range set here, in the Session Date field, is used as the default date range 
throughout HLA Fusion, such as in the Navigator and Reports windows. Each time you 
change it, and click the Find button, the default changes for the rest of the application.

Print Report

From any Analysis Screen, you can click the Print       
button to display a list of the reports that you can print,(the 
reports listed are specific to the product you are currently 
analyzing, so what you see in the example here may be 
different). If you have set up a default printer, (configured 
through Utilities > Printer Setup) the selected report is 
automatically sent to the specified printer. Otherwise, a
dialog box is displayed from which you can select a printer.
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EExxaammppllee ooff PPrreevviieeww RReeppoorrtt OOppttiioonnss

EExxaammppllee ooff PPrriinntt SSccrreeeenn RReessuullttss

Preview Report

From any Analysis Screen, click the Preview Report
button to display a list of reports you can check out before 
printing—reports listed are specific to the product you are 
currently analyzing. The reports are displayed in a preview 
window. Use the Print and Export buttons in the 
preview window to output the report in the selected format. 

Click the Close button at the upper right of the screen to 
exit the preview window.

Print Screen

From any Analysis Screen, click the Print Screen button to open a new window containing a 

screen shot of the current analysis window. Click the Print button, (top, left corner) to send the 
screen shot directly to the printer.

To close this window, click the Exit button or the Close button.
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Magnify

From any Analysis Window, click the Magnify button to activate the magnifying glass and 
enlarge any section of the window. Use your mouse to move the magnifier and use the arrow keys on 
your computer keyboard to increase or decrease the height and width of the magnified area. 

Click anywhere on the screen to deactivate the magnifying glass.

Show Navigator

If the Fusion Navigator, (normally displayed on the right side of the application window) is not visible, 

click the Show Navigator button on the toolbar. Once the Navigator tab is displayed, move your 
cursor over it to slide the Navigator panel open.

MMaaggnniiffyy aann AArreeaa

TThhee FFuussiioonn

NNaavviiggaattoorr
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PPaattiieenntt//DDoonnoorr IInnffoorrmmaattiioonn SSccrreeeenn

Patient/Donor Information

From any Analysis Screen, click the Patient button to display the Patient/Donor 
Information Screen where you can enter or edit information related to a patient or donor and 
associate it with the current sample.

You can also open the Patient/Donor Information screen at any time by 
clicking Patient Info on the Fusion Menu Bar, followed by Manage 
Patient.
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BBeeggiinn SSiiddee--bbyy--SSiiddee AAnnaallyyssiiss

Related Records

A Related Record is a sample that is associated in some way with the current sample or patient. 

From any Analysis Screen, click the Related Records button to load all records related to the 
current sample into the drop-down list in the Sample ID field. Use the sample navigation arrows to 
display the analysis of each related record, one-by-one. 

To exit from the Related Records mode and return to the previous analysis screen, click the 
<<Summary link to the left of the Sample ID field at the top of the screen.

Note: This function can be also accessed by right-clicking a sample in the Fusion Navigator. 
Review the product-specific sections of this manual for more information about using this 
feature.

Side-by-Side Analysis

From any Analysis Screen click the Side-by-Side Analysis button on the Fusion toolbar to 
compare the current sample analysis, (with a brown background) with previous analysis sessions for 
the same Sample ID.

 Select a previous sample analysis from the displayed list to compare to the current one. The two 
analysis windows are then displayed together for comparison. 

 Each window can be resized and moved by dragging and dropping. Click again on the Side-by-

Side Analysis button to cancel the comparison display.
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CCuurrrreenntt
AAnnaallyyssiiss

PPrreevviioouuss
AAnnaallyyssiiss

SSiiddee--bbyy--SSiiddee AAnnaallyyssiiss VViieeww

PPrroodduucctt GGrroouupp

TThhee SSaammppllee NNaavviiggaattoorr

TThhee SSaammpplleeIIDD DDrroopp--ddoowwnn

Note: This function can also be accessed by right-clicking a sample in the Fusion Navigator. 

Product Data Analysis

Click any of the Product Data Analysis 

buttons on the Fusion toolbar to display 
that product’s home page, import a session file, manually enter a 
session, or display and select from the Navigator List of 
previously imported sessions for that product.

 You can also click on any of the Fusion products located 
in the Product Group at the top upper left side of the 
Home screen to open a product’s home page.

Sample Navigation

The Sample Navigation tools, (only accessible from an Analysis Screen) give you access to all the 
samples in the current session. You can select a different sample within the same session either by 
selecting from the drop-down list in the Sample ID field, or by clicking the forward/back arrow 
buttons next to the drop-down field.
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SSaammppllee DDaattee

SSaammppllee DDrroopp--ddoowwnn

Clicking on the drop-downarrow displays all the samples within the current session, as shown 
below:

 Selecting a sample from this list in the Sample ID field makes that sample the active sample in
the analysis window. Alternatively, you can use the forward or back arrow buttons to select 
different samples.

 Click this button to go to the first sample.  Click this button to go to the last sample

 Clicking <<Summary takes you back to the session summary for the current sample.

Sample Date

For the sample currently being analyzed, the Sample Date field 
displays the date the sample was obtained.

The sample date can be set and auto-filled from the Session Import 
table.
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LABType Analysis

The HLA Fusion™ LABType® analysis module analyzes Luminex CSV output files for LABType 
products, including HD output files. Analysis results are based on catalog specifications, NMDP or 
Local codes and serology equivalent reference files.  All of which can be downloaded and used with the 
Fusion software.

A few things should be completed or verified before you start an analysis session: 

 Make sure you have the latest catalog files, as well as NMDP code, local code,(if used) or 
serology equivalent reference files before you analyze. You can download or update existing 
catalogs from the LABType Home Page.

 View and modify global product configuration settings prior to starting analysis. Global settings 
are displayed and be can be modified on the LABType Home Page, or through the Utilities 
menu. Global settings apply across all newly imported sessions.

 Save time importing CSV files by verifying that the default URL’s and directory or folder paths 
are pointing to the locations where these files are commonly stored on your system or network. 
These settings can also be modified in the General Configurations section of the Fusion Explorer 
Home page.

 You can set HLA Fusion to remain on a sample that you’ve just saved or confirmed rather than 
automatically moving to the next sample by changing this setting in the General Configurations 
section of the Fusion Explorer Home page.

Note: Some of the above tasks require Supervisor User privileges. You may have to verify with 
your Supervisor that these tasks have been completed.
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Overview of the LABType
Analysis Process

After importing session(s), check the Summary Table for low Positive
Control and low Bead Counts.  Consider deleting those samples.

Check the lower left graph of the Analysis Screen for
close reactions –just above or below the cut-off points.

Also check the Control and Bead Analysis Tabs.

Use the Force tab to help review homozygous
and rare allele results, (lower right quadrant).

Look at the reaction table to review allele
reactivity patterns, (upper left quadrant).

Check the Close Reaction Box to further
finalize assignments, (lower right quadrant).

Make any necessary cut-off adjustments,
(upper right or lower left quadrants).

Make final allele pair, serology and/or
coded assignments, (lower right quadrant).
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Start LABType Analysis

Importing LABType Session Data (Non HD)

 Click the LABType button on the 
Product Group Panel on the Home 

Screen, the LABType button on 
the Fusion toolbar, or click Analyze
Data on the toolbar and select
LABType.

The LABType Home Page is now displayed:

Note: The Reference file Updates function does not work for NMDP or seroequivalent files.

CClliicckk tthheessee lliinnkkss ttoo
ddiissppllaayy CCaattaalloogg,,
WWoorrkksshheeeett aanndd
PPrroobbee//PPrriimmeerr
ddooccuummeennttss

CClliicckk tthhee GGeeaarr bbuuttttoonn ttoo mmooddiiffyy
tthhee LLAABBTTyyppee GGlloobbaall SSeettttiinnggss..

CClliicckk ttoo ddoowwnn--
llooaadd uuppddaatteedd
RReeffeerreennccee FFiilleess..

CClliicckk ttoo ooppeenn tthhee
CCaattaalloogg MMaannaaggeerr..

IIff tthhee ccooddee bbeeiinngg
uusseedd iiss NNMMDDPP,,
tthhee vveerrssiioonn iiss
lliisstteedd hheerree..
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SSeelleeccttiinngg//IImmppoorrttiinngg CCSSVV FFiilleess

To open the Session screen, click the “Include Imported” checkbox on the upper left hand side of the 
LABType Home Page. The Session screen will then appear (below):

Note: Open worksheets and probe/primer sheets to verify the accuracy of revision numbers, 
(these documents do not contain a revision number in their filename).

2. Click the small Folder Icon and select a 
session(s) from the Select CSV Files screen.

DDoouubbllee--cclliicckk aa SSaammppllee
IIDD ttoo sseeee tthhee LLAABBTTyyppee
ssaammppllee lliisstt ((AA ssaammppllee IIDD

ccaann bbee eeddiitteedd))..

LLuummiinneexx
CCSSVV

SSeessssiioonn
ffiilleess

CClliicckk ttoo
bbrroowwssee
ffoorr CCSSVV

ffiilleess..

LLAABBTTyyppee ttoooollbbaarr
bbuuttttoonn

DDaattee iiss hhiigghhlliigghhtteedd
iinn yyyeeelll lllooowww iiff rreeggiioonnaall

sseettttiinnggss ddoo nnoott mmaattcchh
bbeettwweeeenn tthhee CCSSVV
ffiillee aanndd FFuussiioonn..

CCaattaalloogg IIDD

AAlllloowwss
ssuupppplleemmeennttaall
aannaallyyssiiss,, ((ii..ee..,, BB
llooccuuss wwiitthh BBww44))

TToo lliisstt
pprreevviioouussllyy
iimmppoorrtteedd
CCSSVV ffiilleess

NNoommeennccllaattuurree//
IIMMGGTT vveerrssiioonn

AAssssiiggnn PPaattiieenntt
TTyyppee ttoo

ccoorrrreessppoonnddiinngg
PPaattiieenntt IIDDSSeessssiioonn IIDD

SSeettss tthhee
PPaattiieenntt IIDD ttoo

bbee tthhee ssaammee aass
tthhee SSaammppllee IIDD

LLiissttss PPoossiittiivvee
CCoonnttrrooll ((PPCC))

vvaalluueess ffoorr eeaacchh
ssaammppllee

SSeelleecctt AAuuttoo--
aannaallyyssiiss ttoo aannaallyyzzee
aallll sseessssiioonn ssaammpplleess

wwhheenn iimmppoorrtteedd

SSaammppllee//
PPaattiieenntt
ddeettaaiillss

DDoouubbllee--cclliicckk
aa PPaattiieenntt IIDD ttoo sseeee

tthhee ccuurrrreenntt
ppaattiieenntt lliisstt..
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SSeessssiioonn II..DD.. ffiieelldd

LLAABBTTyyppee SSeessssiioonn -- PPaattiieenntt//SSaammppllee DDeettaaiillss ttaabbllee

Note: HLA Fusion converts Luminex-generated CSV file data, such as date and time, to the local 
regional code if a regional code is specified in the CSV file. (A regional code cannot be 

specified for CSV files created with Luminex software version 2.2 or earlier.) If the first date 
field is highlighted yellow, it indicates that Fusion detected a regional code mismatch. In 
this case, it is recommended that you use the drop-down selector in the second date field 
to choose the appropriate date, taking into consideration regional date format 
differences.

3. Select a file from the list of CSV files to import, or click the Folder icon above the list to 
browse to LABType CSV file(s) on your system/network. If samples in a session have a positive 
control value below the minimum setting, they are flagged so you can easily select and delete 
them from the session.

Note: You may see CSV files for products other than LABType, or other CSV files. This means 
that you must first click on a sub-folder for LABType, or that your LABType session files 
are not contained within the directory to which HLA Fusion is pointing.

4. HLA Fusion assigns a Session ID, (the CSV filename) automatically. Optionally, you can edit the 
Session ID field. The ID can be alphanumeric, (contain letters and numbers) and will be listed 
alphabetically with any other LABType session files in your database.

Note: A Session ID must be unique to the Fusion database. If the Session ID already exists, HLA 
Fusion prompts you to rename the session. It is also highly recommended that you do not 
use any special characters in this field since they may serve a specific purpose as field 
separators.

5. Click a CSV file to display its associated samples in the Sample/Patient Details table.
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CCaattaalloogg LLiissttiinngg

Note: The Supplemental button can be used to add sessions that have already been analyzed, to 
the current one for a combined analysis, (e.g., B7 sessions with B locus sessions). This 
does not work for combinations of cross loci sessions, (such as A locus and B locus).

6. If a sample is already associated with a patient, the Patient ID and any existing or related patient 
information is displayed.

To add patient information, do one of the following:

 To add patient data which is already stored in the system, double-
click in the Patient ID column of the Sample/Patient Details table, or 

 Click Patient Info on the Fusion Menu Bar and select Import 
Patient List to import the patient information file.

 To manually add patient data, type data directly into the patient-related fields in the table.

You can automatically assign the Sample ID to empty Patient ID fields 
by selecting the check box for Set empty Patient ID to Sample.

7. Select a Catalog file. The catalog file selection method varies depending on the CSV file and the 
catalog files you may have previously imported for LABType.

Note: If you need to import more catalogs, click the [Download] link on the LABtype Home Page. 
The Catalog drop-down list may not be immediately updated if you downloaded the 
catalogs during the current import session. You may need to click the Home button and 
then click the LABType button again to return to the import process.

 If the CSV file specifies a template name, (only applies to CSV files from Luminex 2.2 and later)

and one of the available catalog files is associated with that template, then all new sessions 
with the same template will auto-select that catalog.

As shown here, you can also select a different catalog file 
from the one that Fusion has selected by using the drop-
down list in the Catalog ID field and selecting any catalog 
file listed.

If there is no template match, the system then considers 
the closest bead match between the session and all 
available catalog files. If only one catalog file is a close 
match, it is automatically selected and you can check to 
see if there are any samples that have been flagged as 
having a low Positive Control, (PC) or low bead.
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CCaattaalloogg VVaalliiddaattiioonn

CCaattaalloogg AAssssoocciiaattiioonn

8. If there is more than one match, a catalog validation dialog box is displayed with the best bead 
matches. You can confirm the selected Catalog file by simply clicking the Close button. Or, you 
can double-click a catalog file name on the list of Suggested Catalogs.

Clicking the Detail button 
on the Catalog Validation screen 
opens the Mismatched Beads
window which lists which beads 
were not found in the Session 
and/or Catalog.

Click the OK button to close.

Following Catalog File Validation, Fusion may ask you 
if you would like to associate that template name with 
the specified catalog file.

If you click Yes to associate the two, the system 
automatically selects this catalog file for future imports 
of any CSV files that reference this template.

Note: If the incorrect catalog and template are associated, review the section, Associating 
Product Catalog Files and Luminex Templates, for instructions on removing the 
association.

Check to see if there are any samples that have been flagged as having a low Positive Control (PC) or low 
Bead Count; the rows of low PC or Low Bead Count samples are highlighted Gray.
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Click a sample to select it – then press the Delete Button to the upper right to remove it.

You may want to delete these samples because they often slow analysis. However, such removal means 
you can no longer track these samples.  Take the following steps if you want to delete any of these 
samples:

9. Click in the border to the left of the Well position column to highlight the entire row for the 
sample:

10. To remove the sample and prevent it from being imported as part of the session, press the Delete 
button (upper right side of the screen).

11. When session and sample information is verified, click Import. 

If you selected the Auto Analysis check box, the session is imported as well as 
analyzed when you click Import and it is displayed on the Fusion Navigator as an 
analyzed session.

You can continue importing Luminex Session Files, or you can click a session in the Navigator to start a 
Batch Analysis.

Note: Once a CSV file has been imported, it no longer displays on the Luminex Session Import list 
unless you select the Include Imported check box. This may be used to re-
import a session under a new name and/or user.

Oriental

11 10
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HHDD SSeessssiioonnss

SSeelleeccttiinngg HHDD SSeessssiioonn FFiilleess

Acquiring LABType Session Data (HD)

To display a listing of HD session(s) on the CSV File Name list:

1. Click the Folder icon. The Select 

CSV Files screen opens.  Note that you 

may need to open HD sessions from a 

location other than the default path for 

LABType files.  After clicking the Folder 

icon, browse to the location where the 

LABType HD files are stored on your 

system/network.

2. Click the Open button.

Note: HLA Fusion converts Luminex-generated CSV file data, such as date and time, to the local 
regional code if a regional code is specified in the CSV file. (A regional code cannot be 

specified for CSV files created with Luminex software versions 2.2 or earlier.) If the first date 
field is highlighted yellow, it indicates a regional code mismatch. In this case, it is 
recommended that you use the drop-down selector in the second date field to choose the 
appropriate date, taking into consideration regional date format differences.

3. Select an HD session from the CSV File Name list to display its 
associated samples in the Current Sample/Patient Details table, 
as shown below.
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HHDD SSeessssiioonn LLiissttiinngg ((LLuummiinneexx 22..22//22..33))

TThheerree sshhoouulldd bbee aa RRuunn
FFiillee ffoorr eevveerryy ssaammppllee iinn
aann HHDD SSeessssiioonn..

TThhee RRuunnFFiilleeIInnddeexx ffiillee
iiss uussuuaallllyy hhiiddddeenn..
TToo sseeee iitt,, sseelleecctt
SShhooww HHiiddddeenn FFiilleess
iinn WWiinnddoowwss >>>>
FFoollddeerr OOppttiioonnss

AA ccoonnvveerrtteedd HHDD
OOuuttppuutt ffiillee

OOrriiggiinnaall HHDD OOuuttppuutt ffiillee
((nnoott ccoonnvveerrtteedd))

Caution: Luminex 2.2/2.3: Make sure you select the CSV file from the same directory that 
contains all the run files and the run-index file, (generally a hidden file in the directory) that were 
output from the Luminex machine into a session folder. Each sample in the session must 
correlate to a run file in this directory. This is essential if the HD CSV file is not yet converted; 
HLA Fusion automatically converts any unconverted HD files during import, if the 
unconverted output file resides in the same location as the run files and run-index file for that 
session.

xPONENT 3.1: The output file can be located anywhere. There is no run index file. But the 
run files must be together in a directory that is structured with the session directory, and 
underneath that, the run files.

HHDD SSaammpplleess iinn tthhee ccuurrrreenntt SSaammppllee//PPaattiieenntt DDeettaaiillss ttaabbllee
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Fusion assigns a Session ID by default. Optionally, you can change the Session ID. If the HD file has not 
been converted, it will be named Output until it is imported, at which point it will have the name of the 
original output session folder, (regardless of whether you rename the folder) followed by “_HD.”

Note: A Session ID must be unique to the Fusion database. If the Session ID already exists, the 
software prompts you to rename the session. It is also highly recommended that you do 
not use any special characters in this field since they may serve a specific purpose as field 
separators.

Note: To see the RunFileIndex file if using Windows XP, open Windows Explorer and Click the 
Folders button.  Then, click View on the Windows Title bar and select Folder Options
from the drop-down menu. Now, click the View tab and scroll down to Hidden files and 
folders.  Select, Show hidden files and folders, and Exit.  When viewing a selection of 
CSV files, change the Files of type to All Files, to reveal the RunFileIndex file. In 
Windows Vista and Windows 7, open Windows Explorer and select Tools >> Folder 
Options.  Next, click on the View tab and select Show hidden files, folders and drives. If 
you rename a session, do not name it output as that is reserved for the original HD output 
file.

Note: The Supplemental button can be used to add other sessions to the current one, (e.g., 

supplementing B locus sessions with B7) for analysis. This does not work for combinations of 
different test types, (such as A locus and B locus).

If a sample is already associated with a patient, the Patient ID and any existing, related patient 
information, is displayed.

4. To add patient information, do one of the following:

 To add existing data from the system, double-click in the Patient ID column of the 
Sample/Patient Details table, or click the Patient List button on the toolbar. The 
Import Patient window is displayed, allowing you to import the patient information file. 

 To manually add patient data, simply type data into the patient-related fields of the table.

 You can assign the Sample ID to empty Patient ID fields by 
selecting the check box for Set empty Patient ID to 
Sample.

5. Select a catalog file. Your catalog selection method may be one of the following, depending on 
the CSV file and the catalog files you have imported for LABType:

Note: If there are no catalog files available for selection, or the one you want is not available, 
review the Utilities section of this manual for instructions on how to add new catalog files 
to the database.
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CCaattaalloogg TTeemmppllaattee AAssssoocciiaattiioonn

AA lliisstt ooff aallll
ccaattaalloogg ffiilleess

hhaavviinngg tthhee
ssaammee oorr aa

bbeetttteerr lleevveell
ooff mmaattcchheess..

TThhee lleetttteerr ““HH”” mmeeaannss tthhee ccaattaalloogg iiss HHDD..

 If the CSV file specifies a template name, (only applies to CSV files from Luminex 2.2 and later)

and one of the available catalog files is associated with that template, then that catalog file is 
automatically selected.  If you want to select a different catalog file, you can use the drop 
down list in the Catalog ID field to select from any other catalog files listed there.

 If there is no template match, the system then considers the closest bead match between the 
session and all available catalog files. A catalog validation dialog box is displayed. You can 
confirm the selected catalog file simply by clicking the Close button. Or, double-click 
another catalog name on the list of Suggested Catalogs.

Note: The catalogs listed in the validation dialog box for HD sessions may also include non-HD 
catalogs. You can identify an HD catalog by the ‘H’ in the name (e.g., RSSOH2B1_003_05).

6. Following catalog file validation, the system may ask if you’d like to associate the template name 
with the specified catalog file. If you associate the two, all new sessions with the same template 
will automatically select this catalog.
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Note: If the incorrect catalog and template are associated as in the above example, review the 
section, Associating Product Catalog Files and Luminex Templates for instructions on 
removing the association.

Check to see if there are any samples that have been flagged as having a low Positive Control (PC) or low 
Bead Count; the rows of low PC or low bead count samples are highlighted Gray.

You may want to delete these samples because they often slow analysis. However, such removal means 
you can no longer track these samples.

Take the following steps if you want to delete any of these samples:

7. Click in the Gray border area to the left of the Well position column to highlight the entire row 
for the sample.

8. Press the Delete button (upper right of screen) to delete the sample and prevent it from being 
imported as part of the session.

9. When session and sample information have been verified, click the Import button.

The session is now displayed in Blue at the top of the Navigator tree. If you 
selected the Auto Analysis check box, the session was imported and
analyzed when you clicked the Import button.

The session is now displayed in the Navigator as an Analyzed session.

You can continue importing more Luminex files, or you can click on a Session in the Navigator to start 
Batch Analysis.

Note: Once a CSV file has been imported, it no longer displays on the Luminex session import list 
unless you select the Include Imported CSV check box.

HHiigghhlliigghhtt aa SSaammppllee RRooww ffoorr DDeelleettiioonn

89
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Analyzing Exon 4+ Sessions

HLA Fusion allows you to analyze Exon 4+ data with generic HD or non-HD LABType samples to 
provide higher resolution results. You can apply Exon 4+ resolution to locus A, B or C typing data.

Please follow these steps to analyze LABType samples with Exon 4+ resolution:

1. On the home screen, click either the LABType button or the product icon:

The LABType home page is displayed.

2. Click the [Download] link on the upper right side of the LABType home page and download the 
catalogs you need to analyze generic A, B, and/or C locus and Exon 4+ LABType samples, (e.g.,
RSSO1E_001_00.cat).

3. Select files from the list of CSV files on the left side of the LABType Home Page that you want to 
import for supplement with Exon 4+ data.

 Or, click the Folder icon and browse to the LABType CSV file(s) on your 
system/network to locate and select CSV files.
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The LABType Session/Patient Details Table is displayed.

4. Import the sessions containing samples you want to supplement with Exon 4+ data by 
following the same process you have used to previously import CSV files into Fusion.

5. Use the Fusion LABType analysis window to analyze the samples you want to use in analysis 
with Exon 4+.

6. Click the LABType button to return to the LABType home page.

7. Make sure you downloaded the Exon 4+ catalog(s) (e.g., RSSO1E_001_00.cat). If you have 

not yet done so, click the [Download] link on the upper right side of the LABType home page 
and download the necessary catalog(s).

8. After the Exon 4+ catalog(s) have been added to your computer or network, select Exon 4+
sessions from the list of CSV files on the left side of the LABType home page.

 Or, click the Folder icon above the list to browse to the LABType CSV file(s) on your 
computer or network to locate and select Exon 4+ CSV files.

9. This will display the Exon 4+ samples in the Sessions Detail Table on the right side of the 
LABType window.

10. Click the Supplemental button, (please note that the Import button is not available for Exon 4+

sessions). The Supplemental Analysis window is displayed.
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The supplemental screen displays the grid of all the possible samples that can be combined with the 
current session. The colors in the legend represent the following:

 Mismatch or false reaction. For Exon 4+ a false sample is disabled: Pink

 Sample is ambiguous: Orange

 Found more than one sample for a locus: Light Blue

 Nomenclature date different: Light Yellow

 No related test available to combine: Light Gray

Make sure the samples you want associated for the supplemental analysis are selected.

Note: Only one sample can be associated with each Exon 4+ per locus. If there is more than one 
generic sample available for association with the Exon 4+ of a particular locus, the system 
by default selects the most recently created sample. You can select an older sample if 
desired.

Micro SSP data can be combined with Exon 4+ data only after it has been combined with 
LABType data. LABType combined with Exon 4+ cannot be combined with Micro SSP data.

11. Click the Import button.

The supplemental session and all associated samples are displayed in the Fusion Navigator where you 
can select them to analyze in the LABType analysis window.

SSuupppplleemmeennttaall SSeessssiioonn SSeelleeccttiioonn ((EExxoonn 44++))
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FFrreeee--ffoorrmm ccoommmmeennttss tthhaatt yyoouu ccaann eenntteerr hheerree..

FFuussiioonn rreeccoorrddss rreecceenntt aaccttiioonnss,, ssuucchh aass aaddjjuussttiinngg aa ccuutt--ooffff..

LABType Session Summary

The session summary page can be launched by clicking a session in the Navigation tree. It 
presents a preview of the analysis results, listing each sample in the session and corresponding 
batch analysis results. 

The Session Summary Field Chooser

LLAABBTTyyppee SSeessssiioonn SSuummmmaarryy PPaaggee

SSeessssiioonn SSuummmmaarryy ttaabbss

TThhee
SSuummmmaarryy

GGrraapphh
ddiissppllaayyss

ddaattaa ppooiinnttss
ffoorr eeaacchh
ssaammppllee..

TThhee FFiieelldd
CChhoooosseerr::

CClliicckk ttoo
iinncclluuddee oorr

eexxcclluuddee
ccoolluummnnss..

CClliicckk ttoo aassssiiggnn tthhee
aannaallyyssiiss rreessuullttss aass tthhee

ffiinnaall rreessuullttss ffoorr aallll
ssaammpplleess..

TToo aappppllyy PP oorr GG
ggrroouuppiinngg ttoo

ssaammpplleess iinn tthhee
sseessssiioonn tthhaatt hhaavvee

nnoott yyeett bbeeeenn
ssaavveedd..

SSeeaarrcchh tthhee
ssaammpplleess ffoorr XXXX

ccooddeess aanndd rreeppllaaccee
tthheemm wwiitthh

uuppddaatteedd NNMMDDPP
ccooddee..

Batch 

Print 

Screen

Click here to
open the 
Field 
Chooser.

Click the Field Chooser button on the far left side of the table 
headings. The Field Chooser appears. This allows you to select or 
clear the check boxes next to column headings to include or exclude 
those columns from the Summary Table. Selecting or clearing check 
boxes in this window instantly updates the table.

You can also rearrange the order of the fields by using your mouse 
pointer to drag and drop any field name to a new location on the 
Field Chooser.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 58

Second, click here 
to trigger analysis 
and PDF generation 
for each chosen 
sample. 

Batch Print Screen Row Selection

First, highlight 
rows of  sample 
data that you 
wish to see  
analyzed and 
reported. After PDFs are 

generated, a 
message appears.

When you close the Field Chooser, a message displays to let you choose whether or not to save any 
changes you’ve made. If you click Yes, your changes are saved for all future LABType Session Summaries 
on this same computer until further modifications are made and saved.

Note:   If you do not see a particular field available in the field chooser and you are sure it should be 
there, go to C:\HLA Fusion\temp and delete the file named Labtype_Layout.xml.

The Batch Print Screen Function

The Batch Print Screen icon on the bottom right allows you to select multiple rows of sample data to 

analyze. Each analysis is performed as a graphic  representation just like the LABType main screen with 

four quadrants. Each analysis is exported to a PDF file, one PDF file for each sample.

To use this feature, first use the mouse to select rows of sample data that are of interest by clicking down 

and dragging within the leftmost column directly under the Field Chooser button. A blue highlight will 

surround these chosen rows. Then click the Batch Print Screen icon near the lower rightmost corner 

of the screen. A series of analysis windows will flash by, and you will then be asked if you would like to 

examine the PDF files that were generated.
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TThhee PPrriinntt PPrreevviieeww SSccrreeeenn

PPrriinntt
PPrreevviieeww

ZZoooomm IInn
ttooooll

DDrroopp--ddoowwnn
ZZoooomm

ccoonnttrroollZZoooomm OOuutt
ttooooll

VViieeww wwhhoollee
ppaaggee

MMaarrggiinn
WWiiddtthh
view

PPaaggee WWiiddtthh
vviieewwDDyynnaammiicc

ZZoooomm
ttooooll

SSnnaappsshhoott
TToooollSSeenndd

SSuummmmaarryy
ttoo pprriinntteerr

TThhuummbbnnaaiill
VViieeww

NNaavviiggaattee
ffrroomm ppaaggee

ttoo ppaaggee

Export, Preview and Print Buttons

Clicking the Export button on the Fusion toolbar will format the Summary as a Microsoft Excel 
spreadsheet file. Fusion suggests a Session Name for the spreadsheet, but you can change it.

Clicking the Print Preview button on the Fusion toolbar not only opens a new window which 
shows you how a session will look when printed, but also allows you to select which pages and/or 
specific parts of pages you would like to print.

When you click the Print button, the Summary is sent directly to the printer.

Clicking the Print button on the Print Preview Screen will send the images you’ve chosen direct-
ly to your printer.
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LABType Session Summary Tabs

Summary Tab

The LABType Session Summary Tab displays a Results Summary Graph. The graph displays the 
quality of batch analysis results for each sample:

 Match M indicates multiple matched results (Orange)

 Match S indicates a single matched result (Red)

 False indicates a false reaction in results (Pink)

 Miss indicates that there are no suggested results (Grey) 

 Click any of the squares in the Results Summary graph to display the corresponding sample 
analysis window.

 If the Auto Accept All button is enabled at the bottom of the Session Summary screen, you can 
click it to assign the possible results as final results for all samples - except those with 
ambiguous results.

This feature is not activated unless you select it through the 
Molecular Product Configuration>>Molecular
Analysis Configuration option in the Utilities menu.

RReessuullttss SSuummmmaarryy GGrraapphh ((SSuummmmaarryy TTaabb))
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PPoossiittiivvee CCoonnttrrooll SSuummmmaarryy GGrraapphh

Control Value Tab

This tab allows you to review the quality of the Control Values for each sample. 
This tab is divided into three graphs, all of which have the following elements in 
common: 

 The X-axis indicates the samples, sorted by well position.

 The Y-axis indicates the raw data values specific to each graph, (e.g., 
positive or negative control values).

 From any graph, right-click to select either Exclude Sample or Analyze Sample.

 Double-click on any marker to go to the analysis screen for that 
sample.

 Hovering your cursor over any marker displays the sample’s 
annotation.

The Positive Control Summary

The Positive Control Summary graph, (top) displays the positive control value for each sample.

 The x-axis indicates the Sample ID names, sorted by well position.

 The y-axis indicates the positive control raw data values.

The horizontal bar indicates the configured value for the minimum positive control. This value can be 
configured through either the Utilities >Molecular Product Configuration menu, or by configuring 
sample-specific settings from the analysis window.

 Each exon is represented by a different color.

 Double-click on any marker to bring up the analysis window for the sample.
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NNeeggaattiivvee CCoonnttrrooll SSuummmmaarryy GGrraapphh

BBeeaadd CCoouunntt SSuummmmaarryy GGrraapphh

Negative Control Summary

The Negative Control Summary graph, (middle) displays the negative control values for each sample.

 The X-axis indicates the Sample ID names, sorted by well position.

 The Y-axis indicates the negative control raw data values.

 Double-click on any marker to bring up the analysis window for that sample.

Bead Count Summary

The Bead Count Summary graph, (lower) displays the Lowest Bead Count per sample.

 The X-axis indicates the sample ID names, sorted by well position.

 The Y-axis indicates the negative control raw data values.

The horizontal bar indicates the configured value for the Minimum 
Bead Count. This value can be globally configured through the 
Utilities >Molecular Product Configuration menu.

You can configure Sample-Specific settings directly from the 
Analysis Window.  Double-click on any marker to bring up the 
Analysis Window for that sample.
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BBeeaadd AAnnaallyyssiiss TTaabb

FFaallssee RReeaaccttiioonn SSuummmmaarryy

The Bead Analysis Tab

This tab allows you to review the global session information for each bead. This tab displays three 
graphs, which are described in the following sections.

False Reaction Summary

With the graph in the lower panel, you can review the number of False Reactions, (both positive and 

negative) associated with each bead in the entire session.

One Lamda QC ID# 052, Probe ID # B101

Match M: (2) Match S: (12) Miss: (7) False: (56)
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BBeeaadd IInnffoo BBuuttttoonn –– AAlllleellee SSppeecciiffiicciittiieess

QQCC PPaanneell aanndd BBeeaadd PPrrooffiillee GGrraapphh

The color of the bar represents the type of false reaction that exists:

 Green = false negative

 Red = false positive 

The height of the color bar indicates the number of false reactions to the indicated bead.

Double-clicking on one of the bars in this graph changes the corresponding QC and Bead graphs to that 
bead. Likewise, double-clicking one of the Bead ID’s along the X axis changes the corresponding QC and 
Bead graphs to that bead.

The two graphs in the upper panel compare the bead profiles of the current session, (right graph) with a 
histogram of the same beads run on a One Lambda QC panel, (left graph). If a local QC is used for the 
session, the local QC histogram is displayed on the left.

 Hover your cursor over the bars on the histograms to display bead information.

 Right-click a bead profile to select either Exclude Sample or Analyze Sample.

 Double-click any bead to go directly to the Analysis Screen for that sample.

 Click the Bead Info button to see the allele specificities for the current bead.

 You can also resize these graphs by placing your cursor in the area between the graphs until 

the cursor image changes to . Then you can click and drag the cursor to resize the graphs.
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BBeeaadd ddrroopp--ddoowwnn lliisstt

UUssiinngg yyoouurr
mmoouussee
ppooiinntteerr,, ddrraagg
aanndd ddrroopp tthhiiss
lliinnee uupp oorr
ddoowwnn ttoo aaddjjuusstt
tthhee pprroobbee ccuutt--
ooffff sseettttiinngg..

AAddjjuussttiinngg tthhee CCuutt--ooffff BBaarr..

 To scale the histograms on the QC Panel Graph, enter a value in the Max Scale text box and 

press the Enter key on your keyboard. This resets the upper Y-axis value of the bead 
profile histogram for both the QC and the current session.

 Using the Bead Navigation buttons, you can navigate between the beads.

 You can also select individual beads from the drop-down list.

 Check the Exclude Bead box to remove the current bead 
from the analysis session. The excluded bead is listed in the 
comment field with a notation that the bead has been excluded. In 
addition, excluded beads are displayed on the graphs during analysis 
as GRAY bars.

 Adjustments made to probe cut-off values in Bead Analysis affect all 
samples in this session. Pre-adjusting values to account for an 
individual lab’s testing conditions can save time during analysis by 
changing all samples at once, (i.e., globally).

Make global cut-off adjustments by doing the following:

 Click and hold the horizontal adjust probe cutoff bar, and drag it up or down to a new cutoff 
setting.
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UUsseerr aanndd SSyysstteemm CCoommmmeennttss

RReesseett CCuutt--ooffff MMeennuu

To reset the cut-off, click the Reset Cutoff button and select a reset option from the drop-down 
list.

 When adjusting the cut-off, you can determine which bead is displayed after the adjustment by 
either selecting or deselecting the following check box at the bottom right of the Bead Analysis 
window:

 If the check box is selected, the next highest False Reaction bead is displayed after the cut-off 
adjustment.

 If the check box is not selected, the bead displayed before the cutoff adjustment was made 
remains displayed.

There are two Comments fields at the bottom—a User one to record your own comments and a 
System field in which HLA Fusion records recent actions you’ve taken in the Summary Window, such 
as adjusting a cut-off.  The system comments cannot be edited.
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General Session Summary Features

Aside from the functionality on the three LABType Session Summary tabs, there are other features that 
allow you to manipulate the summary table data.

 You can double-click a sample in the Summary Table or single-click a sample marker on the 
Summary Graph to go directly to the Analysis Screen for that sample.

 Double-click in the User Comments field to add or edit your remarks. System-generated 
comments cannot be modified.

 Click the Field Chooser button to the left of the table headings. The Field Chooser is 
displayed. This allows you to select or clear the check boxes next to column headings and 
include or exclude those columns from the Summary Table.

 Selecting or clearing check boxes in this window instantly updates the table.

Note: If you do not see a particular field available through the field chooser and you are sure it 
should be there, go to C:\HLA Fusion\temp and delete the file named: 
Labtype_Layout.xml.

SSeessssiioonn SSuummmmaarryy TTaabbllee

SSaammppllee MMaarrkkeerrss

FFiieelldd
CChhoooosseerr

SSaammpplleess

CCoolluummnn
HHeeaaddiinnggss
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FFiieelldd CChhoooosseerr

AAnn EExxppoorrtteedd SSuummmmaarryy TTaabbllee ((EExxcceell SSpprreeaaddsshheeeett ffoorrmmaatt))

PPrriinntt PPrreevviieeww SSccrreeeenn

UUssee sslliiddeerr
ttoo mmoovvee
ffrroomm ppaaggee
ttoo ppaaggee

RReeppoossiittiioonniinngg aa FFiieelldd

 Click on any column header of the 
Summary Table to sort the table by that 
column. The triangle in the column 
header indicates the sorting order—up for 
ascending and down  for descending.

 Columns can also be dragged and dropped 
to change their order.

 When you close the Field Chooser, a pop-up message displays to let you 
choose whether or not to save any changes you made. If you click Yes, your 
changes are saved for all future LABType session summaries on this same 
computer until further modifications are saved.

 Click the Export button to save the Summary Table on your computer or the network,
(default location is C:\OLI FUSION\data\report). The file is saved in Excel (*.XLS) format.

 Click the Print button to immediately print out a report of the Summary Table.

 Click the Preview button to review a report of the Summary Table before printing or 
saving.
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 In the Print Preview window, the left side displays symbols for each page of the report. Use the 
Slider to move from page to page, or click on a page icon to go to that page.

 Use your mouse Scroll Wheel, or click and move your mouse up and down to zoom in and out 
of each page in the Print Preview window.

Excluding a Sample from Analysis

If you want to exclude a sample from an analysis session, select the Exclude
check box next to that sample.

You can also right-click the sample on
either of the graphs on the Control 
Value tab and select Exclude 
Sample.

This means the selected sample is not displayed in Fusion reports, or in Bead Analysis, Control Value 
data, or as results in the sample Analysis Window.

 The False Sample rows in the Summary table are highlighted in Pink; sample rows having 
multiple matches are highlighted Orange.

 If you want HLA Fusion to search the entire session for XX codes and replace them with the most 
current NMDP codes you have imported, click the Replace XX Code button. It is 
recommended that you use this feature if the current NMDP file was recently imported. 

Note: For individual samples, the replace code function can be performed by selecting the 
Reanalyze button from the analysis window.
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SSeett CCoonnffiigg bbuuttttoonn oonn tthhee QQCC GGrraapphh iinn QQuuaaddrraanntt OOnnee

Configure LABType Analysis for the Current Sample

Global default LABType configurations can be set from the Utilities menu. In addition, configurations 
can also be set from within the LABType analysis window for the current sample.

Change Configuration for the Current Sample

Before starting analysis, you can change analysis options for the current sample by using the 

configuration menu as shown below. Changes to configuration settings during analysis affect the 

current sample only.

To change configuration settings for the current sample, click the Set Config button at the top of 

Quadrant 1 of the analysis window.
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CCuurrrreenntt SSaammppllee CCoonnffiigguurraattiioonn OOppttiioonnss

BBww44//BBww66 iinn SSeerroollooggyy

Assign Code

By default, Fusion assigns NMDP codes to the alleles. However, 
you can optionally change these codes to one of the following 
options:

 No Code - the results, allele pairs assembled into a string 
with no formatted code, are simply condensed without 
applying a coded format.

 Local Code - assigns user-defined code definitions, (codes 

used by your Lab) for suggested code results.

 P Grouping - Codes allele strings in P Grouping as 
published by IMGT.

 G Grouping - Codes allele strings in G Grouping as 
published by IMGT.

 Cross Code - allows allele combinations that cross serological groups (e.g., EAPW = 
DRB1*04:03:01DRB1*04:03:03). By default, cross-coding is turned off so that allele pairs 

are condensed only within the same allele groups.

Bw4/Bw6 in Serology

Serology has identified many pairs of HLA-B

alleles which appear to differ only at the 
Bw4/Bw6 region—the two mutually 
exclusive serological epitopes. If you select 
this option, Bw4/Bw6 is added to the 
serology results.
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DDeemmooggrraapphhiicc CCoonnffiigguurraattiioonn OOppttiioonn

SSeett MMiinniimmuumm PPoossiittiivvee CCoonnttrrooll

Demographic Information

The Demographic Information option allows you to organize alleles according to their frequency. Based 
on the demographic selection you make, HLA Fusion displays as many as three allele groups in the 
allele pairs list:

 Group 1: Frequent on both alleles

 Group 2: Frequent on one or the other of the alleles only

 Group 3: Frequent on neither allele

Note: If the Demographic Information option is not available, (i.e., grayed-out) it means you 
need to import an allele frequency input file. On the Fusion Menu bar, select 
Utilities>Update Reference>Allele Frequency. Click the browse button and locate the 
Allele Frequency files.  Click Import Allele Frequency.

Minimum Positive Control

The default Minimum Positive Control value assigned by the system 
is 1000. If desired, enter a new value in the Minimum Positive 

Control Value field and press the Enter key on your keyboard.

DDeemmooggrraapphhiicc FFrreeqquueennccyy
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FFoorrccee SSuurree RReeaaccttiioonn

     Enter the bead ID’s you want to force POSITIVE 

Enter the bead ID’s you want to force NEGATIVE 

SSeett MMiinniimmuumm BBeeaadd CCoouunntt

The sample is flagged in the System Comments as having a low Positive Control if any positive control 
trimmed mean in the current sample falls under the threshold you’ve set. On the analysis Bead Tab, the 
bead bars for samples below the threshold you’ve set are colored GRAY.

Minimum Bead Count

The default Minimum Bead Count value assigned by the system is 100. If desired, enter a new value in 
the Minimum Bead Count Value field. The sample is flagged in comments as having a low bead count 
if any bead count in the current sample falls below the threshold you set.

Set Sure Reaction Bead

1. Click the Set Config button, (upper right) and select the Set Sure Reaction Bead option in the 
configuration menu to enter Bead IDs for which to force positive or negative values.

The Force Sure Reaction dialog box is displayed. 

2. Here you can enter bead IDs for which you want to force positive, 
(false positives are considered true positives) or negative, (false 
negatives are considered true negatives).

SSeett SSuurree RReeaaccttiioonn
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CCoonnffiigguurree AAlltteerrnnaattee QQCC PPaanneellss

View QC

This pop-out list displays the Alternate QC panels, (that you created) which 
are available for the current Catalog file which can be displayed as 
histograms in Quadrant 1 of the Analysis Window. When clicked, you can 
select from this list rather than use the OLI QC.

QC panels can also be created by right-clicking a saved LABType Session 
on the Navigator tree and selecting Create Local QC.

Low Positive Threshold Setting

The default Low Positive Threshold value assigned 
by HLA Fusion is 200. 

If desired, click the Set Config button and 
enter a new value in the Low Positive Threshold
field located at the bottom of the pop-out menu.

Samples below this value are graphed as GRAY, 
vertical bars in the upper right Quadrant, (2) of the 
Bead Analysis screen.

SSeett LLooww PPoossiittiivvee TThhrreesshhoolldd
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Using the LABType Data Analysis Window

The LABType Data Analysis Window provides detailed analysis information for each sample in the 
session. You can review the allele assignments suggested by the program and modify and accept the 
typing assignments. HLA Fusion suggests possible typing results, but the final assignment must be 
made by you or your supervisor.

From the LABType Analysis Window you can do the following:

 Switch between code formats

 Apply Bw4/Bw6 to serology results

 Apply frequency filters

 Show the delta between the signal generated and the cutoff point for each bead

 Display reaction, recognition site, raw, and bead data

 Navigate between beads

 Exclude a bead from analysis

 Adjust cutoffs

 Assign non-coded allele pairs

 Assign a coded allele pair

 Assign serology equivalents

 Make manual assignments

 Remove assignments

 Save and confirm your analysis results

 Find the source of an ambiguity and ways to resolve it

The LABType Analysis Window is divided into four main sections, or Quadrants, each providing specific 
data for analysis.
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QQuuaaddrraanntt 11

TThhee LLAABBTTyyppee SSaammppllee AAnnaallyyssiiss WWiinnddooww

DDiissppllaayyss
OOLLIIQQCC

DDiissppllaayyss tthhee
RReeaaccttiioonn TTaabbllee

DDiissppllaayyss
RReeccooggnniittiioonn

SSiittee aanndd DDaattaa ffoorr
eeaacchh PPrroobbee

DDiissppllaayyss UUsseerr QQCC
ffoorr eeaacchh pprroobbee

DDiissppllaayyss LLooccii rreessuullttss ffoorr tthhee
ccuurrrreenntt ppaattiieenntt

ffoorr tthhee sseelleecctteedd ssaammppllee

EEnntteerr nneeww vvaalluueess hheerree
ttoo mmooddiiffyy tthhee YY aaxxiiss
ooff tthhee QQCC hhiissttooggrraamm

DDiissppllaayyss LLAABB QQCC
((iiff ccrreeaatteedd))

QQuuaaddrraanntt 11

Quadrant 1 Quadrant 2

Quadrant 3 Quadrant 4
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QQuuaaddrraanntt 33

GGrraayy
ddiiaammoonnddss aarree
tthhee ccuurrrreenntt
ccuutt--ooffff ffoorr
eeaacchh bbeeaadd..

TThheessee bbaarrss
iinnddiiccaattee tthhee
NNoorrmmaalliizzeedd
VVaalluuee ooff
eeaacchh bbeeaadd iinn
aa ssaammppllee..

BBeeaaddss iinn nnuummeerriicc oorrddeerrNNoorrmmaalliizzeedd
VVaalluuee ((PPeerrcceenntt

PPoossiittiivvee))

MMaaggeennttaa ==
PPoossiittiivvee
CCoonnttrrooll

WWWhhhiiittteee ==
NNeeggaattiivvee
CCoonnttrrooll

RReepprreesseennttss
tthhee RRaaww DDaattaa
VVaalluueess ffoorr tthhee

PPoossiittiivvee aanndd
NNeeggaattiivvee

ccoonnttrrooll bbeeaaddss
ooff aa LLAABBTTyyppee

aassssaayy..

CCuurrrreenntt BBeeaadd:: GGRREEEENN
NNeeggaattiivvee RReeaaccttiioonn:: BBLLUUEE
PPoossiittiivvee RReeaaccttiioonn:: RREEDD

BBAARR CCOOLLOORRSS
VViieeww DDeellttaa //
VViieeww NNoorrmmaall

CClliicckk ffoorr
SSaammppllee IInnffoo

CClliicckk ttoo ssoorrtt bbyy
MMFFII oorr BBeeaaddIIDD

RRAA == RReessoollvvee
AAmmbbiigguuiittyy

RRAA == SSoouurrccee ooff
AAmmbbiigguuiittyy
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RReeaadd--oonnllyy nnootteess
eenntteerreedd bbyy FFuussiioonn

PPllaaccee aa cchheecckk mmaarrkk
hheerree ttoo iinnddiiccaattee tthhaatt

SSuuppeerrvviissoorr
cclliicckkss hheerree ttoo

ccoonnffiirrmm aannaallyyssiiss
rreessuullttss

EEnntteerr yyoouurr oowwnn
ccoommmmeennttss hheerree

TToo aassssiiggnn aanndd
ssaavvee aallll rreessuullttss

AAssssiiggnn tthhee rreessuullttss
aatt tthhee ppaattiieenntt lleevveell

SSaavvee aannaallyyssiiss
ffoorr rreevviieeww aanndd

aapppprroovvaall

SSaavveess yyoouurr ccuurrrreenntt
wwiinnddooww llaayyoouutt

TToo aannaallyyzzee
rreeaaccttiioonnss ffrroomm
ttwwoo tteessttss

TToo rree--aannaallyyzzee aa ssaammppllee
aafftteerr nneeww NNMMDDPP,,

sseerroollooggyy,, oorr cchhaannggeedd
nnuummbbeerr ooff ffaallssee

rreeaaccttiioonnss aalllloowweedd

Each quadrant of the Analysis Window represents a different view of the same sample. The quadrants 
are all linked to one another: a change you make to Quadrant 2, (cutoff for example) affects the display 
in Quadrants 1, 3 and 4. Each quadrant can be re-sized, vertically and horizontally:

 Hover your cursor between the quadrants until the cursor image changes to . Click and drag 
the graph to resize it.

 Or, click the Quadrant Maximize button to modify the quadrant display.

DDiissppllaayyss
aalllleellee ppaaiirrss

PPaaiirr ttaabb
AAssssiiggnnmmeennttss
ssuuggggeesstteedd bbyy

HHLLAA FFuussiioonn

AAlllloowwss oonnee
ffoorrccee ppoossiittiivvee

oorr nneeggaattiivvee

DDiissppllaayyss rreessuullttss
aass ttyyppeess aanndd

ssuubbttyyppeess

GGrroouuppss ppaaiirrss
wwiitthh tthhee ssaammee

rreeaaccttiioonn ppaatttteerrnn

DDiissppllaayyss tthhee sseerroo
eeqquuiivvaalleenntt ooff tthhee

aalllleellee ppaaiirrss

MMoovveess
UUnnaammbbiigguuoouuss
ppoossssiibbllee aalllleellee
ccooddee ttoo tthhee
AAssssiiggnneedd CCooddee
LLiisstt

QQuuaaddrraanntt 44
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EEnntteerr aa nneeww
MMaaxx SSccaallee
vvaalluuee hheerree

HHoovveerr yyoouurr
mmoouussee ttoo
vviieeww
ssaammppllee
ddeettaaiillss

Keyboard Shortcuts for LABType Analysis Navigation

The following table defines some computer keyboard combinations you can use to quickly navigate 
through a LABType sample during analysis.

Keyboard Combo To Do this...

+  N Navigate to the next bead, (from bead analysis & sample analysis screens)

+  P Navigate to the previous bead, (from the bead analysis & sample analysis screens)

+  A Assign and go to the next sample, (from the sample analysis screen)

Quadrant 1 (QC Histogram)

There are several tabs in this quadrant, as explained in the following sections. 

QC Tab

The QC Tab displays a histogram of the reaction profile for the current bead against all samples of the 
QC panel used in the analysis.

Each bar represents a QC sample, and its height represents the normalized reaction value. 
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 Hover your cursor over any sample and the sample details are displayed, including typing 
results, (see graphic).

 To change the histogram scale, click inside the Max Scale box, type in new limits, and press the 

Enter key. 

The Max Scale feature defines the maximum Y-axis range. When you enter a new Max Scale 
value, the QC and bead data histograms automatically refresh to display the range from zero to 
the new maximum value.

 The cut-off line represents the One Lambda default cutoff value.

Rxn (Reaction)Tab

The Reaction Pattern tab displays the Positive reactions for each bead, (X-axis) versus every allele, 
(Y-axis) defined in the catalog file. 

From the LABType Analysis Window in Quadrant 1, click the Rxn tab to display the Reaction 
Pattern Table.

CClliicckk iinn tthhiiss aarreeaa ttoo sseeaarrcchh bbyy rreeaaccttiioonn

CClliicckk ttoo ssoorrtt bbeeaaddss
bbyy ssaammppllee rreeaaccttiioonn

AAnn ““XX””
iinnddiiccaatteess

aa ppoossiittiivvee
rreeaaccttiioonn

PPoossiittiivvee
aalllleelleess
hhaavvee aa

sshhaaddeedd
bbaacckkggrroouunndd

CCuurrrreenntt
SSaammppllee
iinn BBLLUUEE

SSeeaarrcchh bbyy
aalllleellee

CClliicckk ttoo eexxppaanndd oorr
ccoonnttrraacctt tthhee ttaabbllee

DDoouubbllee--cclliicckk ttoo ddiissppllaayy tthhee
sseelleecctteedd bbeeaadd iinn tthhee BBeeaadd

DDaattaa ggrraapphh (Quadrant 2)
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The Default configuration:

 Beads are sorted by sample reaction.

 The current sample appears on top line of the table in a blue font

 Positive alleles are listed below the sample row and have a shaded background.

 Salmon coloring indicates a false positive. 

 Green indicates a false negative.

Positive reactions are displayed as an “X” on the table, (Blue for the current sample and Black for 
the rest).  PC, NC, and excluded beads are displayed as a zero, “0” on the table.

If you want to expand the table to its full size, click the Maximize button. To 
minimize the view, click the button again.

OR…

Double-click anywhere in the area just above the 
table, between the Rxn Reset and the Max buttons 
to expand the table. To size the table back to its 
original quadrant size, double-click in the same area 
again.

Type an allele into the field and click the Find Allele
button to display the allele and its reaction pattern in 
the first row below the sample. Double-click on an 
allele name to bring that allele to the top of the table. 
You can bring all of a certain allele group to the top 
by entering an allele group (e.g., DRB1*03).

Click on the blank, gray row header to the left of an allele name or 
reaction to move all the beads with that reaction to the left. Click the 
Rxn Reset button to reset the table to its original configuration.
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When a column header is clicked, the table is 
sorted by reaction criteria for that bead. The 
first click sorts in ascending order from top 
to bottom. The second click sorts in 
descending order.

Double-click on the allele column to bring the selected allele up to the top of 
the Reaction Pattern Table, just below the sample.

If you use the Analyze Combined button to analyze two or more analyses for the same
sample, Bead IDs in additional analyses are differentiated from the current one in the Rxn Table by an 
underscore and a sequential number.

For example, if the current sample contains a bead with Bead ID002, and you analyzed it in 
combination with an additional analysis for the sample, that same bead for the second sample analysis 
is listed as 002_0 in the Rxn Table. The number following the underscore increments for additional 
samples you may add to the combined analysis (_1 for a third sample test, etc.).

Rec (Recognition) Site Tab

This graph maps the recognition sites of all probes in the sample and highlights those probes that pick 
up any of two user-selected alleles for comparison.

 X-axis: probe binding site in reference to the exons amplified in the test kit used, (starting with 
exon 2’s on the left and going to exon 4’s or higher on the right, if applicable to the sample).

 Y-axis: bead

From the LABType analysis window in Quadrant 1, click the Rec Site tab.
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 Probes that are positive for the selected alleles are colored Red and are displayed at the top of the 
plot. Negatives are colored Blue, and are displayed below the positives.

 Probes are identified by a horizontal bar at the location of the recognition site. The probe position
is labeled next to the bar.

 When you click a probe, the bead graph in Quadrant 2 updates and a pop-up information box
displays the following fields:

1. Bead ID

2. Recognition Site

3. Exon number

 Gap, or specialty probes are indicated by a yellow connector that joins two recognition sites. 
The recognition site data that displays when you click a specialty probe is for both of the 
connected probes.

PPrroobbeess tthhaatt aarree
ppoossiittiivvee aarree RREEDD..

GGaapp,, oorr ssppeecciiaallttyy
pprroobbeess aarree sshhoowwnn
wwiitthh aa yyeellllooww
ccoonnnneeccttoorr..

NNeeggaattiivvee pprroobbeess
aarree ccoolloorreedd BBLLUUEE..



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 84

AA ssuummmmaarryy ooff
aallll pprroobbeess tthhaatt
lliiee iinn tthhee aarreeaa
bbeeffoorree tthhee nneeww
bbaarr ppoossiittiioonn..

PPrroobbee RReeccooggnniittiioonn SSiittee SSuummmmaarryy

TThhee
RReeccooggnniittiioonn

BBaarr

CClliicckk ttoo
aaccttiivvaattee tthhee
RReeccooggnniittiioonn
BBaarr

RReeccooggnniittiioonn SSiittee –– AAlllleellee PPaaiirrss

The Recognition Bar

Activate the Recognition Bar by clicking the Recg. Bar button.  Initially, the bar will appear 
on the left side of the graph. Drag the bar to the right with your mouse pointer.  Once you release the bar 
the system will display the Recognition Site Summary, (Positive, Negative and Excluded probes) for 
wherever this bar is positioned in the window.

Click the OK button to dismiss the Recognition Site Summary.

 You can enter up to two alleles, separated by space, in the Allele Text Field , 
and press the Enter key on your keyboard.

 Or, you can search alleles by double-clicking the allele pair on the Possible Allele Pairs
results list, (in Quadrant 4).
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LLooccaall QQCC TTaabb

OOnnee LLaammbbddaa
ccuutt--ooffff lliinnee

All probes that are reactive to the selected allele(s) are colored:

 Allele 1: Magenta

 Allele 2: Cyan

Local QC Tab

The Local QC tab displays a histogram of the reaction profile for the current bead against all samples 
this user has ever run for the same product, (same lot/revision) and over a specified date range.

Each Green bar represents a QC sample and its height represents the normalized reaction value. This 
will serve as a user-created QC graph.

 Hover your cursor over any sample, and the sample details are displayed.

 The graph is continually updated as you analyze the product over time.

 The cut-off line represents the One Lambda default cut-off value.

Patient/Sample Results Tab

The Patient/Sample Results tab details all of the results for all the 
tests done on a Sample ID or Patient ID.  As results are saved for each 
locus, either the serology result or the allele code for each loci appears 
in this all-loci section.

Click on any of the labeled Gray tabs along the top of the grid to sort 
the results in either ascending or descending order. The direction of 
the small triangles indicates how the results have been sorted.

Hover your mouse over any Possible Allele Code to see the entire allele code.
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PPaattiieenntt//SSaammppllee RReessuullttss ttaabb

PPrreevviioouuss bbeeaaddTThhee ffiirrsstt bbeeaadd LLaasstt bbeeaadd
CClliicckk ttoo rreesseett

vvaalluueess ttoo ddeeffaauulltt

TThhee BBeeaadd TTaabb

NNeexxtt bbeeaadd

CCuurrrreenntt ssaammpplleeCCuutt--ooffff bbaarr

You can use your mouse to widen the grid, or double-click between the 
tabs to automatically increase the column width to accommodate all the 
data presented.

Quadrant 2(Bead Data)

There are three tabs in this quadrant which are explained in the following sections.

Bead Tab

The Bead Tab 
displays the 
histogram for the 
currently selected 
bead. Each bar 
represents a sample. 
The bar height 
represents the 
normalized reaction 
value for the selected 
bead in that sample.

The Red bar 
represents the 
currently selected 
sample.
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AAddjjuussttiinngg tthhee CCuutt--ooffff BBaarr

Double-click on a bar to navigate to the analysis of that selected sample.

You can click the arrow buttons to select a Bead Bar and display the selected bead in Quadrant 2.

Alternatively, you can also select the bead from the Bead Navigator at the top.

 X-axis: Samples sorted in order of reactivity, (weakest to strongest).

 Y-axis: Normalized value, (% positive).

 Data points: Bars represent the normalized value of a sample for the current bead.

 The Bar Colors: All bars are Green, except the current sample, which is Red.

 A white bar indicates samples with a low, (PC) positive control.

 Cut-off line: The cut-off line is located at the cut-off value for the current bead, (values 
above this line are considered positive).

 The cut-off line on this histogram can be modified. To adjust sample cut-off values, do this:

1. Click and hold the horizontal cut-off bar and drag it up or down to a new cut-off setting. 
The cut-off value is displayed next to the cursor and changes as you drag the bar up or 
down.

2.   To reset the cut off values to the default for the current sample, click the Reset 
button and choose a default option.

 When a Sample Bar is double-clicked, the analysis module displays the results for the selected 
sample.

 Hover your cursor over any sample and the bar turns yellow and sample details are displayed.
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SSaammppllee DDeettaaiill

EExxcclluuddeedd BBeeaadd iinn SSyysstteemm CCoommmmeennttss

 If you wish to exclude a bead from analysis, check the Exclude box. When checked, the current
bead is excluded from the analysis of the current sample.  Analysis results are refreshed to reflect 
the change and a notation is added to the System Comment field:  Exclude Bead #[bead id].

 If HLA Fusion cannot determine any results that exactly match the reaction pattern entered, it 
analyzes the reaction assuming that there is one false reaction in the sample. If a solution still 
cannot be found, the system continues to search through additional false reactions until the 
number of allowable false reactions has been reached, or a solution is found.

The false reaction setting must be between the minimum setting of 1 and the 
maximum setting of 4.

Note: Regardless of the maximum false reactions set here, the sample analysis stops at the first 
false reaction found.
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SSeett cclloossee bbeeaadd rreeaaccttiioonn tthhrreesshhoolldd
((ssaammppllee ssppeecciiffiicc iiff ddoonnee hheerree))

NNeeggaattiivvee
RReeaaccttiioonn

PPoossiittiivvee
RReeaaccttiioonn

NNoo RReeaaccttiioonn
((iiff bbeeaadd iiss eexxcclluuddeedd))

RRaaww TTaabb

Raw Tab

Displays the data for the current sample as a table of values. From the LABType analysis window in 

Quadrant 2, click the Raw tab to display the Raw Data Table.

The columns in the Raw Data table display the following types of data:

 Rxn: (1=negative, 8=positive, 0=no reaction)

 Raw: raw data for the trimmed mean fluorescent

 Normal: normalized value

 PosCtl: positive control bead ID

 OLI Cutoff: default OLI positive threshold cut-off

 Sample Cutoff: sample positive threshold cut-off

 Count: bead count

The beads having reactions that fall within the range of the close bead threshold are highlighted in 
Yellow.

 These close beads are also listed in the Close Bead text box in 
Quadrant 4.
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BBeeaadd ccoouunnttss lloowweerr tthhaann llooww ppoossiittiivvee ccoonnttrrooll tthhrreesshhoolldd

BBeeaadd IInnffoo TTaabb

The Close Bead Threshold can be set for all newly imported LABType sessions by using the Utilities > 
Molecular Product Configuration menu.

This sets the range of close beads based on the normalized values, +/- from the current cut-off for the 
bead so that a bead can be considered a close bead and be highlighted yellow on the raw data table. The 
default value is 3. To change the threshold value, type in a new value in the Threshold box and press 

the Enter key.

The raw table is updated instantly and rows with a close bead reaction are highlighted in yellow.

 Click the Maximize button to expand the Raw Data Table.  Click the button again to 
minimize the Raw Data Table.

 Click on any column header to sort the Raw Data table by that column. Double click a Bead ID to 
select that bead on the Bead Tab.

 The count values and corresponding Bead IDs in Red are those beads that have a bead count 
lower than the low positive control threshold. The minimum Bead Count threshold may be set 
through the Utilities > Molecular Product Configuration menu, or by clicking [Edit] on 

the LABType Configuration portion of the LABType home page. The default threshold is 100.

Bead Info Tab

When you click the Bead Info tab, it displays the 
allele specificities of the most recently selected bead 
from the QC histogram or bead profile graph, as well 
as the recognition site of the probe.
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RReeaaccttiioonn
DDaattaa

Quadrant 3(Reaction Profile)

The Reaction Profile

Quadrant3 displays the reaction profile for the current sample against all beads in the analysis.

 X-axis: Beads listed in numeric order from left to right

 Y-axis: Normalized value (% positive)

 Data points: Bars represent the normalized value for all beads in the current sample.

 Bar colors: Positive reaction = Red; negative reaction = Blue; current bead = Green.

 False Positive or False Negative: Light Blue

 Excluded bead: Gray

When a bar is selected on this histogram, the bead profile histogram, (in Quadrant 2) and QC panel 

histogram, (in Quadrant 1) refresh to display the selected bead.

BBeeaaddss iinn nnuummeerriicc oorrddeerr

MMaaxxiimmiizzee
bbuuttttoonn

CClliicckk ttoo vviieeww tthhee ddiiffffeerreennccee
bbeettwweeeenn ssiiggnnaall

ssttrreennggtthh aanndd ccuutt--ooffff vvaalluuee
ffoorr eeaacchh bbeeaadd..

CChhaannggee tthhee vvaalluuee ooff tthhee
nnoorrmmaalliizzeedd ssccaallee ((YY aaxxiiss))

CClliicckk ttoo
mmaaggnniiffyy
oorr sshhrriinnkk

ggrraapphh

CClliicckk ffoorr
ssaammppllee

iinnffoo

SSoorrtt ggrraapphh
ddiissppllaayy bbyy MMFFII

oorr BBeeaaddIIDD

CClliicckk ffoorr
pprroodduucctt
rreelleeaassee
nnootteess
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CClliicckk,, ddrraagg aanndd
ddrroopp tthheessee
ddiiaammoonnddss

--uupp oorr ddoowwnn--
ttoo aaddjjuusstt aa

bbeeaadd ccuutt--ooffff
sseettttiinngg..

AAddjjuusstt BBeeaadd CCuutt--ooffff SSeettttiinnggss

BBeeaadd CCuutt--ooffff DDeellttaa AArrrrooww

CCuutt--ooffff
CChhaannggee FFllaagg

This histogram may be expanded when you click the Maximize button at the top, left corner. The 
histogram maximizes to the width of your screen, allowing for more space to view the bars in graph.

Click the button again to return the histogram to its original size within the quadrant.

The diamonds inside the histogram indicate the current cutoff position for each bead. 

Bead-level cutoff adjustments can be made in this quadrant by dragging and dropping the arrows within 
the bars. To adjust bead cutoff values, follow these instructions:

 Click and hold the bead cutoff diamond and drag it up or down to a new cutoff setting. The cutoff 
value is displayed next to the cursor and changes as you drag the bar up or down.

When a cutoff adjustment has been made, the diamond changes into a Delta Arrow  that points in the 
direction the cutoff was moved. The tip of the arrow points to the location of the new bead cutoff value 
along the x-axis.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 93

TTyyppee yyoouurr oowwnn ccoommmmeennttss iinn tthhiiss aarreeaa..

NNeeggaattiivvee
CCoonnttrrooll

MMaaggeennttaa
PPoossiittiivvee
CCoonnttrrooll

BBeeaaddss

RRaaww
DDaattaa

VVaalluuee

QQuuaaddrraanntt 33:: DDeellttaa VViieeww

You can hover your mouse pointer over any bar and details for that bead are displayed for the sample.

You can add comments to the sample by typing in the 
Comment field at the bottom. Double-clicking in this 

text box opens a much larger window to type your 
comments in.

The Magenta and the wwhhiittee, (or non-colored bar on the right) represent the raw data values for the 
positive and negative control beads of a LABType assay:

X-axis: Beads in numeric order.

Y-axis: Raw data value, (trimmed mean).

Data points: Bars represent the raw data value of a bead vs. the 
sample reaction.

Bar colors/display:

 Positive control = Magenta

 Negative control = 

To expand the histogram, double-click in the area between Quadrants 1 and 3. To resize the histogram to 

its original size, double-click between Quadrant 1 and 3 again. Or, click the Maximize/Minimize
button.

To view the Delta data, (the difference 
between the signal generated and the 

cutoff point for each bead) click the View Delta
button.
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To go back to the normalized view, click the same button which now says View Normal .

Would you prefer to make View Delta the default view so that it automatically displays each time you 
bring up a sample in the LABType Analysis window?

 Save the layout while this quadrant is in the View Delta mode by clicking 

the Save Layout button.

After you exit Fusion and  log in again, your LABType sessions will display Quadrant 3 in View Delta 
mode.

Quadrant 4(Test Results)

Quadrant 4 displays the typing results for the current sample. In general, the typing results include 
possible results and user assignments for allele pairs, coded results, serological equivalency results, and 
other assignments. 

The left side shows various pair tab assignments suggested by the software. You must make all final 
assignments by bringing a suggested pair into the final assignment area or by typing in an allele pair.

There are five tabs here:

 The Pairs tab displays the possible allele pairs results that match the reaction pattern for the 
sample.

 The Force tab displays a list of alternate possible allele pair results for each bead if an 
additional false reaction is allowed.

 With the Type/Subtype tab, when an allele from one list is selected, the matching allele(s) are 
highlighted on another list to show the possible match-ups.

 The Match tab displays the coded format of the actual allele pairings for the sample.

 The Sero (serology) tab displays all suggested serology equivalent data for the sample, based on 
the possible allele pairs.

The right side shows possible allele code assignments for the sample, as well as close bead reactions.
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QQuuaaddrraanntt 44 –– TTeesstt RReessuullttss

The Pairs Tab

The Pairs Tab displays the possible allele pairs results that match the reaction pattern for the sample. 

The pairs are suggested by HLA Fusion. 

 The list identifies the pairs and groups them by either full-match pairs, (no false reactions) or 
the number of false reactions.

 Results with false reactions are listed with the false reacting bead/well identified.

 The results display one allele pair per row.

 Possible homozygous NMDP-coded results are noted in the 
System Comment field.
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……oorr cclliicckk tthhee
AAssssiiggnn

BBuuttttoonn hheerree..

SSeelleecctt aanndd
cclliicckk tthhee XX
bbuuttttoonn ttoo
rreemmoovvee aann
aassssiiggnneedd
ppaaiirr..

AAssssiiggnniinngg aanndd RReemmoovviinngg AAlllleellee PPaaiirrss

DDoouubbllee--cclliicckk
oonn aa ppaaiirr ttoo
mmoovvee tthheemm
ttoo tthhee ffiinnaall
aassssiiggnnmmeenntt

aarreeaa..

Allele pairs are grouped by demographic frequency groups:

 G1 (it is frequent on both alleles)

 G2 (it is frequent on one of two alleles)

 G3 (it is not frequent on either allele)

Each allele pair group is identified by "(G#)" at the end of each allele pair to indicate demographic 
frequency.

If the closest matching results include a false reaction, the false reaction bead is also listed.

No Solution is listed if there are no results that match the sample’s reactions within an allowable 
number of false reactions. When this occurs, increase the number of false reactions and reanalyze.

Assign an Allele Pair from the Suggested List

Double-click on an allele pair under the Pairs tab to assign it to the final allele 
pairs assignment area.

Alternatively, you can click to highlight an allele pair on the list under the Pairs tab and click the 
down arrow V (assign) button next to the Assigned Allele Pairs title to add it to the final 
assignment area. Multiple allele pairs can be assigned.

To remove an assignment, click and highlight the assignment on the Assigned Allele Pairs list and 
click the X (remove) button.
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TThhee
MMaannuuaall

AAssssiiggnnmmeenntt
aarreeaa

Manually Assign an Allele Pair

Manual assignments must be entered in the Manual Entry Field, in standard allele nomenclature 
format. Separate alleles with a space.

1. Enter an assignment into the text field below the 

Assigned Allele Pairs area.

2. Press the Enter key to display the typed 
allele on the Assigned Allele Pairs list above.

You can also make an assignment into the Manual Entry field by selecting a suggested allele pair and 
clicking the Assign button (V) to move the pair into the Manual Entry field, followed by pressing the 

Enter key.

Note: If you highlight more than one allele pair from the Pairs List, only the first one highlighted 
is assigned to the manual entry field.

Force Tab

The Force tab displays a list of alternate possible allele pair results for each bead if an additional false 
reaction is allowed.  In other words, when there is a full match result, the system evaluates the sample 
with a single false reaction.

 This list is applicable for only one (1) forced false reaction. 

 All results are grouped by order of the beads and reactions—the default is to list beads in 
ascending order, with false negative reactions listed first. 

 Use this tool for homozygous, or rare allele assignments.

 False reactions are shown in light blue bars in the histogram in Quadrant 3 to make it easy to 
locate and look at bead data.
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CClliicckk aa pplluuss ssiiggnn ((++)) ttoo
ddiissppllaayy tthhee ssuuggggeesstteedd

aalllleellee ppaaiirr aassssiiggnnmmeennttss
aassssoocciiaatteedd wwiitthh tthhee bbeeaadd

aanndd rreeaaccttiioonn ttyyppee..

CClliicckk aa mmiinnuuss
ssiiggnn ((--)) ttoo

sshhrriinnkk iitt bbaacckk..

CClliicckk tthhiiss bbuuttttoonn ttoo ccooppyy
aanndd ssaavvee ddaattaa ttoo tthhee

cclliippbbooaarrdd wwhhiicchh ccaann bbee
ppaasstteedd iinnttoo aann EExxcceell

sspprreeaaddsshheeeett..

CClliicckk hheerree ttoo
ooppeenn aallll aalllleellee
ppaaiirr rreessuullttss ffoorr
aallll tthhee bbeeaaddss..

CClliicckk ttoo ssoorrtt bbyy
FFaallssee PPoossiittiivvee oorr
FFaallssee NNeeggaattiivvee

Results are grouped by bead and reaction type, False Negative, (FN) or False Positive, (FP).  

You can change the order by clicking Allele 1, Allele 2 or the FP/FN button until the results are 
displayed in the order you prefer.

 Click any Plus Sign (+) to display the suggested allele pair assignments associated with the 

bead and reaction type.

Click the Expand All button to open all allele pair results for all the beads simultaneously.

Click the Collapse All button to close all results for all beads simultaneously.

 Click Copy Data to send a copy of this data to the system clipboard so it can be pasted into 
an Excel spreadsheet.

Type/Subtype Tab

When an allele from the left side of the list is selected, 
the matching allele(s) are highlighted on the right side
to show the possible match-ups in the results.

AAlllleellee 11
mmaattcchheess
ffoorr tthhee
sseelleecctteedd
aalllleellee 22
rreessuulltt..

TTyyppee//SSuubbttyyppee TTaabb
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MMaattcchh TTaabb

Note: The side-by-side placement of the two lists is not intended to imply any allele pairing. 

Match Tab

The Match Tab displays the coded format of the actual allele pairings for the sample.  A Matched 
Reaction Pair is a pair of alleles, (or group of alleles) with a reaction pattern that completely matches the 
reaction pattern of the current sample.

 This result differs from the Possible Allele Code results. The 
Possible Allele Code condenses the results into a single code 
where possible. 

 Hovering your cursor over a coded allele format displays its 
code definition.

Sero Tab

The Sero, (serology) tab displays all suggested serology equivalent data for the sample, based on the 
possible allele pairs.

Note: Make sure you have imported the current serology equivalent file through the Utilities 
menu.  If you have selected the Computer Assigned Serology check box for LABType product 
configuration, adjusting the sample cutoff values automatically results in serology 
assignments.

Only one serology assignment can be made at a time per locus for the sample. Therefore, a current 
serology assignment is replaced if you assign a different one.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 100

SSeerroollooggyy
EEqquuiivvaalleenntt

AAlllleellee ppaaiirrss
aassssoocciiaatteedd

wwiitthh tthhee SSeerroo
EEqquuiivvaalleenntt

SSeerroollooggiiccaall
AAssssiiggnnmmeenntt

AAssssiiggnn
BBuuttttoonn

SSuuggggeesstteedd SSeerroollooggyy EEqquuiivvaalleenntt TTaabb

1. In Quadrant 4, click on the Sero Tab to display the Serology Equivalents for the current sample 
in the top pane of the tab, above its associated allele pairs.

2. Double-click an equivalent, or highlight it and click the V (assign) button to copy it to the 
Assigned Sero field.

3. Click the X (remove) button to delete a serological assignment, or to select and assign a different 
equivalency to replace it.

4. For Class II manual serology assignments there is a pop-up message that allows the user to 

specifiy if the assignment is for DQA1 / DQB1 , DPA1/DPB1 or DRb1/DPB345. 

Note: To set auto-assigned serology results, select Computer Assigned Serology on the LABType 
product configuration page. Users will be prompted to designate alpha and beta for DQ 
and DP loci while making manual assignments.

Exclude Exon 3 Probes for a Locus

If you are analyzing samples from a DPA/DPB or DQA/DQB kit 
containing Exon 3 probes, some of the samples may result in false 
reactions, or no solution. This is due to the limited sequence 
information available for Exon 3 probes. For such samples you can 
choose to analyze without the Exon 3 probes.

DQB1 checkbox appears 
due to No Solution
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As the example shows, if there is a false reaction or no solution for samples with these loci, a checkbox is 
displayed to allow you to exclude the Exon 3.  The checkbox only appears with false reactions.

If you exclude Exon 3 probes for a locus, it has the following results:

 A comment is included in the System Comment field (Exclude <locus> Exon 3 probes).

 All Exon 3 probes are displayed as Gray bars on the Reaction Profile, (Quadrant 3).

 The <loci> check box is displayed with a check mark.

Note: If the false or no solution is corrected by making cutoff adjustments without having to 
exclude the Exon 3 probes, the check box disappears. All Exon 3 manual exclusions and/or 
global adjustments will be kept as-is, whether the Exon 3 probes are included or excluded.

Allele Code Assignment

Allele code assignment is performed on the far right panel of Quadrant 4.

 The Possible Allele Code field displays possible coded results for all pairs that fully match the 
sample.

 The type of code used is dependent on your selection when you configured Fusion for LABType 
analysis, or for this sample – P & G Group, NMDP code, (default) local code, (user-defined) or 
no code.

 The possible coded result is listed at the top section of the field.

 The code definition is listed below it.

 If there are no codes for suggested alleles, then the suggestion is listed with XX, meaning the 
code is undefined.

 For multiple XX suggestions, each suggestion is distinguished from the others by numbering 
such as XX1, XX2, and so forth.

 The allele codes displayed in the Possible Allele Code field are condensed by the system 
based on suggestions from the list of possible allele pairs displayed under the Pairs tab. Note: 
If allele code (possible and assigned) lengths are greater than 4680 then they may appear as a 
blank line. We suggest that you use “+RP+” to see the complete results. This also applies to 
MicroSSP.

UUnnddeeffiinneedd AAlllleellee CCooddee

UUnnddeeffiinneedd
AAlllleellee CCooddee
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 The allele code is based on the current NMDP code or local code installed in the system. By 
default, the system assigns NMDP codes to the alleles. You can optionally change these codes 
to either No Code, Local Code or Cross Code.

 No Solution is listed if there are no results that match the
sample’s reactions within an allowable number of false 
reactions.  If the sample shows no solution, increase the 
number of false reactions in the upper right quadrant for a 
suggested result.

Allele Code Assignment

 Double-click the possible allele code, or select the 

suggested code and click the V (assign) button.

 Click the X (remove) button to remove an allele code 
assignment.

Manual Allele Code Assignment

1. Type an assignment into the text field just below Assigned Allele Code. Make sure you type the 

assignment in correct allele code format:

 The new nomenclature format: X*##:##(####)  X*##:##(####), where X=locus type and #= 
code number).

 The previous nomenclature format: X*#### X*####, where X=locus type and #= code 
number).

Otherwise, Fusion will not accept it and prompts you to make corrections.

Note: If you click on the Translate button to display alleles in the new nomenclature format, you 
cannot enter a manual allele code unless you reanalyze the sample and the alleles are 
again displaying in the previous nomenclature format.
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Press the Enter key to move the allele code you typed in to the Assigned Allele Code field.

Note: If you have a homozygous result, the assigned code can be edited in the Manual Allele 
Code field to show the homozygous coded results once.

Unknown Allele Codes

Unknown allele codes are marked with XX followed by a sequential number. The numbers are reset to 1
for each sample and locus. When you see unknown codes, you should first make certain you have 
imported the latest NMDP file. If you have the latest code file and are still seeing XX codes, you can 
store these unknowns for later submission to the NMDP in a “.txt” file named 
nmdp_code_report.txt,(by default stored in C:\OLI Fusion\data\NMDPExport)but the location can 
be changed by modifying the path in Utilities>URLs & Paths). Code information is appended to this 
text file as it is added; the newest additions are at the bottom.

1. From the Possible Allele Code field, click the XX code to 

display the NMDP Code Report buttons, (to the right of the 

System Comment field).

NMDP Code Report Buttons:

Click the Assign button (V)and choose one of the following:

 To send the unknown code information directly to NMDP, click the +RPT button.  If 
you’re connected to the Internet, Fusion will open the Bioinformatics.NMDP.Org webpage.
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 To add the unknown code information to a text file, (by 
default stored in C:\OLI Fusion\data\NMDPExport) 

right-click on the +Rpt button and select Save in text 
file.

 After the unknown code has been saved, Fusion displays a 
confirmation message that the text file has been saved.

 To add unknown code information to an Excel file, (by default stored in C:\OLI 
Fusion\data\export\NMDPExport), right-click on the +Rpt button and select Save in 
Excel File.

After the spreadsheet file has been saved, Fusion displays a 
confirmation message.

When you’re done, click the Close button, (on the right of the +Rpt button) to remove the buttons from 
the display.

Note: The +Rpt button retains the last selection you made, (direct, text or Excel) so it can be 
used as a shortcut. Unless you want to change your selection, the next time you report XX 
code simply click +Rpt.

Other Assignment 

The Other Assignment field may be used to make a sample assignment that is not restricted to any 
format. In addition, you can highlight and add serology or allele pair or code assignments and add them 
to the field for modification.

You can make other code assignments in one of two 
ways:

 Type an allele pair or allele code into the Other 
Assignment field.

 Click the V (assign) button and select one of 
two options:
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RReeaannaallyyzzee BBuuttttoonn

1. To assign just the possible allele code, select Assign Possible Allele Code to bring the 
highlighted Possible Allele Code into the Other Assignment field.

2. Select Assign All to bring the Possible Allele Code, Assigned Serology or Assigned Allele 
Pairs assignment(s) into the Other Assignment field.

You can also choose to modify any of the copied code, if desired.

Entered alleles are assigned and included in reports that are run which include this sample, but allele 
assignments made this way are not listed in the final assignment field for this sample.

Reanalyze

If you have imported a new NMDP code, local code or serology equivalent file into the system, or you 
change the number of false reactions allowed for a no-solution sample, you can click the Reanalyze
button to analyze the data using the new reference file(s) or to reflect false reaction changes.

Note: This reanalysis replaces only the NMDP, local or serological codes, or analyzes with 
different false reactions settings. All other setting changes generally result in an 
automatic reanalysis of the sample immediately following the setting change.

Analyze Combined LABType Sessions

HLA Fusion supports a combined analysis feature for both LABType and Micro SSP analysis sessions.
In a combined analysis, the reactions from two tests of the same sample are combined together in a 
single analysis that may generate a higher resolution result. The previous test must have the same
sample ID.

Note: To combine a generic or HD LABType sample with Exon 4-7, the combination must be done 
from the Exon 4-7.
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From the Analysis Window, click on the Analyze Combined button. The next pop-up 

window displays a list of previous sessions that have used the current sample and share the same sample 

ID.

1. Select the desired previous session(s) by selecting the associated Combine check box.

2. Click the Analyze button at the bottom of the pop-up window.

 The reaction pattern table includes bead information for all the sample tests. This table’s Bead 
ID listings provide indication that the selected sessions have been combined and reanalyzed.

 If you combine one sample in the previous nomenclature format with a sample in the newer 
nomenclature format, the possible and assigned allele pairs and code are displayed in the new 
format. If the sample with the previous nomenclature format contains an allele that is not 
included in the new nomenclature, that older allele is dropped.

To rerun the combined analysis, click the Reanalyze Combine button.

 If the nomenclature dates between the current one and the one(s) being combined with it, 
conflict, then the session(s) you selected is highlighted red.

 If you click the Analyze button and there is a conflict on nomenclature dates, a warning 
message is displayed that gives you the option of continuing or canceling the combined 
analysis. The nomenclature of the sample test you selected to combine with the current one 
will be used if you continue.

Adding User Comments to Samples

Comments you or the system add to the Comments Field are displayed with the results in the 
current analysis session, data look up and reporting functions in HLA Fusion. They are separated into 
user and system comments. You can only add or edit the comments in the user comment field.

1. In the analysis window, enter your comments into the User Comment field below the Assignments 

area, (maximum of 255 characters).
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Comment Field

Comments are saved only after you click the Save or Confirm buttons.

Flagging a Sample for Further Testing

You can indicate the need for further testing of a sample by selecting 
the More Test check box. The More Test indication is displayed in 
results, data look-up and reports for the sample.

Assigning Serology and Allele Code Results to a Patient

Note: This feature is available only to Lab Supervisors and for saved samples.

This check box is grayed-out until the sample has been saved or assigned and can only be selected by 
those with Lab Supervisor privileges. If selected, serology and allele code results are then added to the 
patient’s record.

 In the analysis window, check the 
Patient Assign check box, 
located below the Assignments 
area.

 Click Confirm>> to preserve the 
setting.

DDoouubbllee--cclliicckk
aannyywwhheerree

iinn tthhiiss aarreeaa……

TToo ooppeenn tthhee llaarrggeerr
ccoommmmeennttss aarreeaa
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 If you previously assigned results to the patient, a message displays asking whether or not you 
want to overwrite the previous assignment.

The Print Screen button prints the currently displayed analysis window.

 From the analysis window, click the Print Screen button on the Fusion Toolbar to print the 
current analysis screen.

Preview or Print Reports

To view a LABType report for the current sample, use the Preview Report and/or Print Report buttons on 

the toolbar.

In the Analysis Window, click the Preview Report button or the Print Report button to 
display a list of reports you can preview or print for the current sample.

Or, hover your mouse pointer over the Print button to 
see a list of available reports.

Note: If you select Molecular Custom, you will not be able to create a new custom report at 
this point. The only custom reports available from the analysis window are ones you 
may have previously created through the Reports window.
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Assign Coded Results

Use the Assign button to assign and save all unambiguous possible coded results, (those results for 
which there is only one coded result). For the assignment of Serological or Allele pairs, or when you want 
to choose in the case of ambiguous results, you must manually move them to Assigned and click the Save

button.

Translate (noncurrent nomenclature format only)

The Translate button is displayed only if the sample allele format is in the older 
nomenclature. Clicking the Translate button does the following:

 Translates and displays all Assigned, (except from the Other Assignment field) and possible 
allele code/pairs/haplo in the latest nomenclature format.

 If a matching allele in the new format cannot be found, the allele remains displayed in the old 
format.

 You can view and print this display, but results cannot be saved or reported in this new 
nomenclature format.

 To go back to the older allele format, you can navigate to another sample and then return to 
this sample.

Save Assignments

Note: Make sure you’ve made the assignments before you save.

Lab technicians and supervisors can save analysis results for further review and approval. Saved samples 
are available for confirmation by a Lab Supervisor only.

 From the analysis window, click the Save button located in the bottom right corner of 
the analysis window to save analysis results for all the specificities currently listed in the Final 
Assignments results box.

 The Save>> button does not assign results; it simply saves the sample results and comments.
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Note: If comments are added, the sample must be saved in order to also save the comments.

 After saving, Fusion automatically moves to the next sample.

 For confirmation, a Supervisor needs to access the sample for which you have saved the 
assignments. You can return to the sample any time prior to confirmation.

 If you need to make changes, click the Reanalyze button and then the Save button 
again.

Confirm Assignments

Lab Supervisors can confirm analysis results. When they do, samples are marked as Approved. The 
Confirm button is colored Purple when you view a confirmed sample.

 From the analysis window, click the Confirm button located at the bottom right 
corner of the window, to confirm all analysis results that have been saved in the Final 
Assignments results box.

 You automatically move to the next sample to continue confirming results.

 When you first return to a confirmed sample, you will see that the Confirm button is now 
shaded Purple to let you know it has been confirmed previously.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 111

SSeessssiioonn--LLeevveell NNaavviiggaattoorr MMeennuu OOppttiioonnss

Navigator Right-Click Menu Options for LABType

Session-Level Options

There are three menu options that are displayed if you right-click on an active session in the Navigator,
(select the session first with a left-click):

Create Lab QC

Allows you to save the catalog file and the QC parameters from the selected session as a Lab QC panel.

 The local QC is set up similarly to a catalog file where the user can, upon launching a new
analysis, select the local QC from the catalog list. The local QC information is then used in the 
analysis session instead of the One Lambda QC.

 When selected, a dialog box displays and prompts you to name the new lab QC (default name =
[current catalog ID]_LAB).

CCrreeaattee nneeww QQCC SSeessssiioonn DDiiaalloogg BBooxx
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After accepting or entering the name, click the Create button.

 The system then saves the current session as a local QC using the selected name appended with a 
date and time stamp (format: yyyymmddhhmmss).

 For new sessions, this local QC is available for selection from the catalog file drop-down list when 
you import LABType sessions.

 This QC is also listed in the View QC drop-down via the LABType sample configuration menu 
when you open a new analysis session.

Session Review

This right-click option provides various sub-menus, (filter criteria) 
that allow you to review the samples in a session according to the type 
of results obtained:

 Review All (default) - all samples are listed and available for 
analysis.

 Single Pair - only samples with unambiguous results are 
listed, (samples displayed with red square markers in the 
Results Summary graph on the session Summary tab).

 Multiple Pairs - only samples with ambiguous results are listed, (samples displayed with 
orange square markers in the Results Summary graph on the session Summary tab).

 Not Analyzed – when selected, the Navigator will display only those samples or sessions 
which have been imported, but not yet analyzed.  These sessions will appear in Blue.

LLooccaall QQCC aafftteerr bbeeiinngg sseelleecctteedd ffrroomm VViieeww LLaabb QQCC
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Miss - only samples with no solution are listed, (samples displayed with gray square markers in the 
Results Summary graph on the Session Summary tab).

 False Reaction - only samples with false reactions are listed, (samples displayed with pink 
square markers in the Results Summary graph on the Session Summary tab).

The samples in the session on which you right-clicked are filtered based on the sub-menu option you 
select. The filtering criteria is then loaded into the batch navigation list. Fusion then takes you to the 
analysis window where the samples are displayed in order of the batch navigation list.

Reanalyze with New Nomenclature

Allows the session to be reanalyzed using a new or updated catalog file.

1. Modify or rename the Old Session ID by giving it a New Session ID.

2. Click the drop-down arrow in the New Catalog ID field and select a new catalog file from the 
list.

3. Click the Analysis button. The session on which you right-clicked is now reanalyzed using the 
catalog file you selected.

Sample-Level Options

There are two menu options that are displayed if you right-click on 
an active sample in the Navigator, (select the sample first with a 
left-click) Related Records and Side-By-Side Analysis.
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Related Records

A Related Record is a record that is associated with the current sample by Patient ID, or Sample ID.

Note: This option is also available when you use the Related Records toolbar button .

Select this menu option to load all records related to the current sample into the Sample drop-down list.

 Use the sample navigation arrows to display the analysis of each related record one by one.

 To go back to viewing the samples in the current session, click the <<Summary link at the top of 
the window.

Side By Side Analysis

Use this option to compare the current sample analysis with one previously conducted.

Note: This option is also 
available by using the 
Side By Side Analysis 
toolbar     button.

The current, on-screen sample analysis has a light Brown background.

SSaammppllee DDrroopp--DDoowwnn LLiisstt ffoorr RReellaatteedd RReeccoorrddss

SSiiddee--bbyy--SSiiddee AAnnaallyyssiiss mmeennuu ooppttiioonn
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Select a previous sample analysis from the displayed list to compare to the current one.

1. Click the OK button and the two analysis windows are then displayed in a comparison 
window.

Each window can be resized and moved by dragging and dropping.

1. Click the Side-By-Side Analysis toolbar button to cancel the comparison display.

PPrreevviioouuss

AAnnaallyyssiiss

CCuurrrreenntt

AAnnaallyyssiiss

EExxaammppllee ooff SSiiddee--bbyy--SSiiddee AAnnaallyyssiiss WWiinnddoowwss
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Micro SSP Analysis

The Micro SSP™ HLA typing trays use the sequence-specific primer technology. These trays are 
available in 96-well format and a few other formats such as E-Gel 96 (V), E-Gel 96 (H), and 
Centipede. Analysis results are based on catalog specifications, NMDP code, and serology equivalent 
references that you can import through the Fusion software.

The software suggests the allele pair assignments, but the final assignment has to be made by the 
user. The results can be saved in the database for further review by lab technicians and for final 
approval by the lab supervisors.

There are a few things that should be completed or verified before you start an analysis session: 

 Make sure you have the latest catalog files, as well as NMDP code, local code, (if used) or 
serology equivalent reference files before you analyze. You can download or update catalogs 
from the Micro SSP Home Page.

 View and modify global product configuration settings before starting analysis. Global settings 
are displayed and be can be modified on the Micro SSP Home. Global settings apply across all 
newly- imported sessions.

 The default setting of HLA Fusion is to automatically move to the next sample after a sample has 
been saved or confirmed.  If you prefer to remain on a sample, make the change in the General 
Configurations section of the Fusion Explorer Home page.

Note: Some of the above tasks require you to have supervisor user privileges. You may have to 
verify with your supervisor that these tasks have been completed.
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CClliicckk ttoo ooppeenn tthhee CCaattaalloogg MMaannaaggeemmeenntt ssccrreeeenn..

Start Micro SSP Analysis

1. Click the Micro SSP                          button on the home page panel, or the Micro SSP 

icon on the Fusion toolbar, or select Analyze Data > Micro SSP.

The Micro SSP Home page is displayed.

Note: Open worksheets and probe/primer sheets to verify the accuracy of revision numbers, 
(these documents do not contain a revision number in their filename).

1. Begin by clicking the Batch Entry button at the top, left side of the 
screen.

Place a check marknext to Include Imported if you also want to 

bring in batches which have previously been imported.

The Batch Entry window is displayed.

CClliicckk ttoo eeddiitt
tthhee MMiiccrrooSSSSPP
gglloobbaall sseettttiinnggss..

CClliicckk aannyy lliinnkk
ttoo ddiissppllaayy tthhee
sseelleecctteedd ccaattaalloogg,,
wwoorrkksshheeeett oorr
pprroobbee//pprriimmeerr
wwoorrkksshheeeettss..

CClliicckk ttoo ooppeenn
tthhee AAvvaaiillaabbllee
RReeffeerreennccee
UUppddaatteess ssccrreeeenn..
(catalogs display
nomenclature dates
and revision notes)

CClliicckk ttoo ooppeenn
tthhee UUppddaattee
RReeffeerreennccee FFiilleess
ssccrreeeenn..
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SSeelleecctt llooccuuss ttoo ffiilltteerr ccaattaalloogg lliisstt PPaattiieenntt IIDD FFiieelldd

BBrroowwssee ffoorr
MMiiccrroo SSSSPP
CCSSVV ffiilleess

SSaavvee tthhee ccuurrrreenntt
bbaattcchh iinnffoorrmmaattiioonn

GGoo ttoo tthhee
aannaallyyssiiss ssccrreeeennSSttaarrtt aa nneeww bbaattcchh

SSaammppllee NNaammee ffiieelldd

The system assigns a Batch Name automatically. Optionally, you can change the name.

Note: A batch must be unique to the Fusion database for each product type. If it already 
exists, the software prompts you to rename the batch. It is highly recommended that 
you do not use any special characters in this field since they may serve a specific 
purpose as field separators.

2. Use the browse button (...) at the bottom of the window to search for and import one or more 
Micro SSP .csv files or follow the steps below.

3. Use the drop-down menu in the Locus Filter field to select a locus by which to filter the catalog 
listing. This will limit the catalog list in the next field to only those catalogs that include the 
selected locus.

4. Use the drop-down menu in the Catalog field to select a catalog file.

Note: If you need to import more catalogs, click the Download link on the Micro SSP Home 
Page for instructions on how to add new catalog files to the database.

The catalog drop-down list may not be immediately updated if you downloaded the 
catalogs during this import session. You may need to click the Home button and then 
click the Micro SSP button again to return to the import process.

5. Accept the session name in the Session field, or modify it.

6. Enter a name in the Sample Name field. If this is an existing sample name, other fields such as 
the Patient ID and Ethnicity, are populated with existing data. You can also double-click in the 
Sample Name field to display the Select Sample window from which you can select a sample.
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SSeelleecctt GGeell IImmaaggee BBrroowwsseerr

7. Click the drop-down arrow in the Sample Date field and select a date. The analysis window for 
this session is displayed. 

8. Enter an ID in the Patient ID field. If this is an existing patient/donor ID, other fields such as 
the First and Last Name and Ethnicity, are populated with existing data. You can also double-click 
in the Patient ID field to display the Select Patient window from which you can search for and 
select a patient ID.

If they are not already filled-in, you can enter a name for the patient or donor in the First Name
and Last Name fields.

9. If it is not already filled-in, click the drop-down arrow in the Ethnicity field to choose the 
patient/donor ethnicity.

10. If not already filled-in, click the drop-down arrow in the Patient/Donor field to choose either 
patient, donor, or both.

11. If you want to associate a gel image with the sample, double-click in the Gel Image field and
browse to the location of the image you want to add to the sample.

Note: Fusion supports the BMP, JPG, BMP and TIF image formats.  However, certain versions 
of the TIF format may not be supported by the Windows version used on your computer.

 Repeat the above steps until you complete the batch information, or until you want to save and 
complete the batch later. Each Micro SSP batch session can consist of as many samples as you 
wish to analyze with the same or with different catalog information.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 120

Take one of the following actions once you are ready to stop creating the batch:

 Click the Next> button to open the Micro SSP analysis window.

 Click the Save button to save the current batch information and return to it later.

 Click New Batch to start creation of a new batch.

 Click Close to exit the Batch Entry window.
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MMiiccrroo SSSSPP SSaammppllee--LLeevveell CCoonnffiigguurraattiioonn MMeennuu

Configure Micro SSP Data Analysis

Global defaults for Micro SSP product configurations can be set from one of two places:

 The Micro SSP Home Page

 The Utilities menu on the main HLA Fusion home screen.

In addition, configurations can also be set from within the analysis window for the current Micro 
SSP sample by clicking on the Config button to view a pop-up list of configuration options.

Assign Code

By default, the system assigns NMDP codes to the alleles. However, the user can optionally change 
these codes to one of the following options:

 No Code - The results, allele pairs assembled into a string with no formatted code, are 
simply condensed without applying a coded format.

 P Grouping -Codes Allele strings in P grouping as published by IMGT.

 G Grouping - Codes Allele strings in G grouping as published by IMGT.

 Local Code - assigns user-defined code definitions, (code used by your Lab) for 
suggested code results.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 122

 Cross Code - allows allele combinations that cross serological groups (e.g.,EAPW = 
DRB1*04:01/33/35/38/72/76). By default, cross coding is turned off so that allele pairs are 
condensed only within the same allele groups.

 Bw4/Bw6 in Serology 

Bw4/Bw6 in Serology

Serology has identified many pairs of HLA-B alleles which appear 
to differ only at the Bw4/Bw6 region - the two mutually exclusive 
serological epitopes.

If you select this option, Bw4/Bw6 is added to the serology 
results.

Demographic Information

The Demographic Information option 
allows you to organize alleles based on their 
frequency.

Based on the demographic selection you make, HLA Fusion displays as many as three allele groups in 
the allele pairs list:

 Group 1: Frequent on both alleles

 Group 2: Frequent on one or the other of the alleles only

 Group 3: Frequent on neither allele

If the Demographic Information option is not active, it means you need to import an allele frequency 
input file.
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Using the Micro SSP Analysis window

The analysis window displays detailed analysis information for each sample in the session. You can 
review the allele assignments suggested by the program, modify and accept the assignments.

HLA Fusion suggests possible typing results, but you must make the final assignment. Any adjustments 
made in the analysis window are sample-specific and affect only the current sample.

From the Analysis Window you can do the following:

 Use the test gel pane to change reactions and sample row positions.

 Change the allowable number of false reactions.

 Force one false reaction.

 View and print sample analysis results.

 Add comments and mark for more testing.

You can return to a session summary from the analysis window any time by clicking 
the<<Summary link from the HLA Fusion toolbar next to the Sample ID.
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PPllaaccee aa cchheecckk mmaarrkk hheerree
ttoo iinnddiiccaattee tthhee nneeeedd ffoorr

aaddddiittiioonnaall tteessttss..

AA cchheecckk mmaarrkk hheerree wwiillll
aassssiiggnn tthhee aannaallyyssiiss
rreessuullttss ttoo tthhee ppaattiieenntt..

DDiissppllaayyss
AAlllleellee
ppaaiirrss

MMiiccrrooSSSSPP AAnnaallyyssiiss ssccrreeeenn

TThhee RReessuullttss
aarreeaa

GGrroouuppss aanndd
CCoonnddeennsseess
ppaaiirrss wwiitthh
tthhee ssaammee
rreeaaccttiioonn
ppaatttteerrnn..

TThhee rreeaaccttiioonn
ppaatttteerrnn ttaabbllee

IInnppuutt aanndd
AAnnaallyyssiiss TTaabblleess

CClliicckk hheerree
ttoo vviieeww

oorr aadddd aa
ggeell iimmaaggee..

Test Gel Pane

The pane on the left side of the window displays each well 
of the test in rows that are intended to duplicate the test 
gel. Each well is shown with a reaction button.

When clicked or entered from the keyboard, you can 
modify the reaction for the selected well between the 
following settings:

 8 = positive reaction

 1 = negative reaction

 0= no clear amplification, (wells with a 0 will 
be excluded from analysis)
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Note: If you right-click in the black area of the test gel pane, you can select a different order 
for the reactions when you click on a well: 0->1->8, or 8->1->0,etc.

 After you analyze a tray, you can no longer add any 
more sample information to that tray.

 If the sample has not been analyzed, the right most 
button on the bottom of this pane is labeled Analyze. 
If analysis already exists for the sample, then the 
button is labeled Re-Analyze.

 This button is only enabled when a Sample ID has 
been entered. If a Sample ID has not been entered when this button is clicked, the Sample 
ID field is flagged with "!" as being empty, and no analysis is performed.

 If other than the first well (1H) reaction is set to zero (0), a message displays, allowing you 
to see system-suggested reaction information to help you decide if you want to analyze the 
non-amp well with a positive or a negative score. If more than one well is set to zero, the 
message does not display, but the suggested reaction information can still be viewed.

To see the possible reactions if the well was positive or negative, click Yes and scroll down the 
Possible Allele Pairs list to the headings Neg Reaction, Pos Reaction. If neither type of 
result can be suggested, the heading is No Solution and it will not be followed by results.
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HHeeaaddiinnggss ttoo llooookk
ffoorr wwhheenn vviieewwiinngg
ppoossssiibbllee nnoonn--aammpp
wweellll rreessuullttss..

PPoossssiibbllee RReessuullttss ffoorr OOnnee NNoonn--AAmmpp WWeellll

VViieeww WWeellll DDeettaaiillss ((wwiitthh yyoouurr mmoouussee oovveerr aa wweellll))

View Well Details

You can view comprehensive details about the current sample by hovering your cursor over a well in 
the test gel area of the analysis window.

Working with Gel Images

 If you have a gel image already linked to the current sample, you can view it, or unlink
it.

OR

 You can search for and link another gel
image to the current sample.
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Here’s how you can link a gel image to the current sample:

1. Click the View Gel button at the bottom, 
left of the gel image screen. If no image is 
currently linked to this sample, you’ll see this 
message:

2. Click the Yes button and Fusion opens the 
Select Gel Image screen.

1. Browse to a new gel image and click the Open

button. 

2. Fusion opens the Gel Image window and 
displays the gel image you’ve selected.  The 
window can be resized if needed.

If you want to link this image to this sample, click the Link Image button.

 To zoom in, click the  button.

 To zoom out, click the - button.

 To turn the image, click the Rotate
button.

ZZoooomm IInn ZZoooomm OOuutt TToo lliinnkk tthhee iimmaaggee ttoo
tthhee ccuurrrreenntt ssaammppllee..

CClliicckk ttoo
cclloossee tthhee
GGeell VViieewweerr

CClliicckk ttoo rroottaattee
tthhee ggeell iimmaaggee

GGeell IImmaaggee VViieewweerr
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To Unlink an image already associated with the current sample:

1. Click the View Gel button.

2. When the image is displayed in the Gel Image viewer, click the Unlink button.

Add Samples

There are two methods that samples can be added and analyzed in a session:

1. Click the Add New Sample
button.

2. Type a new Sample ID, or Sample Name, in the 
Sample ID field, (above the gel image).

3. Select the Sample Date by clicking the Down 

Arrowin the Date field to the right of the 

Sample ID field.

4. And click the Analyze button.

OR

Here’s an alternate method to add existing samples for analysis in Micro SSP:

1. Click the Sample Selection button to the right of the Sample ID field.

Select an existing sample from the list of Available Samples.

You can use the text box at the 
top as a search tool.

2. Click the OK button at 
the bottom of this window to move the sample from the 
list of Available Samples to the Sample ID text box 
above the gel image viewer.  You may use the existing 
Sample Name, or create a new one.
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3. Select/create a Sample Date.

4. Click the Analyze button.

View Gel

Within the Serology Analysis window, you can view the gel for the current sample. This tool finds the gel 
file, (JPEG format) associated with the CSV data file and displays it in the Analysis window.

1. Click on the View Gel button. A picture of the gel for the current sample is displayed as a new 

window.

2. Click the Close button or click on X to close the gel.

Modify the Session Start Position

For multi-test trays, you can skip tray positions to match your gel photos by clicking the Add New 
Sample button until the correct test start position is displayed.
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Rxn (Reaction) Tab

The reaction pattern table displays the positive reactions for each well, or bead, if combined with 
LABType, (x-axis) versus every allele, (y-axis) defined in the current catalog.

 The Reaction Pattern Table is displayed in the right pane of the Micro SSP analysis window.

Default configuration:

 Wells, (Beads if it’s a combined analysis with LABType) are sorted by sample reaction.

 The well ID depends on the row and location of the sample in the test gel pane.

 The current sample appears in a Blue font, just below the cross loci row.

 Positive alleles are listed below the sample row and are highlighted in yellow.

 Cross loci wells are identified with the pound sign (#).

 Salmon coloring indicates a false positive. Green indicates a false negative.

BBeeaadd IIDD’’ss ffoorr LLaabbTTyyppee tteessttss uusseedd iinn ccoommbbiinneedd
aannaallyyssiiss wwiitthh tthhee ccuurrrreenntt MMiiccrrooSSSSPP ssaammppllee..

DDoouubbllee--cclliicckk aannyywwhheerree iinn tthhiiss
aarreeaa ttoo eexxppaanndd tthhee ttaabbllee

ttoo hhaallff tthhee aannaallyyssiiss wwiinnddooww..

CClliicckk ttoo ssoorrtt
tthhee ttaabbllee
bbyy tthhee
sseelleecctteedd
wweellll
rreeaaccttiioonnss..

TThhee MMaaxx
bbuuttttoonn
eexxppaannddss tthhee
rreeaaccttiioonn ttaabbllee..

SSeeaarrcchh bbyy
rreeaaccttiioonn
ppaatttteerrnn

SSeeaarrcchh bbyy AAlllleellee
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
Positive reactions are displayed as an “X” on the table, (blue for the current sample 
and black for the rest). PC, NC and excluded beads are displayed as “0” on the table.


If you want to expand the table to full window size, click the button. To 

minimize it again, click the button.


Double-click in the area just above the table, between the Find Allele and Max
buttons, to expand the table to half the analysis window. To size the table back to its 
original size, double-click in the same area again.


Type an allele into the field and click the Find Allele button to display the allele and 
its reaction pattern in the first row. Double click on an allele name to bring that allele 
to the top of the table. You can bring all of a certain allele group to the top by 
entering an allele group (i.e., DRB1*07).


Click on the blank row header to either the left of an allele name or the sample 
reaction to move all the beads with that reaction to the left. Click the Rxn Reset
button, (above the Max button) to reset the table to its original configuration.


When a column header is clicked, the table is sorted by reaction criteria for that well 
or bead, (if combined with LABType). The first click sorts in ascending order from top 
to bottom. The second click sorts in descending order.


If you use the Analyze Combined button from the analysis window to analyze a 
LABType test and a Micro SSP test, the Bead IDs from the LABType test are displayed 
in the Well ID row on the Rxn table. These are recognizable by the bead ID followed 
by an underscore and a 0. 
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Number of Allowable False Reactions

If HLA Fusion cannot determine any results that exactly match the reaction pattern entered, it 
analyzes the reaction assuming that there is one false reaction in the sample.

If a solution still cannot be found, the system continues to search through additional false reactions 
until the number of allowable false reactions has been reached, or a solution is found.

The false reaction setting allows you to set the number of allowable false reactions:

Minimum setting = 0

Maximum setting = 4

 In the # False Rxn field, click the up or down arrow 
to change the number of allowable false reactions.

Note: Regardless of the maximum false reactions set here, sample analysis stops at the first 
false reaction found.

Force One False Reaction

When a sample has a result with no false reactions, (exact match result) the Force 1 feature forces 
HLA Fusion to re-analyze the reaction to allow for one possible false reaction in any well. This feature 
is used to search for results for which one additional reaction can change the results.

1. From the analysis window, click the Force 1button to force the program to analyze the sample 

with one false reaction.

Click the Reanalyze button to reset the analysis to the original results.

Click the Rxn Reset button to return the Rxn Pattern table to the default settings.
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Micro SSP Combined Analysis

The HLA Fusion software supports a combined analysis feature. In a combined analysis, the reactions 
from two tests of the same sample are combined together in a single analysis. The previous test must 
either have the same Sample ID or be associated with the same Patient ID.

To combine results for a sample, you need to start or continue a Micro SSP allele-specific test and 
have a previously saved Micro SSP or LABType session to combine with it. After combining sessions, 
the possible typing assignments are displayed, and the reaction pattern table changes to reflect the 
reaction pattern of both tests.

1. From the analysis window, click on the Analyze Combined button below the reaction 

pattern table. The Combined Analysis window displays a list of previous sessions that have 

used the current sample and share the same Sample ID.

Select the desired previous session(s) by selecting the associated Combine check box on the far left.

Click the Analyze button at the bottom of the pop-up window.

Note: If you combine one sample in the previous nomenclature format with a sample in 
the newer nomenclature format, the possible and assigned allele pairs and code will 
be displayed in the new format. If the sample with the previous nomenclature 
format contains an allele that is not included in the new nomenclature, that older 
allele is dropped.

To rerun the combined analysis, click the Reanalyze Combined button.
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 If the nomenclature dates between the current one and the one(s) being combined with it 
conflict, then the session(s) you selected is highlighted Red.

 If you click the Analyze button and there is a conflict on nomenclature dates, a 
warning message is displayed that gives you the option of continuing or canceling the 
combined analysis. The nomenclature of the sample test you selected to combine with the 
current one will be used if you continue.

Note: Notice that the Analyze Combined button in the analysis window changes to Reanalyze 
Combined button. This is an indication that the selected sessions have been combined.
If sessions are combined, a note is added to the system comments box.
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Make Typing Assignments in Micro SSP Analysis

HLA Fusion provides computer-suggested allele pairs and coded assignments. Final typing assignments 
can only be made by you, or your supervisor.

From the analysis window you can do the following:

 Switch between code formats

 Apply Bw4/Bw6 to serology results

 Apply frequency filters

 Assign non-coded allele pairs

 Assign a coded allele pair

 Assign serology equivalents

 Make manual assignments

 Remove assignments

 Save and confirm assignments

Pairs Tab

The Pairs Tab displays the possible allele pairs results that match the reaction pattern for the 
sample. The pairs are suggested by the software.

 The list identifies the pairs and groups them by either full-match pairs, (no false reactions) 
or the number of false reactions. Results with false reactions are listed with the false 
reacting bead/well identified.

 The results display one allele pair per row.

 Possible homozygous pairs are flagged in the Comment field.
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SSeelleecctt aann aalllleellee ppaaiirr,,
((oorr ppaaiirrss)) aanndd cclliicckk
tthhiiss bbuuttttoonn ttoo sseenndd
tthheemm ttoo tthhee ffiinnaall
aassssiiggnnmmeenntt aarreeaa..
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aa ppaaiirr ttoo
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aarreeaa
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HHoovveerr yyoouurr
mmoouussee

ppooiinntteerr oovveerr
aann aalllleellee ttoo

sseeee iittss ccooddee
ddeeffiinniittiioonn..

Assign an Allele Pair from the Suggested List

1. Double-click on an allele pair under the Possible Allele Pairs to assign it to the final pairs 

assignment area.

Alternatively, you can click to highlight an allele pair on the list under the Pairs tab, and click 
the V (assign) button next to the Assigned Allele Pairs title to add it to the final assignment 
area.

To remove an assignment, select the assignment on the Assigned Allele Pairs list and click the X
(remove) button.

Match Tab

This data grid displays the coded format of the actual allele pairings for the sample. A Matched 
Reaction Pair is a pair of alleles, (or group of alleles) with a reaction pattern that completely matches 
the reaction pattern of the current sample.

 This result differs from the Possible Allele Code results. The Possible Allele Code 
condenses the results into a single code, where possible.

 Hovering your cursor over a coded allele format displays its code definition.
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AA mmaannuuaallllyy
eenntteerreedd
aassssiiggnnmmeenntt..

PPoossssiibbllee
aalllleellee ccooddee AAlllleellee ccooddee

ddeeffiinniittiioonn

AAssssiiggnneedd
aalllleellee ccooddee

Manual Allele Pair Assignment

1. Make sure you type the assignment in the correct allele code format:

 New nomenclature format: X*##:##(####)  X*##:##(####), where X=locus type 
and #= code number.

 Previous nomenclature format: X*#### X*####, where X=locus type and #= code 
number.

Type an assignment into the text box directly below the Assigned Allele Pairs list.

Press the Enter key on your keyboard to move the typed allele upwards into the Assigned Allele
Pairs text box.

Possible Allele Codes

The Possible Allele Code field displays the possible coded results for all results that fully match the 
sample. The type of code used is dependent on your configuration selection: NMDP code, (default) local 
code, (user-defined) or no code.
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 The possible coded result is listed at the top section of the field. The code definition is 
listed below it.

 If there are no codes for a particular suggestion, then the suggestion is listed with XX, 
meaning the code is undefined. For multiple XX suggestions, each suggestion is numbered 

as XX1, XX2, etc., to distinguish one from the other.

 The allele codes displayed in the Possible Allele Code field are condensed by Fusion 
based on suggestions from the list of possible allele pairs displayed under the Pairs tab.

 The allele code is based on the current NMDP code, or local code installed in the system. 
By default, the system assigns the NMDP codes to the alleles. You can optionally change 
these codes to either No Code, Local Code or Cross Code.

 No Solution is listed if there are no results that match the sample’s reactions within the 
allowable number of false reactions.

Allele Code Assignment

1. Double-click the possible allele code, or select the suggested code and click the V (assign) 

button.

Select an allele code and click the X (remove) button to remove an allele code assignment.

Manual Allele Code Assignment

1. Type an assignment into the text field just below Assigned Allele Code. Make sure you type 

the assignment in correct allele code format:

 New nomenclature format: X*##:##(####)  X*##:##(####), where X=locus type and 
#= code number.

 Previous nomenclature format: X*#### X*####, where X=locus type and #= code 
number.

Otherwise, the system does not accept it, and prompts you to make corrections.

Note: If you click on the Translate button to display alleles in the new nomenclature format, 
you cannot enter a manual allele code unless you reanalyze the sample and alleles are 
again displaying in the previous nomenclature format.
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CClliicckk tthhee
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bbuuttttoonn hheerree..

SSeelleecctt XXXX
ccooddee hheerree……

Press the Enter key to move the allele code you typed in to the Assigned Allele Code field.

Note: If you have a homozygous result, the assigned code can be edited in the Manual Allele 
Code field to show the homozygous-coded results once.

Unknown Allele Codes

Unknown allele codes are marked with XX followed by a sequential number. The numbers are reset to 

1 for each sample and locus. When you see unknown codes, you should first make certain you have 
imported the latest NMDP file.  If you have the latest code file, and are still seeing XX codes, you can 
store these unknowns for later submission to the NMDP in a .txt file named 
nmdp_code_report.txt. By default the text file is stored in C:\OLI 
Fusion\data\NMDPExport, but the location can be changed by modifying the Interface path. Code 

information is appended to the end of this text file as it is added; the newest additions are at the 
bottom.

1. From the Possible Allele Code field, 

select the XX code to enable the NMDP 

Code Report buttons at the 

bottom of the screen.
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XXXX ccooddee ssaavveedd
aass aa sspprreeaaddsshheeeett
((..ccssvv)) ffiillee..

DDiirreecctt ttoo
NNMMDDPP

XXXX ccooddee ssaavveedd
aass aa tteexxtt,, ((..ttxxtt))
ffiillee..

Right-click the Report button and choose one of the following:

To send the unknown code information to NMDP, select 
Direct Request NMDP.

 To add the unknown code information to a text file, 
(by default stored in C:\OLI 
Fusion\data\NMDPExport), select Save in text 

file.

 To add the unknown code information to an Excel file, 
(by default stored in C:\OLI 
Fusion\data\export\NMDPExport), select Save in 

Excel File, or simply left-click the mouse button.

When you’re done, click the button to remove the buttons from display.

Note: The +Rpt button retains the last selection you made, (direct, text or Excel) so it can be 
used as a shortcut; unless you want to change your selection, the next time you report 
XX code simply click the +Rpt button.

The following shows examples of each result:
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Other Assignment

The Other Assignment field can be used to make a sample assignment that is not restricted to any 
format. In addition, you can highlight and add serology or allele pair or code assignments and add 
them to the field for modification.

You can make other code assignments one of two ways:

 Type an allele pair or allele code into the Other Assignment field.

 Click the V (assign) button and select one of two options:

1. To assign just the possible allele code, select Assign Possible Allele Code. 

2. Choose Assign All to bring the Possible Allele Code, Serology or Assigned Allele Pairs as-
signment(s) into the Other Assignment field.

 You can then choose to modify any of the copied code if desired.

 The entered allele is assigned and is included in reports that are run that include this sample.

 It is not listed in any final assignment fields for this sample.

Possible Serology Field

The serology equivalent field displays all serology equivalent suggestions for the sample based on the 
possible allele pairs. When you select a displayed serology equivalent, the allele pairs associated with 
it are displayed in the field below.

Note: Make sure you have imported the current serology equivalent file through the Utilities 
menu. If a zero (0) appears in the serology assignments, this means you need to import 
the current serology equivalent file.

 Only one serology equivalent assignment for the sample can be made at a time. Therefore, a 
current serology assignment is replaced if you select and assign a different one.
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RReemmoovvee
bbuuttttoonn
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bbuuttttoonn
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SSeerroollooggyy
EEqquuiivvaalleenntt

Note: If this is a multi-loci test, more than one locus can be assigned. However, for single locus tests, 
only one locus can be assigned.

1. Double-click a serology suggestion, or highlight it 

and click the V (assign) button to copy it to the 

Assigned Serology field.

2. Select the a serology equivalent and click the X

(remove) button to remove it. Or, select and assign a 

different one to replace it.

3. For Class II manual serology assignments there is

a pop-up message that allows the user to specifiy if 

the assignment is for DQA1 / DQB1 , DPA1/DPB1 

or DRb1/DPB345.

Translate (noncurrent nomenclature format only)

The Translate button is displayed if your alleles format is displayed with older 
nomenclature. Clicking the button does the following:

 Displays all assigned, (except from the Other Assignment field) and possible allele code/pairs 
in the latest nomenclature format. If a matching allele in the new format cannot be found, the 
allele remains displayed in the old format.

 You can view and print this display, but results cannot be saved or reported in this new 
nomenclature format.

 To go back to the older allele format, you can navigate to another sample, and then return to 
this sample.

Adding Comments to Samples

Comments you, or Fusion adds to the Comments field are displayed with the sample results in the 
current analysis session, data look up and reporting functions in HLA Fusion.

1. In the analysis window, type sample comments into the User Comment field below the 

Assignments area.
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YYoouurr oowwnn
CCoommmmeennttss

((225555 cchhaarraacctteerrss
mmaaxxiimmuumm))

CCoommmmeennttss
eenntteerreedd bbyy
HHLLAA FFuussiioonn

Or double-click in the User Comments field to open a larger writing space.

Comments are only saved after you click 
the Save button.

Note: The larger User Comments field expands to allow for a maximum of 255 characters.

Flagging a Sample for Further Testing

You can indicate the need for further testing of a sample by selecting the More Tests check box 
followed by clicking the Save >> button.  The More Tests indication is displayed in results, data look 
up and reports for the sample.

 In the analysis window, click the More Tests check box, located 
below the Assignments area.

Printing the Current Analysis Window

The Print Screen button prints the currently displayed analysis window.

 From the analysis window, click the Print Screen button on the toolbar to print the 
current analysis screen.
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Preview or Print Reports

To view a Micro SSP report for the current sample, use the Preview Report and/or Print Report
button on the toolbar.

In the analysis window, click the Preview Report button or the 

Print Report button to display a list of reports you can preview 
or print for the current sample. The drop-down report menus are 
identical for either Preview Report or Print Report.

Note: If you select Molecular Custom, you will not be able to create a new custom report at 
this point. The only custom reports available from the analysis window are ones you 
previously created through the reports window.

Assign Coded Results

Use the Assign button to assign and save all unambiguous possible coded results, (those 
results for which there is only one coded result).

Save Assignments

Lab Technicians and Supervisors can save analysis results for further review and approval. Saved 
samples are available for confirmation by a lab supervisor only.

 From the analysis window, click the Save button, located in the bottom right corner of 
the analysis window to save the analysis results.

 Fusion will automatically move to the next sample.

 Samples must be saved in order to associate any user-created comments in the database or 
reports. For confirmation, a supervisor needs to access the sample for which you saved the 
assignments.
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Confirm Assignments

Lab Supervisors can confirm analysis results. Samples are marked as Confirmed. 

 From the analysis window, click the Confirm button, located in the bottom right 
corner of the analysis window, to confirm all analysis results.

You automatically move to the next sample to continue confirming results.

When you first return to a confirmed sample, you see that the Confirm button is now 
shaded purple to let you know it has been previously confirmed.
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TThhee FFiieelldd
CChhoooosseerr

bbuuttttoonn

Micro SSP Session Summary

The summary table can be launched by clicking on a session in the Navigation Tree on the far right 
of the screen. It lists each sample in the session and any saved analysis results.

 Double-click a sample in the Summary Table to go directly to the analysis screen for this sample.

Click on the Field Chooser button to 
the left of the table headings to display 
the Field Chooser.

In this window, you can select or clear 
the check boxes next to column headings 
to include or exclude those columns 
from the Summary Table.

Selecting or clearing check boxes in this 
window instantly updates the table.

Note: If you do not see a particular field available through the field chooser, and you are sure 
it should be there, go to C:\HLA Fusion\temp and delete the file named 
SSP_Layout.xml.

 Click on any column header of the Summary Table to sort the table by that column. The small 
Up or Downarrow in the column header indicates the sorting order: up for Ascending 
and down for Descending.

You can also click on a header and drag and drop it to change the 
column order.

 You can save any modifications you’ve made to the layout by 
clicking the Yes button in the message box when it appears.
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Your changes are saved for all future Micro SSP session summaries on this same computer until 
further modifications are made and saved.

 Click the Export button, (located at the bottom of the screen) to save the Summary Table on 
your computer or network, (default location is C:\OLI FUSION\data\report). The file will 
be saved in the Excel spreadsheet (.XLS) format.

 Click the Print button to create a hard copy of the Summary Table.

 Click the Preview button to view and/or resize the Summary Table before printing.

In the print preview window, the page view slider on the left displays icons for each page of the 
report.

 Click on a page icon to display that page in the preview window.
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Navigator Right-Click Menu Options for Micro SSP

Session-Level Options

There is a menu that displays if you right-click on an active session in the Navigator, (select the session 
first with a left-click):

Reanalyze with New Nomenclature

Allows the session to be reanalyzed using a new or updated 
catalog.

1. After right-clicking on a session, the Select New 
Product screen opens.

2. Rename the session.

3. Click the drop-down arrow in the New Catalog 
ID field and select a new catalog from the list. 

4. Click the Analysis button.

The session on which you right-clicked is now re-analyzed with the catalog you’ve selected.
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SSaammppllee IIDD’’ss NNaavviiggaattiioonn bbuuttttoonnss

Sample-Level Options

Two menu options are displayed if you right-click on an active
sample in the Navigator, (select the sample first with a left-
click).

Related Records

A related record is a record that is associated with the current sample by Patient ID or Sample ID.

Note: This option is also available when you use the Related Records toolbar button .

 Right click a sample from the Navigator and select Related Records to load all records 
related to the current sample into the Sample drop-down list, (at the top, center of the 
screen).

Use the sample navigation buttons to display the analysis of each related record one-by-one.

To go back to viewing the samples in the current sessions, click the <<Summary link at the top 
of the window.

Side By Side Analysis 

Use this option to compare the current sample analysis with one previously conducted.

Note: This option is also available when you use the Side By Side Analysis toolbar button .
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 Right-click the sample, and select Side By Side Analysis.

 Select a previous sample analysis from the displayed list to compare it to the current one. The 
two analysis windows are then displayed in a comparison window.

 Each window can be resized and moved by dragging and dropping. 

 Click the Side-By-Side Analysis toolbar button again to cancel the comparison display.

SSiiddee--bbyy--SSiiddee aannaallyyssiiss ddiissppllaayy

PPrreevviioouuss
AAnnaallyyssiiss

CCuurrrreenntt
AAnnaallyyssiiss
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LABScreen Analysis

The LABScreen analysis feature of the program allows you to analyze Luminex CSV output files from 
LABScreen products. Analysis results are based on the catalog specifications provided with the HLA 
Fusion software. 

A few things should be completed or verified before you start an analysis session:

 Make sure you have the latest catalog files.

 You can download or update catalogs from the LABScreen Home Page.

 Some features, such as w632 normalization, may not be available if you have not already 
imported the appropriate catalog(s).

 View and modify global product configuration settings before starting analysis. Global settings 
are displayed and be can be modified on the LABScreen Home Page, or through the Utilities 
menu. Global settings apply across all newly imported sessions.

 Save time importing CSV files by verifying that the default URLs and paths are pointing to the 
locations where these files are commonly stored on your system or network. These settings 
can also be modified in the General Configuration section of the default Fusion Home page.

 If you prefer HLA Fusion to stay on a sample you have just saved or confirmed, rather than 
automatically move to the next sample, this can be set in the General Configurations section of 
the Fusion Explorer Home page.

Note: Some of the above tasks require supervisor user privileges. You may have to verify with 
your supervisor that these tasks have been completed.
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Starting LABScreen Analysis

Note: If you want to set W632 Normalization as the default for LABScreen Single Analysis, 
select the check box next to Use W632 Normalization as Default in the LABScreen Single 
Analysis product configuration page.

Acquiring LABScreen Session Data

Select the LABScreen button from the Home Page panel or the Fusion toolbar .

The LABScreen Home page is displayed.

TThhee mmoosstt rreecceenntt
ccaattaalloogg uuppddaatteess..

CClliicckk ttoo iimmppoorrtt
uuppddaatteedd
rreeffeerreennccee ffiilleess..

IInnffoorrmmaattiioonn
oonn aavvaaiillaabbllee
rreeffeerreennccee ffiillee
uuppddaatteess..

CClliicckk ttoo mmooddiiffyy
yyoouurr LLAABBSSccrreeeenn
gglloobbaall sseettttiinnggss..

CClliicckk lliinnkkss
ttoo ddiissppllaayy
ccaattaalloogg,,
wwoorrkksshheeeett &&
pprroobbee//pprriimmeerr
ddooccuummeennttss..

CCuurrrreenntt
wwaarrnniinngg
mmeessssaaggee
sseettttiinnggss

……ttoo ddiissppllaayy
tthhee ccuurrrreenntt

ccoonnffiigguurraattiioonn
sseettttiinnggss..

SSeelleecctt aa ttaabb……

CCuurrrreenntt nnuummbbeerr
ooff ddoowwnnllooaaddeedd

ccaattaallooggss
aavvaaiillaabbllee ffoorr

eeaacchh pprroodduucctt..
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SSeessssiioonn II..DD..
LLuummiinneexx
VVeerrssiioonn

SSeelleecctt ttoo aauuttoommaattiiccaallllyy aannaallyyzzee
aallll sseessssiioonn ssaammpplleess wwhheenn CCSSVV’’ss

aarree iimmppoorrtteedd..

DDaattee wwiillll bbee hhiigghhlliigghhtteedd iinn yyeellllooww iiff
rreeggiioonnaall sseettttiinnggss ddoo nnoott mmaattcchh bbeettwweeeenn

tthhee ccuurrrreenntt CCSSVV ffiillee aanndd FFuussiioonn..
DDeeffaauulltt
NNeeggaattiivvee
SSeerruumm,, ((NNSS))
vvaalluueess ffoorr
bbeeaaddss..

CClliicckk hheerree
ttoo ssoorrtt bbyy
ppaattiieenntt
oorr ddoonnoorr..

AAssssiiggnn PPaattiieenntt TTyyppee
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sseeee tthhee ccuurrrreenntt ppaattiieenntt lliisstt..

CClliicckk aannyy ooff
tthheessee hheeaaddiinnggss
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aasscceennddiinngg oorr

ddeesscceennddiinngg
oorrddeerr..

CCaattaalloogg IIDD &&
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IIMMGGTT vveerrssiioonn..

TThhee CCSSVV ffiillee’’ss
llooccaattiioonn oonn

ccoommppuutteerr oorr
nneettwwoorrkk..

Note: Open worksheets and probe/primer sheets to verify the accuracy of revision numbers, (these 
documents do not contain a revision number in their filename).

Select a session from the CSV File Name List.

The LABScreen Session Import window displays.

PPllaaccee aa cchheecckkmmaarrkk hheerree
ttoo lliisstt pprreevviioouussllyy
iimmppoorrtteedd CCSSVV ffiilleess..

CClliicckk tthhee ffoollddeerr iiccoonn ttoo
sseeaarrcchh ffoorr LLuummiinneexx CCSSVV
sseessssiioonn ffiilleess iinn tthhee
ddeeffaauulltt llooccaattiioonn..

SSeessssiioonn ffiilleess aarree
lliisstteedd hheerree..
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CClliicckk ffoollddeerr
iiccoonn ttoo bbrroowwssee

ffoorr CCSSVV ffiilleess..

1. Click the small folder icon at the top of the LABScreen 
CSV File Name list.

2. Select a file from the list of previously imported CSV 
files, or click the Folder Icon to browse to the 
location of LABScreen CSV file(s) on your computer or 
network.

Browse to Find LABScreen Session Files

3. Select a CSV session file(s) and click the Open button to display its associated samples in 

the Current Sample/Patient Details table.

Note: You may see CSV files for products other than LABScreen, or other miscellaneous CSV 
files. This means that you must first click on a sub folder for LABScreen, or that your 
LABScreen session files are not contained within their own folder in the directory to 
which HLA Fusion is pointing.

Note: HLA Fusion converts Luminex-generated CSV file data, such as date and time, to the 
local regional code if a regional code is specified in the CSV file. (A regional code 
cannot be specified for CSV files created with Luminex software versions 2.2 or earlier.) 
If the first date field is highlighted yellow, it indicates a regional code mismatch. In this 
case, it is recommended that you use the drop-down selector in the second date field to 
choose the appropriate date, taking into consideration regional date format differences.

If a sample is already associated with a patient, the patient ID and any existing, related patient infor-

mation is displayed.
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LLAABBSSccrreeeenn SSeessssiioonn IIDD ffiieelldd

To add patient information, do one of the following:

 To add data from the system, double-click in the Patient ID column of the Sample/Patient 
Details table or click the Patient List button on the toolbar. The Import Patient window is 
displayed, allowing you to import the patient information file.

 To manually add patient data, type data into the patient-related fields of the table.

 You can assign the sample ID to empty patient ID fields by selecting the check box for Set 
empty patient ID to Sample.

To assign secondary Ab to the samples, do one of the following:

 To assign secondary Ab to individual samples, select from the Secondary Ab drop-down, or 
type one in the associated field.

 To assign a secondary Ab to all of the samples, select from the Apply to all drop-down or 
type one in the field, and then select the Apply to all check box.

The system assigns a session ID automatically. Optionally, you can change the ID.

Note: A session ID must be unique to the Fusion database. If the session ID already exists, the 
software prompts you to rename the session. It is also highly recommended that you do not 
use any special characters in this field since they may serve a specific purpose as field 
separators.

4. Select a catalog file. Your catalog selection method is one of the following, depending on the CSV 

file and the catalog files you have imported for LABScreen.

Note: If you need to import more catalogs, click the [Download] link on the LABScreen home 
page to add new catalog files to your database. The catalog drop-down list may not be 
immediately updated if you downloaded the catalogs during this import session. You may 
need to click the Home button and then click the LABScreen button again to return to the 
import process.

If the CSV file specifies a template name, (applies only to CSV files from Luminex 2.2 and later) and one 

of the available catalogs is associated with that template, then that catalog is automatically selected.
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You can also select a different catalog from the one the system has selected by using the 
drop-down list in the Catalog ID field and selecting any catalog listed.

If there is no template match, the system then considers the closest bead match between the session and 
all available catalogs. If only one catalog is a close match, it is automatically selected and you can go to 

5. When session and sample information has been verified, click the Details button. If there is more 
than one match, a catalog validation dialog box is displayed with the best bead matches. You can 
confirm the selected catalog by clicking the Close button. Or, you can double-click a catalog name 
on the list of Suggested Catalogs.

6. Following catalog validation, the system may ask you if you would like to associate that template 
name with the catalog.

This means that in the future, for any CSV files referencing 
this template, the system automatically selects it; you can 
select a different catalog for the CSV file, though, before you 
import it.

Note: If you want to see the selected negative serum, (NS) sample overlaid with the default 
NS for the current sample, you must do so before you import the session.

If you pick a Class I Single Antigen CSV file and a catalog with W6-32 data 
in it, the Apply W6-32 check box displays. If this check box is displayed, 
you can choose whether or not to normalize the imported data for W6-32 
by selecting the check box.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 157

CClliicckk ttoo
ooppeenn tthhee

FFiieelldd
CChhoooosseerr..

CClliicckk ttoo ddiissppllaayy tthhee LLAABBSSccrreeeenn BBaattcchh RReeppoorrtt
CCllaassss II,, IIII aanndd MMIICC ddoonnoorr PPRRAA

LLAABBSSccrreeeenn SSeessssiioonn SSuummmmaarryy SSccrreeeenn

You must import a LABScreen Single Antigen catalog type and a CSV file containing W6-32 data to apply 
W6-32 normalization.

7. When session and sample information has been verified, click the Import button. The 
session is displayed in the Navigator tree on the right for subsequent analysis.

You can continue importing Luminex session files, or you can click a session on the Navigator to start 
analysis. Either way, you can navigate between sessions and samples in various ways during analysis.

LABScreen Session Summary Screen

In the Navigator Tree, click on a Session Name. The Session Summary Table is displayed.

 Double-click a sample in the Summary Table to go directly to the analysis screen for this 
sample.

 Scroll left and right to see all the columns of the Summary Table.

 Click on the Field Chooser button to the left of the table headings. The Field Chooser 
box displays. You can select or clear the check boxes next to column headings to include or 
exclude those columns from the Summary Table. Selecting or clearing check boxes in this 
window instantly updates the table.

 Click the Auto Accept All button to allow automatic assignment and acceptance, 
(both Tail and Epitope) of results upon import.

Note: If you do not see a particular field available through the field chooser, and you are sure 
it should be there, go to C:\HLA Fusion\temp and delete the file named: X_X_X(antigen 
type)_Layout.xml. For a list of the names used to represent the layout files for the 
different screening antigen products, consult the section, Session Summary Layout File 
Naming.
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 The session summary table columns and order can be modified 
and your selections saved. When you exit the Field Chooser, a 
pop-up message displays, asking whether you want to save any 
changes you made in the field chooser. If you select Yes, only 
the selected columns display on this same computer until 
further modifications are made and saved.

Note: Two columns of session data will always display, even if you save the field chooser 
settings: Sample ID and Well Pos.

 In addition to the Field Chooser, you can click on any column header in the Summary Table to 
sort the table by that column. The arrows in the column header indicate the sorting order—up 
for ascending and down for descending. You can also click on a column header and drag 
and drop it to change the column order.

 Click the Export button to save the Summary Table as an Excel, (*xls) spreadsheet on 
your computer, or on the network, (the default location is C:\OLI FUSION\data\report). 

 The Print and Preview buttons displayed here provide functionality similar to 
other HLA Fusion programs.
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Using the LABScreen Mixed Analysis Window

For each LABScreen Mixed sample in the current session, you can view the test data, adjust cutoffs, 
assign screening results and more:

 Review data and make overall assignments

 Circle antigens in the specificity table

 View molecular specificities

 View Class I, Class II and MIC screening results

 Adjust cutoffs

 Review a raw data table for all beads in the sample

 Overlay the negative serum sample on the current sample

 Add comments, mark the sample for more testing and view a sample analysis report

 Save and confirm results

The LABScreen Mixed Analysis Screen:
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TThhee FFiinndd AAnnttiiggeenn FFiieelldd

Note: If you prefer to make Graph Raw the default view when you access the LABScreen analysis 
window, go to the LABScreen product configuration settings and select the check box next to Display 
Graph Raw by Default.

 Both HLA Class I and Class II are displayed in a single window on the first tab of the screening 
results. MIC results can be accessed from a subsequent tab. Analysis results are either positive, 
negative, or undetermined.

 The normalized value is displayed using the ratio formula for each bead in the sample. 

 Beads coated with Class I antigens are listed on the Class I histogram on the left side of the 
Class I/II window, and beads coated with Class II antigens are shown on the Class II 
histogram on the right side of the window. The X-axis labels show bead numbers, and the Y-
axis labels list ranges of normalized bead values for each histogram.

Bar Colors:

 Positive = 

 Negative = 

 Undetermined = 

Find Antigen

Enter single or multiple antigens to circle the antigen(s) on the specificity, (center) area of the 
analysis window.

1. From the analysis window, type antigens, separated by a space, into the field next to the Find 

Ag (Antigen) button. The antigen strings you type in must match the antigen 

displayed on the window.
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……cclliicckk aannyy
CCRREEGG
bbooxx hheerree..

Click the Find Ag button to circle the entered antigens.

Note: If the antigen entered is a broad antigen, then its split antigens will be circled. For 
example, if A9 is entered, then A23 and A4 will be circled.

You may also click on any of the boxes in the CREG Bar, (as shown above) to circle the antigens in the 
Specificity area without having to type the antigen in the Find Antigen field.

View Molecular Typing for Antigens

1. From the analysis window, select the DNA check box below the 

Sample Name at the top to display molecular typing for the 

antigens in the sample.  Note: Antigens will now be highlighted by 

diagonal boxes in the Specificity area.

Molecular typing is displayed in Purple in the central, specificity area of the 
screen.

Clear the DNA check box to return to the display of serological specificities.

TToo hhiigghhlliigghhtt aannttiiggeennss
hheerree……
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View MIC Antibody Screening Results

Select the tab labeled MIC to review MIC results for the sample.

1. From the analysis window, click the MIC tab to display MIC screening results.

To return to Class I and Class II results, click the Class I & II tab at the bottom, left.

Adjust Cut-offs

You can change the positive or negative cut-off value for each sample by clicking and moving the cut-
off lines on the histograms. However, you can change only one threshold cut-off at a time.

 From the analysis window, click on the cutoff bar, and drag and drop it up or down the bead 
graph to re-analyze the sample with a new cut-off value.
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Cutoff colors:

 The Positive cutoff threshold is colored Red.

 The Negative cutoff threshold is colored Green.

Reset All Options to Default

Any changes made can be returned to default values.

 From the analysis window, click the Use Default button in the upper right portion 
of the window to return all changed settings to default values. The sample is re-analyzed with 
the default values that were used when the sample was selected for analysis.

Graph Raw

The Raw Data graph shows the raw Mean Fluorescent Intensity, (MFI) value of each bead overlaid 
with the imported NC Serum MFI.

1. From the analysis window, click the Graph Raw button in the upper right portion of 

the window to display a raw data graph with background values from the selected or default 

NS for each bead.
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LLAABBSSccrreeeenn MMiixxeedd RRaaww DDaattaa TTaabbllee

2. Click the Normal button, (top right) to return to a normalized graph.

Raw Data Table

Analysis information is displayed in tabular form. Positive wells are in Red text. Rows highlighted in 
yellow have reaction values over the threshold.

1. To display a sample’s data in tabular form, click the Raw Data button in the lower right 
portion of the LABScreen analysis window.

2. Click on a column header, (i.e., Baseline) to sort the table by that criteria.

3. Click the Close button located at the upper right corner of the screen to close the Raw Data 
Table window and return to analysis.

Raw Data Report

For easier navigation, exporting and printing, you can create a report containing raw data information for 
the current sample.

1. Once the Raw Data Table is displayed, click the Report button in the bottom right 

portion of the Raw Data Table window to display a report of the raw data.

You may also use the Print Screen button to export data.
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LLAABBSSccrreeeenn MMiixxeedd SSttaattiissttiiccss ttaabblleess

Statistics Table

This section of the LABScreen Mixed analysis window is in the lower left corner of the window, and 
displays statistics for each type of screening results. The values shown vary according to the screening 
results tab that is active.

Making Assignments

The Final Assignment radio buttons display the Fusion-suggested assignment. To accept the 
assignment as displayed, save or confirm the sample.

To modify the suggested assignment, do the following:

 From the analysis window, select an assignment for each class using the Final Assignment 
options, (Positive, Negative or Undetermined).
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Saving Assignments

Lab technicians and supervisors can save analysis results for further review and approval. Saved 
samples are available for confirmation only by a lab supervisor 

 From the analysis window, click the Save button, located at the bottom right corner of 
the analysis window to save analysis results for all the specificities currently listed in the 
Final Assignments field.

After clicking the Save button, Fusion automatically moves you to the next sample.

For confirmation, a supervisor needs to access the sample for which you saved the assignments. You 
can return to the sample any time prior to confirmation if you need to make changes.

Confirming Assignments

Lab supervisors can confirm analysis results. When they do so, samples are marked as Confirmed. 

The Confirm button is Purple when you view a confirmed sample.

 From the analysis window, click the Confirm button, located in the bottom right 
corner of the window, to confirm all analysis results that have been saved in the Final 
Assignments Results box.

After confirmation, Fusion automatically moves to the next sample to continue confirming results.

When you first return to a confirmed sample, you’ll see that the Confirm button is now 
shaded purple to signify that it has been previously confirmed.

Adding Comments to Samples

Sample comments are displayed for the sample’s results in the current analysis session in all analysis, 
data look up, and reporting functions in HLA Fusion.

 In the analysis window, type sample comments into the Comments (System) field below 
the Assignments area.

 Or, double-click in either field to display a pop-up window that allows more text characters to 
be entered.
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Flagging a Sample for Further Testing

You can indicate the need for further testing of a sample by selecting the More Tests check box and 
saving. The More Tests indication is displayed in results, data look up and reports for the sample.

 In the analysis window, select the More Tests check box 
below the Assignments area if more tests are needed.

Printing the Current Analysis Window

The Print Screen button on the Fusion toolbar sends the currently displayed analysis window to the 
default printer.

 From the analysis window, click the Print Screen button on the 
toolbar to print the current analysis screen.

 It is printed to the default printer you have selected for this 
computer.

Previewing and Printing Reports

To view or print an Antibody Screening Mixed Data report for the current sample, use the Preview 
Report button on the toolbar.

 In the analysis window, click the Preview Report button or Print Report button to 
display a list of reports you can print or preview for the current sample.
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RReeppoorrttss aavvaaiillaabbllee ttoo pprreevviieeww oorr pprriinntt
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Using the LABScreen PRA, Single Antigen & Singles Analysis 
Window

There are several tasks you can perform from the LABScreen window for PRA, Single Antigen, and 
Singles product analysis:

 Review data and assign specificities

 Circle antigens in the specificity table

 View molecular specificities

 Adjust cutoffs for the sample

 Graph raw data

 Exclude an antigen from analysis

 Sort antigens for Single Antigen samples

 Make tail or epitope analysis assignments

 Manually enter an assignment

 Assign a sample as negative

 Add comments, mark for more testing and/or view a report for the current sample.
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If you prefer Graph Raw as the default view when viewing the LABScreen analysis window, access the

LABScreen product configuration settings and click the check box Display Graph Raw by Default.

CREG Table

The CREG Groups are displayed at the top of the table, with the specificities for the group displayed 
below. Specificities are highlighted in one of the following colors.

Note: If you want to hide the display of the CREG bar, click the CREG title at the top of the 
window. A dialog box displays asking if you want to hide the CREG bar. Click Yes to hide 
it. To re-display it, click again on the CREG title and click the Yes button to show it.

 Purple = positive assignments from the Epitope Analysis Results box

 Pink = Tail assignments that are masked by Epitope analysis

 Blue = Cw assignments

 Green = Bw4 and Bw6 assignments
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 Click a CREG group, or 
antigens to circle the 
corresponding 
specificities.

 Right-click an antigen 
to move the specificity 
to the Final 
Assignments box.

Do the following if you want to use a different CREG table:

 Click the LABScreen                              home page button, 
or select Utilities > Antibody Product Configuration 
> Set Analysis Configuration.

 From the Home page, click the Edit link to display the 
Analysis Configuration Settings menu.

 Select a table from the CREG drop-down list.

 Click the Save button at the bottom of the menu.

Note: For information on creating or editing a CREG list, review the section, Managing CREG 
List Information.

Find Antigen

To enter multiple antigens, use a space to separate each entry. All entered antigens are circled in the 
specificity field.

Clicking on the labels for Tail Analysis Results, Epitope Analysis Results, or Final Assignment fields 
circles all specificities listed in the selected results field.

Clicking the Excluded Antigen field label circles the excluded antigens.

If you use the Find Antigen feature while the window is displaying molecular specificities, you are not 
able to see the circled antigens until you deselect the DNA check box.
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RRiigghhtt--cclliicckk iinn tthhee lliigghhtt bblluuee aarreeaa ttoo cchhaannggee tthhee LLaabb SSccaallee..

1. From the analysis window, type antigens or CREG groups 

(e.g., 1C or 2C) into the field next to the Find Ag (Antigen) 

button.

4. Click the Find Ag button and Fusion will circle the entered antigens or CREG groups.

Click the Find Ag button again to remove the circles from antigens in the specificity field.

Change the Lab Scale

The maximum value for the bead graph scale, per the baseline, user or raw data formula can be 
modified from the analysis window. To do so, follow these steps:

 Right-click in the background area of the analysis window, just above the top value of the y-axis of 
the bead graph.

 Select Set Max Scale.

 Type a new value in the Scale field and press the Enter key on your keyboard.

To return to the LAB Scale value, follow the above steps, but select the LAB Scale option.
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MMoolleeccuullaarr ssppeecciiffiicciittiieess aarree ddiissppllaayyeedd wwhheenn tthhee DDNNAA CChheecckk bbooxx iiss sseelleecctteedd..

AAddjjuussttiinngg TThhrreesshhoolldd CCuutt--ooffffss

View Molecular Specificities

Molecular specificities are displayed in the specificity field of the analysis window, and can be used to 
make allele assignments. Screening results are displayed and saved as serological specificities.

1. From the analysis window, select the DNA check box near the top of the Analysis 

Screen to display molecular specificities.

Clear the check box to return to the serological specificities.

Adjust Cut-offs

You can change a threshold cut-off value for each sample. You can only change one threshold cut-off 
at a time.

1. In the analysis window, click on the threshold bar you want to adjust.

2. Drag and drop the cut-off bar to adjust the cut-off and re-analyze the sample.
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NNoorrmmaalliizzaattiioonn FFoorrmmuullaa SSeelleeccttiioonn

Select Minimum Positive Threshold

You can change the minimum positive threshold by using the pull-down menu above 
the bead graph.

 From the analysis window, select a new positive threshold from the 
Threshold drop-down list, (next to the analysis tools near the top of the 
window). The sample is re-analyzed according to the new threshold. The effects 
of the threshold change are displayed in the result boxes.

Change Normalization Formula

By default, LABScreen analysis uses the Baseline normalization formula. You can change the 
normalization formula used in analysis to any of the following: Ratio Scoring, Mixed and Raw Data. 
When using the Raw Data normalization formula, the sample negative control is shown as a black line on 
the Bead reactivity graph. Changes apply only to the current sample.

 From the analysis window, select a new normalization formula from the Formula drop-down 
list. The sample is re-analyzed.

Exclude Antigen(s) from Analysis

All antigens entered are excluded from analysis. To enter multiple antigens, use a comma to separate 
antigen entries. 

1. From the analysis window, click the Excl. Ag. button. The Exclude Antigen pop-up box is 

displayed.
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2. Type the antigens to be excluded and click the OK button. Note: the 
use of wildcard characters, i.e. * is not allowed here.

If you change your mind and click the Clear button, your entries will 
be deleted and you’ll see this message:

The sample is re-analyzed, and the excluded antigens are listed in the Excluded Antigens field under the 
analysis statistics box.

To include all these antigens again, click the Excl. Ag button 
again, click the Clear button to remove antigens from the field, and 
then click OK to re-analyze with these antigens included.

Note: To also exclude all typing antigens for the associated patient, select the Exclude 
Patient Typing check box.

Include/Exclude Cw

You can include or exclude Cw antigen specificities from analysis.
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NNoorrmmaalliizzeedd
GGrraapphh

RRaaww DDaattaa
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1. Near the top of the analysis window, select the Cw check box to re-analyze with Cw specificities.

Clear the Cw check box to re-analyze without Cw specificities.

Reset All Options to Default

Any changes you make can be returned to the default values.

 From the analysis window, click the Use Default button in the upper right corner of 
the window to return all changed settings to the default values for this sample.

 The sample is re-analyzed with the default values.

Force Positive

If a sample has a low bead count, the Force +ve button is displayed, allowing you to force a 
positive result by recalculating for allowance of low bead counts.

 For low negative control samples, click the Force +ve button  to analyze the sample 
as positive.

The sample is re-analyzed.

Graph Raw

The Raw Data Graph shows the raw Mean Fluorescent Intensity, (MFI) value of each bead overlaid 
with the imported NC Serum MFI.

1. In the analysis window, click the Graph Raw button to display raw data graph with 

background values.

Click the Normal button to return to normalized graph.
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LLAABBSSccrreeeenn PPRRAA//SSAA RRaaww ddaattaa ttaabbllee

Raw Data Table

Positive beads are displayed in red text. Rows highlighted in yellow have normalized values that are 
above the value in the Min Value box. Changes made to the normalization formula and minimum 
normalized value apply only to the raw data table and not to analysis.

1. From the analysis window, click the Raw Data button on the bottom right of the 

analysis window to display Raw Data Table.

Click on a header to sort the table by that category.

Note: You can select a different formula from the Formula drop-down list, (either baseline, 
ratio scoring, or raw data), but if you do this, you must also adjust the Min Value
(lowest value of a positive for the current sample based on the selected reaction 
threshold) so it correlates with the new formula. 

2. Click on the button located at the upper right corner of the table, or the Close button to 
exit and to return to analysis.

Raw Data Report

For easier navigation, exporting and printing, you can create a report containing the raw data 
information for the current sample.
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1. Once the Raw Data Table is displayed, click the Report button on the bottom right 

portion of the Raw Data Table window to display a report of the raw data.

Displaying DSA (Donor Specific Antigen)Match/Mismatch

By clicking the M button, you can display all the DSA match/mismatch information for the patient 
associated with this sample and the donor(s) associated with the patient.

Note: If you do not have a patient associated with this sample, you will receive a warning 
message, and will not be able to display any DSA match/mismatch information until you 
associate a patient to the sample and at least one donor to the patient.

To display the information, take the following steps:

1. Click the M button, (next to the T button on the right). If you have a patient associated with this 

sample, the DSA Match/Mismatch window opens.

If necessary, select another donor from the Donor 
ID drop-down list.

Use the  or - buttons to expand, or collapse the 

table.

The colors on the table mean the following:

 Green: represents a matched antigen.

 Orange: represents a mismatched 
antigen that has been confirmed in the 
final assignment.

 Yellow: represents a mismatched 
antigen that has not yet been 
confirmed in the final assignment.
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Adding Comments to Samples

Comments you or the system add to the Comments field are displayed with the results in the current 
analysis session, data look up and reporting functions in HLA Fusion.

1. In the Analysis Window, type sample comments into the Comment field below the 

Assignments area.

Comments are saved when you click Save.

Flagging a Sample for Further Testing

You can indicate the need for further testing of a sample by selecting the More Testscheck box 
and saving.

The More Tests indication is displayed in results, data look up and reports for the sample. 

 In the analysis window, check the More Tests check box, located below the 
Assignments area.

 The Test Selection window is displayed.

 Select the check boxes next to the additional tests you want run.

 Enter a name for the test list you are creating.

 Click Save to save the test list and return to the analysis window.

Printing the Current Analysis Window

The Print Screen button prints the currently displayed analysis window.

 From the analysis window, click the Print Screen button on the toolbar to print the current 
analysis screen.

Previewing and Printing Reports

To view or print a report for the current sample, use the Preview Report button on the toolbar.

 In the analysis window, click the Preview Report button or Print Report button to 
display a list of reports you can print or preview for the current sample.
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RReeppoorrttss aavvaaiillaabbllee ffoorr pprreevviieeww//pprriinnttiinngg

Note: If you select Antibody Custom, you are not be able to create a new custom report at 
this point. The only custom reports available from the analysis window are ones you 
previously created through the Reports window. 

Making Final Assignments

Final assignments can be made from either the Tail, (not applicable to LABScreen Singles samples) or 
Epitope results fields.

Note: If you want the Mean, (Normal) of positives to be used for Epitope analysis, instead of 
the Mean, (Raw) of positives, check the setting Use the Mean of Normal on the 
LABScreen PRA, Single Antigen and Singles product configuration screens.

From the analysis window, do one of the following to make assignments:

 Double-click an antigen specificity in the Tail or Epitope Analysis results box to assign the 
specified antigen to the Final Assignment list.

 Click to highlight the specificity and click the Assign Single button  to move it to the 
Final Assignment list.

Click the Assign All button to the right of the Tail or Epitope list to move all the current 
results on that list to the Final Assignments area.

 Right-click on a specificity, or CREG group on the CREG Table to assign it to the Final 
Assignments area.

Manual Assignments

Manual assignments can be entered in the field below the Final Assignments results box. Enter 
multiple manual assignments simultaneously by leaving a space between each specificity.
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1. From the analysis window, type a manual antigen specificity assignment in the field under the 
Final Assignment box.

2. Click the Assign button (), just above the Manual Assignment field, or press the Enter key 
to add the assignment to the Final Assignment results box.

Assigning Negative Sample Values

You can assign a negative value to a sample even if analysis shows some positive results.

 From the analysis window, click the Assign –ve button, (located just above the Manual 
Assignment field) to force the sample to have a negative value.

Removing Assignments

Specificities can be removed from the Final Assignments results box. You can remove more than one 
specificity by holding down the Ctrl key and clicking each specificity you want to remove.

 From the analysis window, click to highlight specificities on the Final Assignment list, (hold 
down the Ctrl key to select more than one) and click the Remove button, (located 
below the Final Assignments results box).

Saving Assignments

Lab Technicians and Supervisors can save analysis results for further review and approval. Saved 
samples are available for confirmation only by a lab supervisor.

 From the analysis window, click the Save button, located at the bottom right corner of 
the analysis window, to save the analysis results for all the specificities currently listed in the 
Final Assignments field.
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Fusion automatically moves to the next sample.

For Confirmation, a supervisor needs to access the sample for which you saved the assignments. 
You can return to the sample at any time prior to confirmation if you need to make changes. Click 
the Reanalyze button and then the Save button again.

Confirming Assignments

Lab supervisors can confirm analysis results. When they do so, samples are marked as Confirmed. 
The Confirm button is Purple-colored when you view a confirmed sample.

 From the analysis window, click the Confirm button, located in the bottom right 
corner of the window, to confirm all analysis results that have been saved in the Final 
Assignments results box.

Fusion automatically moves to the next sample to continue confirming results.

When you first return to a confirmed sample, you’ll see that the Confirm button is now 
shaded Purple to let you know it has been confirmed previously.

Getting Tail Analysis Values (Except Singles)

Tail analysis values can be displayed in the analysis with the final 
assignments, but are not stored for look up or reporting.

 From the analysis window, click the T button, located to the upper 

right of the Final Analysis results box, to display tail analysis 
values in Final Assignments results box.

Donor PRA (Except Singles)

You can display the percentage of PRA from available donors in the system or from selected donor 
groups who match the computer-assigned antibodies for the current sample.

Note: To select a donor, or donor groups, click the Donor PRA button. You can also auto-
select groups by selecting Utilities > General Settings. To create a donor group, select 
Patient Info > Manage Patient, select Donor in the Patient/Donor field, and fill in the 
donor group field.
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1. For Single Antigen or PRA analysis, click the Donor PRA

(DPRA)                 button. A pop-up box displays the percentage of 

matching donor PRA and the total number of donors that were 

considered in the calculation.

Click OK to close the box. The percentage and number of donors remains 
displayed next to the Donor PRA button. 

Calculated PRA

You can perform Calculated PRA (CPRA) analysis by clicking on the CPRA                  button, found to 

the right of the DPRA button on the lower left panel. Clicking the CPRA button will calculate PRA 

(UNOS calculator) using unacceptable antigens assigned to the patient record.

From within the Final Assignment box, select several anti-

gens by highlighting them, then right-click and choose “Add 

Unacceptable Antigen.” 

Now, click the CPRA button. 

The percentage score will  

appear next to the CPRA 

button. The list of selected 

antigens appears below to 

the left under the System 

Comments area.

0 % (1)
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Choosing Minimum Positive Threshold Cutoffs (Except Singles)

You can set the minimum positive threshold cutoffs to use with any LABScreen PRA or Single 

Antigen sample. To set the cutoffs for X8 - X2, review the section Changing Antibody Screening 

Analysis Configuration. You can then switch between the OLI provided cutoffs and the ones defined 
through Fusion by doing the following:

 To choose user-defined cutoffs, select the check box next to User Cutoff

 To go back to using the OLI cutoffs, clear the User Cutoff check box.

Hiding Tail Analysis Values (Single Antigen)

You can choose to hide the display of Tail analysis values from Single 
Antigen sample analysis, but these values remain stored for look up or 
reporting.

1. Select the Utilities > Antibody Product Configuration 
> Set Analysis Configuration menu option.

2. Select LABScreen Single Antigen from the Product Type drop-down menu at the top 
of the display.

3. Select the Hide Tail Analysis Window check box, located at the bottom of the Single 
Antigen product configuration dialog box.

4. Click the Save button at the bottom of the menu.

LABScreen Single Antigen samples imported after this configuration change do not display the tail 
analysis assignment area on the sample analysis window.

Navigating Between Class I and Class II (PRA Class I and II Combined)

For Combined Class I and II LABScreen PRA sessions, each class is analyzed separately and needs to be 
saved separately for the combined results to appear in the database.

Make sure that you have already created a combined Class I and Class II LABScreen PRA catalog 
before you import the combined sessions.

 From the analysis window, click the Run Class I and Run Class II buttons , 
located in the upper left part of the analysis window, to switch between Class I and Class II 
results for the current sample.

Sort Antigen (Single Antigen)

Single Antigen trays can be sorted in order of specificity, instead of reaction value.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 185

1. For Single Antigen analysis, click the Sort Ag. Button. 

The graph is sorted by bead number.

2. Click the Refresh button to return to the default graph.

LABScreen Mixed Batch Analysis allows you to quickly analyze a session and save it for later review and 
final assignments. You cannot view samples graphically during batch analysis, and no final screening 
assignments are made.

 Batch analyze a session

 View the Batch Analysis report

 Save analysis results
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Overview

After batch analysis is performed, the LABScreen Batch Analysis Report is displayed. Results can be 
saved, but they need to be confirmed individually.

Save Batch Analysis

Lab technicians and supervisors can save batch analysis results for further review and approval. Samples 
are marked as Ready.

1. Click Save>> at the bottom of the report menu to save all samples to the database.

1. Click Exit to close and return to the Main Menu.

Review/Analyze Samples

To let you view batch results in more detail after saving, the Analyze button displays the session in the 
Analysis window. Each sample needs to be saved individually if you did not save the batch analysis 
session before reviewing the batch results.
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Navigator Right-Click Menu Options for LABScreen

Note: These options apply to all LABScreen sessions and samples.

There are analysis options available through the Navigator -
depending on whether you are in the LABScreen session 
summary view, or on an analysis screen for a sample.

By right-clicking on the Current Session in the Navigator 
window, you’ll see menu options that allow you to affect your 
LABScreen analysis sessions before, during or analysis.

Reanalyze with New Settings/Catalog

Allows the session to be reanalyzed using new
settings or an updated catalog.  Here’s how:

1. Click the drop-down arrow in the New 
Catalog ID field and select a new catalog 
from the list.

2. Rename the session, (Sessions must have 
unique names).

3. Click the Analysis button. The 
session on which you right-clicked is 
reanalyzed with the catalog you’ve 
selected.
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SSaammppllee--lleevveell NNaavviiggaattoorr OOppttiioonnss

SSiiddee--bbyy--ssiiddee AAnnaallyyssiiss SSeelleeccttiioonn LLiisstt

Sample-Level Options

There are two menu options that are displayed if you right-click on an Active Sample in the Navigator, 
(select sample first with a left-click):

Related Records

A related record is a record that is associated with the current sample by Patient ID or Sample ID.

Note: This option is also available by using the Related Records toolbar button .

 Right-click a sample in the Navigator, and select Related Records to load all records related 
to the current sample into the Sample drop-down list at the top of the screen. Use the sample 
navigation arrows to display the analysis of each related record one by one.

 To go back to viewing the samples in the current sessions, click the <<Summary link at the 
top of the window.

Side-By-Side Analysis
Use this option to compare the current sample analysis with one previously conducted.

Note: This option is also available by using the Side-By-Side Analysis toolbar button. 
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 Right click on a sample from the Navigator, and select Side By Side Analysis. Select a 
previous sample analysis from the displayed list to compare to the current one.  (The current 
sample is displayed with a light brown background.)

 The two analysis windows are then displayed together in a comparison window.

 Each pane of the window can be resized and moved independently by dragging and dropping. 
Click the Side-by-side Analysis toolbar button to cancel the comparison display.
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LAT Analysis

The LAT™ analysis feature of the program analyzes CSV output files, manually-entered reaction 
patterns, or ELISA results as a new session and can continue the analysis of a previously unfinished 
session. Analysis results are based on catalog specifications provided with the software.

There are a few things that should be completed or verified before you start an analysis session:

 Make sure you have the latest catalog files before you analyze. You can download or update 
catalogs from the LAT Home Page by clicking on             .

 View and modify global product configuration settings before starting analysis. Global settings 
are displayed and be can be modified on the LAT Home Page by clicking on, or through 
the Utilities Menu . Global settings apply across all newly imported sessions.

 Save time importing CSV files by verifying that the default URL’s and paths are pointing to the 
locations where these files are commonly stored on your system or network. These settings 
can be modified in the Utilities > General Settings section of the default Fusion Home 
page.

Note: Some of the above tasks require you to have Supervisor Privileges. You may have to 
verify with your supervisor that these tasks have been completed.
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Starting LAT Analysis

Acquiring LAT Session Data

There are four basic methods to import session data for LAT Analysis in HLA Fusion:

1. Manual Entry the data from only one session is manually entered from the keyboard.

2. Batch Entry the data from several sessions are manually entered in a series.

3. CSV file a properly-formatted CSV file is directly imported into Fusion for LAT Analysis.

4. ELISAread analysis data directly from the Biotek ELX 800 ELISA reader.

Click the LAT button from the Home Page panel, or the LAT icon on the Fusion Toolbar 
to open the LAT program.

The LAT Home page is displayed.

Note: Open worksheets to verify the accuracy of revision numbers, (these documents do not 
contain a revision number in their filename).

CClliicckk tthheessee lliinnkkss
ttoo ddiissppllaayy
sseelleecctteedd ccaattaalloogg,,
wwoorrkksshheeeett ddoocc--
uummeennttss..

PPllaaccee aa
cchheecckk mmaarrkk

hheerree ttoo
iinncclluuddee

pprreevviioouussllyy
iimmppoorrtteedd
CCSSVV ffiilleess..

CCSSVV FFiillee
lliisstt

CClliicckk ttoo
ooppeenn tthhee
CCaattaalloogg

MMaannaaggeerr

CClliicckk ttoo ooppeenn tthhee
AAvvaaiillaabbllee RReeffeerreennccee
FFiillee UUppddaattee wwiinnddooww

CClliicckk ttoo mmooddiiffyy LLAATT
gglloobbaall sseettttiinnggss..
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Single Session Manual Entry

To manually enter a single session for LAT Analysis, do the 
following:

1. Click the Manual Entry button at the top of the LAT 
Home panel.

2. In the top text field of the next window, 
enter a unique name for the new manually-
entered LAT Analysis session.

3. Click the DownArrow of the Select
Product Catalog field and select the 
appropriate LAT Product Catalog.

4. Next, type in the correct Test Date, or click 
the DownArrow to reveal the pop-up 
calendar and select the test date.

5. Click the Next button.

The Data Input Menu displays.

This allows you to input reaction values for a new sample. 

You can enter the samples and reactions into a session—a 10 test tray, 
or a 20 test tray.  Data may be entered manually by clicking on each 
well, or by obtaining raw data values from an ELISA reader.

6. Enter a Sample Name(s). A unique Sample Name is required 
for analysis. The Sample Date may be changed here if necessary.
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Manual Batch Entry

To manually enter a more than one session for analysis, do the following:

1. Click the Batch Entry button.

A blank Session Summary Screen opens.

Unlike Manual Entry which is limited to just one session, Batch Entry allows you to enter a group of 
sessions with the Session Summary screen.  This allows you enter data in a tabular format with each row 
representing one session.

2. Enter a unique name for this batch, or accept the default 
batch name which Fusion suggests.

3. Manually select and/or enter session data beginning 
with the HLA class, (I, II, Class I PRA + Class II PRA 
and Single Class I) at the left side of the Session 
Summary Screen and continue to the right until all the 
available data for a session has been entered.

The fields with an asterisk () are required.  This includes the fields that are completed by using drop-
downs, (Catalog Name and Test Date) and the Session ID.
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Continue entering session data as needed.  Note that once you’ve entered data for a session and have 
started entering data for the next session, you cannot return to the previous line of session data.  
However, after a batch has been saved it can be reopened and edited.

4. When all data for a batch of sessions has 
been entered, click the Save
button at the bottom of the screen.  The 
batch has been saved and is included in 
the list of Existing Batches in the 
drop-down list at the top of the screen.

5. After you’re finished entering session data for this batch, click the Next button.

Similar to Manual Input of Session data as discussed previously, the Data Input Menu and the main LAT 
Analysis window appears.

Importing CSV files in LAT

1. Click the Folder Icon to open the Select CSV Files list.

2. Select one or more sessions from the Select CSV Files list.

3. Click the Open button.

The CSV Files are now displayed in the CSV File Name List.
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CCuurrrreenntt SSaammppllee//PPaattiieenntt DDeettaaiillss TTaabbllee

CClliicckk tthhee
BBrroowwssee BBuuttttoonn
ttoo llooccaattee
PPaattiieenntt
IInnffoorrmmaattiioonn
lliissttss..

Note: You may see CSV files for products other than LAT, or other miscellaneous CSV files. This 
means that you must first click on a sub folder for LAT, or that your LAT session files are 
not contained within their own folder in the directory to which HLA Fusion is pointing.

4. Click on a CSV file to display its associated samples in the Current Sample/Patient Details
table.

If a sample is already associated with a patient, the Patient ID and any existing, related patient 
information is displayed.

To add patient information, do one of the following:

1. To add data from the system, click the Patient List button.

The Import Patient window is displayed, allowing you to import the patient information file.
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To manually add Patient Data, simply type data into the patient-related fields of the table.

 You can have Fusion assign the Sample ID 
to empty Patient ID fields by checking the 
box for assigning the Sample ID to empty 
Patient IDs.

2. The system assigns a Session ID by default. Optionally, you can type in a different Session ID.

Note: A session ID must be unique to the Fusion database. If the session ID already exists, the 
software prompts you to rename the session. It is highly recommended that you not use 
any special characters in this field since they may serve a specific purpose as field 
separators.

3. Accept the displayed Catalog file, or select a Catalog file from the drop-down list in the 
Catalog ID field.

Note: If you need to import more catalogs, click the Download              link on the LAT Home 
page. The catalog drop-down list may not be immediately updated if you downloaded 
the catalogs during the current import session. You may need to click the Home button 
and then click the LAT button again to return to the import process.

4. When session and sample information have been verified, 
click the Import button. The session is now 
displayed in the Fusion Navigator tree on the right side of 
the analysis screen for subsequent analysis.
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You can select a session from the Fusion Navigator to view its summary; then select a sample from the 
session summary to view its analysis. Or, you can continue importing samples from the Import Sample 
list.

5. In the Navigator, click on a Session Name. The Session Summary Table is displayed:

 Double-click a sample in the Summary Table to go directly to the analysis screen for this 
sample.

 Scroll left or right to display all of the Summary Table fields.

 Click on the Field Chooser button to the left of the table headings. In this window, you can 
select or clear the check boxes next to column headings to include or exclude those columns from 
the Summary Table. Selecting or clearing check boxes in this window instantly updates the table.

Note: If you do not see a particular field available through the field chooser, and you are sure 
it should be there, go to C:\HLA Fusion\temp and delete the file named X_X_X(antigen 

type)_Layout.xml.

 Click on any column header of the Summary Table to sort the table by that column. The arrow 
in the column header indicates the sorting order - up for ascending and down for descending. 
Columns can also be dragged-and-dropped to change their order.

 The session summary table columns and order can be modified. When you close the Field 
Chooser, a pop-up message displays to let you choose whether or not to save any changes 
you made. If you click Yes, your changes are saved for all future LAT session summaries on 
this same computer until further modifications are saved.
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PPrriinntt//PPrreevviieeww SSuummmmaarryy TTaabbllee

SSuummmmaarryy TTaabbllee eexxppoorrtteedd aass aann EExxcceell sspprreeaaddsshheeeett

 Click the Export button to save the Summary Table on your computer or the network, 
(default locations C:\OLI FUSION\data\report). The file is saved in Excel (*.xls) format.

 Click Print to print out a report of the Summary Table.

 Click Preview to view a report of the Summary Table.

 In the print preview window, the page view slider on the left allows you to select different pages of 
the report.

 The session summary table columns and order can be modified. You can save any modifications 
you make to the layout by clicking the Save Layout button. Your changes are saved for all future 
LAT session summaries on the same computer until further modifications are made and saved.

If you want to exclude a sample from an analysis session, select the Exclude check box next for that 
sample. The sample is still displayed on the Reports sample list; to prevent it from being included in 
report data, do not select that sample during report creation.
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LLAATT MMiixxeedd AAnnaallyyssiiss SSccrreeeenn

Using the LAT Mixed Analysis Window

For each sample in the current session, you can view the test data and assign screening results. HLA 
Fusion analyzes a sample when you move to view that sample. To analyze an entire session, you must 
view all samples in the session and assign the results.

From the analysis window you can:

 View and print sample analysis results

 Circle antigens in the specificity table

 Sort by well position

 Add comments and mark the sample for more testing

 View a Quick Report for the current sample

 Export reaction data to a CSV file

Note: You can return to a session summary from the analysis window any time by clicking the 
<<Summary link from the HLA Fusion toolbar next to the sample/session ID.
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DDaattaa iinnppuutt aanndd rreeaaccttiioonn ppaatttteerrnn ((1100 tteesstt ttrraayy))

Entering Data and Reaction Pattern 

The data input menu displays the current reaction for an existing sample or allows you to input reaction 
values for a new sample. This area allows you to enter the samples and reactions into a session—10 test 
tray, or 20 test tray. Data may be entered manually or by obtaining raw data values from ELISA reader.

 The format of the data input section mimics an LAT mixed analysis worksheet. The reaction 
input panel has a tray layout. The row of wells for the current test is highlighted by a blue 
rectangle.

 Each well is a button that cycles through reaction values (1, 8, 6, 4, 2, 0). Buttons are color-
coded to match the reactions.

 You can enter reactions by clicking a button and typing a reaction value, or by clicking the 
button until it displays the desired reaction.  When the button changes, the focus shifts to the 
next button.  

 Button navigation occurs from left to right (1A –1F, 2A – 2F…etc.).

 Where the product has a blank well, the corresponding reaction button is disabled.

 Sample list/entry for the tray is listed along the side of the panel. You must enter a sample ID 
before the reaction can be saved to the database. The session does not require that all wells of 
the tray be used.

 Once you analyze a tray, you can no longer add any more sample information to that tray.
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Using the ELISA Reader

To read analysis data directly from the Biotek ELX 800 ELISA reader, the computer on which you are 
running HLA Fusion must be connected to the ELISA reader. Connect and calibrate the ELISA reader 
according to product specifications. HLA Fusion can analyze only 96-well Terasaki trays. ELISA reads the 
trays, and transfers the raw data to HLA Fusion.

 From the analysis window, click Read From to import data from the ELISA reader.

Note: The Read From button is displayed only when your computer is connected to the ELISA 
reader, and you have not yet entered any manual reactions for the current test. 

LAT Mixed Histogram

This histogram displays the reaction value for each well position of the current tray in a session. It also 
displays the average negative control wells for the test group as a narrow light green bar superimposed on 
each reaction well bar.

Wells are sorted by test groups; Class I, Class II and control wells are sorted together.

 X-axis shows the well position.

 Y-axis lists ranges of reaction values (e.g., 1 to 10).

Bars are color-coded based on their reaction value:

 8 = Red

 6 = Orange

 4 = Gold

 2 = Blue

 1 = Green

HHiissttooggrraamm ffoorr LLAATT MMiixxeedd aannaallyyssiiss
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LLAATT AAssssiiggnnmmeennttss aarreeaa

Horizontal lines represent the positive threshold you set for Class I and Class II. The line(s) assumes the 
same color as the RXN color code.

Making Assignments

The Final Assignment option buttons display the software-suggested assignment, (Positive, Negative 
or Undetermined). To accept the assignment, save or confirm the sample, (see the following sections).

To modify the suggested assignment, do the following:

1. From the analysis window, select an assignment for each Class using the Final Assignment

option buttons— Positive, Negative or Undetermined.

Save Assignments

Lab Technicians and Supervisors can save analysis results for further review and approval. Saved 
samples are available for confirmation only by a Lab Supervisor.

 From the analysis window, click the Save button, located in the bottom right corner of the 
analysis window, to save analysis results for all the specificities currently listed in the Final 
Assignments results box.

Fusion automatically moves to the next sample.

For confirmation, a Supervisor needs to access the sample for which you saved the assignments. You 
can return to the sample any time prior to confirmation. If you need to make changes, click the 

Reanalyze button and then the Save button again.
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TTyyppee yyoouurr oowwnn ccoommmmeennttss iinn tthhiiss aarreeaa

SSyysstteemm ccoommmmeennttss aauuttoommaattiiccaallllyy aaddddeedd hheerree

DDoouubbllee--cclliicckk iinn
eeiitthheerr tteexxtt ffiieelldd

ttoo ooppeenn tthhee llaarrggeerr
ccoommmmeennttss wwiinnddooww

Confirm Assignments

Only Lab Supervisors can confirm analysis results. When they do so, samples are marked as Confirmed. 
The Confirm button is Purple when you view a confirmed sample.

 From the analysis window, click the Confirm button , located in the bottom right corner 
of the window, to confirm all analysis results.

You automatically move to the next sample to continue confirming results.

When you first return to a confirmed sample, you see that the Confirm button is now 
shaded purple to let you know it has been confirmed before.

Adding Comments to Samples

Comments you or Fusion add to the Comments fields are displayed with the results in the current 
analysis session, data look up and reporting functions in HLA Fusion.

 In the analysis window, enter sample comments into the Comment field below the Assignments 

area.

Comments are saved only after you click the Save or Confirm buttons.

Flagging a Sample for Further Testing

You can indicate the need for further testing of a sample by selecting the More Tests check box and then 
saving.

The More Tests indication is displayed in results, data look up and reports for the sample.

1. In the analysis window, check the More Tests check box, located below the 
Assignments area at the bottom, right.

2. Click Save or Confirm to preserve the setting.
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Adding Tray Information

You can add information about the current tray, such as expiration date, by clicking the Info
button. The following dialog box is displayed when you click this button, allowing you to add 
information about this sample tray.

Exporting Session Data

You can click the Export button (located at the bottom, right above the Save>> button) to export 
session data into a file similar to the Luminex output CSV format.

If you have a separate workstation for ELISA and analysis, the exported file can be imported for analysis 
and used on another computer.

Raw Data Table

Positive beads are displayed in Red text. Rows highlighted in Yellow have normalized values over the 
minimum value. 

Changes made to the normalization formula and the minimum normalized value apply only to the raw 
data table and not to analysis.

1. From the analysis window, click the Raw button at the bottom right of the analysis window 

to display raw data table.

labsupervisor1
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RRaaww DDaattaa ttaabbllee

Click a column header to sort the table by that category.

Click the Exit button at the upper right corner of the table to close the window and to return to 
analysis.

Raw Data Quick Report

For easier navigation, exporting and printing, you can create a report containing raw data information for 
the current sample.

Once the Raw Data Table is displayed, click the Report button at the bottom right portion of the 
Raw Data table window to display a report of the raw data.

Click the Exit button at the upper right corner of the table to close the window and to return to 
analysis.

Click the Print Screen button to display a preview of the currently visible portion of the Raw 
Data Table.

Click the Printer button at the top left of the window to send the image directly to the printer.

Click either the Exit or Close buttons to close the window and to return to analysis.
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Printing the Current Analysis Window

The Print Screen button sends the currently displayed analysis window to the default printer for your 
computer.

 From the analysis window, click the Print Screen button on the Fusion toolbar to print the 
currently visible portion of the analysis screen.

Previewing and Printing Reports

To view or print an Antibody Screening Mixed Data report for the current sample, use the Preview 
Report button on the toolbar.

 In the analysis window, click the Preview Report

button or the Print Report button to display a list 
of reports you can print or preview for the current 
sample.

Note: If you select Antibody Custom, you cannot create a new custom report at this point. The 
only custom reports available from the analysis window are ones you previously created 
through the Reports window.
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LLAATT PPRRAA//SSiinnggllee AAnnttiiggeenn AAnnaallyyssiiss

Using the LAT PRA/Single Antigen Analysis Window

This window provides detailed analysis information for each sample in the session. It allows you to 
review the specificity assignments suggested by the program and to modify and accept the assignments. 
HLA Fusion suggests possible screening results, but the final assignment must be made by the user.

From the analysis window menu you can do the following:

 Select minimum positive threshold

 Exclude selected, or Cw specificities

Note: You can return to a session summary from the analysis window any time by clicking the 
<<Summary link from the HLA Fusion toolbar next to the sample/session ID.

Entering the Reaction Pattern

Click each well to change its reaction value, or type a reaction value when the well is highlighted. Wells 
with white borders are control wells; wells with black borders are reaction wells.

1. From the analysis window, type a sample name into the Top/Bottom Sample fields and press 

the Enter key, (for two test trays, enter both top and bottom sample names).

2. Enter reaction patterns by clicking on wells to change the reaction value. Or, select a well and type 
the reaction value.
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AAdddd TTeesstt TTrraayy IInnffoorrmmaattiioonn

3. Click the Reanalyze button.

There is no requirement that all wells of a tray be used.

The tray input is a group of buttons representing each well. The buttons cycle through reaction values 
when clicked (1, 8, 6, 4, 2, 0). By default, 1 is displayed. The colors of the buttons reflect the values 
entered: 1=Green, 2=light blue, 4=magenta; 6=red; 8=dark blue.

You can enter reactions by clicking a button and typing a reaction value, or by clicking the button until it 
displays the desired reaction. When the button reaction value changes, the focus shifts to the next button.

Button navigation is from left to right (1A –1F,2A – 2F, etc.).

The image of the tray, (button order, well position, etc.) emulates the actual LAT tray that is run. So for a 
2 test tray, the top of the tray is shown first for the first sample and the bottom half of the tray is shown 
second, for the second sample. When you add a new tray, the top half is displayed first, then the bottom 
half, if applicable.

You can add information about the tray, such as expiration date, by clicking the + Info button. The 
More Test Information dialog box is displayed when you click this button, allowing you to add 
information about this tray:
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HHiissttooggrraamm ffoorr LLAATT PPRRAA//SSiinnggllee aannttiiggeenn

Using the ELISA Reader

To import analysis data directly from the Biotek ELX 800 NB ELISA reader, the computer on which you 
are running HLA Fusion must be connected to the ELISA reader. Connect and calibrate the ELISA reader 
according to product specifications. HLA Fusion can analyze only 96-well Terasaki trays. ELISA reads the 
trays, and transfers the raw data to HLA Fusion.

 From the analysis window, click the Read From ELISA button to import data from the ELISA 
reader.

Note: The Read From button is displayed only when your computer is connected to the ELISA 
reader, and you have not yet entered any manual reactions for the current test. 

LAT PRA/Single Antigen Histogram

Displays the reaction of the sample.

 Y-axis = reactivity; X-axis = well position and sample order.

 By default, the histogram is sorted from highest reaction to lowest. You can also click the Sort by 
Well Position button to sort it that way.

 Bars are colored according to reaction: 1=Green, 2= 
light blue, 4=yellow; 6=brown; 8=red.

 When you hover your cursor over a bar, a pop-up 
window displays Bead ID, Tray Position, Rxn, Raw Data, 
Threshold, Well Specificity.
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CREG Table

The CREG groups are displayed at the top of the table, with the specificities for the group displayed 
below. Specificities are highlighted in one of the following colors.

Note: If you want to hide the display of the CREG bar, click the CREG title at the top of the 
window. A dialog box displays asking if you want to hide the CREG bar. Click Yes to hide it. 
To re-display it, click again on the CREG title and click the Yes button to show it.

 Purple = positive assignments from the Epitope Analysis Results box

 Pink = Tail assignments that are masked by Epitope analysis

 Blue = Cw assignments

 Green = Bw4 and Bw6 assignments

 Click a CREG group or antigens to circle the corresponding specificities.

 Right-click an antigen to move the specificity to the Final Assignments box.

Do the following if you want to use a different CREG table:

1. Click the LAT Home Page button, 
or select Utilities > Antibody Product 
Configuration > Set Analysis 
Configuration.

2. On the LAT Home page, click the [Edit] link to 
display the Analysis Configuration 
Settings dialog box, (this dialog box is 
displayed already if you are accessing it 
through the Utilities menu).

3. Select a different table from the CREG drop-down list.

4. Click the Save button at the bottom of this screen.

Find Antigen

All entered antigens are circled in the specificity field. To enter multiple antigens, use a space to separate 
antigen entries. Clicking on the labels for Tail Analysis Results, Epitope Analysis Results, or Final 
Assignment creates circles around the specificities listed in the results area. Clicking on the “Exclude 
Antigen” label circles the excluded antigens.
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Note: If you use the Find Antigen feature while the window is displaying molecular specificities, you 
cannot see the circled antigens until you deselect the DNA check box.

1. From the analysis window, type individual antigens or CREG groups, (e.g., 1C or 2C) into the 

field next to the Find Ag, (Antigen) button.

2. Click the Find Ag button to circle the entered antigens or CREG groups.

3. Click the Find Ag button again to remove the circles from antigens in the specificity field.

View Molecular Specificities

Molecular specificities are displayed only in the specificity field of the analysis window. The CREG Table 
and screening results are displayed and saved as serological specificities.

1. In the Analysis Window, select the DNA check box to display molecular specificities.

2. Clear the check box to return the display to serological specificities.

Select Minimum Positive Threshold

You can change the minimum positive threshold using the pull-down menu.

 From the analysis window, select a new positive threshold from the Threshold drop-down list 
next to the analysis tools near the top of the window. The sample is re-analyzed according to the 
new threshold. The effects of the threshold change are displayed in the result boxes.

Exclude Antigen from Analysis

To enter multiple antigens, use a comma to separate the antigen entries. All antigens entered are 
excluded from analysis.

1. From the analysis window, click the Excl. Ag. button. The Exclude Antigen pop-up box is displayed.
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2. Type in antigens to be excluded, separated by commas and click 
OK.

The sample is re-analyzed and the excluded antigens are listed in the 
Excluded Antigens field in the Analysis Statistics box.

3. To include all these antigens again, click the Excl. Ag button 
again; click Clear to remove antigens from the field; and then 
click OK to re-analyze with these antigens included.

Include/Exclude Cw

You can choose to include or exclude Cw antigen specificities from analysis.

 Near the top of the analysis window, select the Cw check box to re-analyze with Cw specificities.

Clear the Cw check box to re-analyze without Cw specificities.

Navigating Between Class I & Class II

(PRA Class I & II Combined)

For Combined Class I and II PRA sessions, each HLA class is analyzed separately and needs to be saved 
separately for combined results to appear in the database.

Make sure that you have already created a combined Class I and Class II LAT PRA catalog file before you 
import the combined sessions).

 In the Analysis Window, click either the Run Class I or Run Class II buttons, located in the 
upper middle part of the analysis window to switch between Class I and Class II results for the 
current sample.

(After you click on the Run Class I button and the analysis is completed, the button changes to 
Run Class II, and vice versa.)
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Raw Data Table

Positive beads are displayed in Red text. Rows highlighted in yellow have normalized values over the 
minimum value. Changes made to the normalization formula and minimum normalized value, apply only 
to the raw data table and not to analysis.

1. From the analysis window, click the Raw button on the bottom right of the analysis window to 

display the raw data table.

Take one or more of the following actions:

 Click on a header at the top of any row to sort the table by that category.

 Click the Report button to create a Raw Data Table report.

 Click the Print Screen button to print what you see on the screen.

 Click the Close button to close the window and to return to analysis.

Raw Data Report

You can create a report containing raw data information for the current sample.

 Once the Raw Data Table is displayed, click the Report button at the bottom right portion of the 

Raw Data Table window to display a report of the raw data.

Exporting Session Data

You can click the Export button to export sample data into a comma-separated output file. This file can 
be imported for analysis. This feature is can be used if you have a separate workstation for ELISA and 
analysis.

Donor PRA

You can display the percentage of PRA from available donors in the system or from selected donor 
groups who match the computer-assigned antibodies for the current sample.

Note: To select a donor group(s), select Utilities > General Settings. To create a donor group, 
select Patient Info > Manage Patient, select Donor in the Patient/Donor field, and fill in 
the donor group field.

1. For Single Antigen or PRA analysis, click the DPRA button. A pop-up box displays the percentage 

of matching donor PRA and the total number of donors that were considered in the calculation. 

2. Click OK to close the box. The percentage and number of donors remains displayed next to the 

Donor PRA button.
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Calculated PRA

You can perform Calculated PRA (CPRA) analysis by clicking on the CPRA                  button, found 

to the right of the DPRA button on the lower left panel. Clicking the CPRA button will calculate PRA 

(UNOS calculator) using unacceptable antigens assigned to the patient record.

1. From within the Final Assignment box, select 

several antigens by highlighting them, then right-

click and choose “Add Unacceptable Anti-

gen.” 

2. Now, click the CPRA button. 

The percentage score will  appear next to the CPRA button as a percentage. 

The list of selected an-

tigens appears below 

to the left under the 

System Comments 

area.

Adding Comments to Samples

Comments that you or Fusion add to the Comments Field are displayed with the results in the current 
analysis session, data look up and reporting functions in HLA Fusion.

 In the analysis window, type sample comments into the Comment field below the Assignments 

area.

You may click and drag the bottom right corner to resize the Comments box. Comments are only saved 
after you click the Save button after completion of the analysis.
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Flagging a Sample for Further Testing

Marking a sample for more testing displays the More Tests check box for the sample’s results in the 
current analysis session in all analysis, data look up and reporting functions in HLA Fusion. 

 In the analysis window, check the More Tests check box, located below the Epitope Analysis 
Results section.

Previewing and Printing Reports

To view or print an LAT PRA/SA report for the current sample, click the 
Preview Report button on the Fusion toolbar.

 In the analysis window, click the Preview Report button  or
Print Report button to display a list of reports you can print or 
preview for the current sample.

Note: If you select Molecular Custom, you cannot create a new custom report at this point. The 
only custom reports available from the analysis window are those previously created 
through the Reports window.

Making Final Assignments

Final assignments can be made from either the Tail or Epitope results lists. Once a specificity has been 
moved to the Final Assignments area, it no longer displays in its initial results box.

From the analysis window, do one of the following to make assignments:

 Double-click an antigen specificity in the Tail or Epitope Analysis results box to list the 
specified antigen in the Final Assignment field.

 Click to highlight the specificity and click the Assign Single button to move it to the Final 
Assignment list.

 Click the Assign All button to the right of the Tail or Epitope list to move all the current results 
on that list to the Final Assignments area.

 Right-click on a specificity, or CREG group on the CREG Table to assign it to the Final 
Assignments area.
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Manual Assignments

Manual assignments can be entered in the field below the Final Assignments results box. Enter multiple 
manual assignments by leaving a space between each specificity.

1. From the Analysis Window, type a manual antigen specificity assignment in the field under the 

Final Assignment box.

2. Click the Assign button , just above the Manual Assignment field to add the assignment to the 
Final Assignment results box.

Assigning Negative Sample Values

You can assign a negative value to a sample even if analysis shows some positive results.

 From the analysis window, click the Assign -ve button, (located just above the Manual 
Assignment field) to assign all samples on the Final Assignment results box a negative value.

Removing Assignments

Specificities can be removed from the Final Assignments results field. You can remove more than one 
specificity by holding down the Ctrl key and clicking each specificity you want to remove.

 From the analysis window, click to highlight specificities on the Final Assignment list, (hold down 
the CTRL key to select more than one) and click the Remove button, located below the Final 
Assignments results field.
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Save Assignments

Lab Technicians and Supervisors can save analysis results for further review and approval. Saved 
samples are available for confirmation only by a lab supervisor.

 From the analysis window, click the Save >>button, (located in the bottom right corner of the 
analysis window) to save analysis results for all the specificities currently listed in the Final 
Assignments results box.

You automatically move to the next sample.

For confirmation, a Supervisor needs to access the sample for which you saved the assignments. You can 
return to the sample any time prior to confirmation. If you need to make changes, click the Reanalyze
button and then the Save button again.

Confirm Assignments

Only Lab Supervisors can confirm analysis results. When they do so, samples are marked as Confirmed. 
The Confirm button is purple when you view a confirmed sample.

 From the analysis window, click the Confirm button, located in the bottom right corner of the 
window, to confirm all analysis results.

You automatically move to the next sample to continue confirming results.

When you first return to a confirmed sample, you see that the Confirm button is now shaded purple to 
let you know it has been confirmed before.

Getting Tail Analysis Values

Tail analysis values can be displayed in the Final Assignments results field, but are not 
stored for look up or reporting.

 From the analysis window, click the button, located to the upper right of the 
Final Analysis results box, to display tail analysis values in Final Assignments 
results field.

 LAT Single Antigen samples imported after this configuration change do not 
display the tail analysis assignment area on the sample analysis window.
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Navigating Between Class I & Class II

(PRA Class I and II Combined)

For Combined Class I and II LABScreen PRA sessions, each HLA class is analyzed separately and needs 
to be saved separately for combined results to appear in the database.

Make sure that you have already created a combined Class I and Class II LABScreen PRA catalog file 
before you import the combined sessions.

 From the analysis window, click Run Class I and Run Class II buttons, located in the upper 
left part of the analysis window, to switch between Class I and Class II results for the current 
sample.
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NNaavviiggaattoorr SSeessssiioonn--lleevveell mmeennuu ooppttiioonnss

Navigator Right-Click Menu Options for LAT

Note: These options apply to all LAT sessions and samples.

There are analysis options available through the Navigator—depending on whether you are in the LAT 
session summary view, or on an analysis screen for a sample.

By right-clicking on either a session or a sample in the Navigator window, you access menu options that 
allow you to affect your LAT analysis sessions before or during analysis.

Reanalyze with New Catalog

Allows a session to be reanalyzed using a new or updated catalog.

1. Right-click on the session in the Fusion Navigator 

and select Reanalyze using New 

Settings/Catalog.

2. Rename the session giving it a new Session ID.

3. Click the drop-down arrow in the New Catalog ID
field and select a new catalog from the list.

4. Click the Analysis button.

The session on which you right-clicked is reanalyzed using a new Session ID with the catalog you just 
selected.
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Sample-Level Options

The Related Records and Side By Side Analysis options are displayed if you right-click on an active 
sample in the Navigator, (first select the sample with a left-click):

Related Records

A related record is a record that is associated with the current sample by patient or sample ID.

Note: This option is also available by using the Related Records toolbar button.

 Select this menu option to load all records related to the current sample into the Sample drop-
down list. Use the sample navigation arrows to display the analysis of each related record one by 
one.

 To go back to viewing the samples in the current sessions, click the <<Summary link at the top 
of the window.

Side By Side Analysis

Use this option to compare the current sample analysis with a sample analysis previously conducted.

Note: This option is also available by using the Side By Side Analysis toolbar button. 

 Select a sample to compare to the current one. 

The two analysis windows are then displayed together in a comparison window. 

 Each window can be resized and moved by dragging and dropping. 

Click the Side-By-Side Analysis toolbar button again to cancel the comparison display.
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FlowPRA Analysis

The FlowPRA analysis feature of the HLA Fusion program analyzes manually-entered reaction values as 
a new session. Analysis results are based on catalog specifications provided with HLA Fusion software.

There are a few things that should be completed or verified before you start a FlowPRA analysis session: 

 Make sure you have the latest catalog files and serology equivalent reference files before you 
analyze. You can download or update catalogs from the FlowPRA Home Page.

 View and modify global- as well as product-specific configuration settings before starting analysis. 
Global settings apply across all newly imported sessions.

 Save time importing catalogs and files by verifying that the default URLs and paths are pointing 
to the locations where these files are commonly stored on your system or network. These settings 
can also be modified in the General Configuration section of the HLA Fusion default Home page.

Note: Some of the above tasks require you to have Supervisor User privileges. You may have to 
verify with your supervisor that these tasks have been completed.

Starting FlowPRA Analysis

Acquiring FlowPRA Data

1. Select the FlowPRA button from the home page panel or the Fusion toolbar.

The FlowPRA Home page is displayed.
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Note: Open worksheets and probe/primer sheets to verify the accuracy of revision numbers 
(these documents do not contain a revision number in their filename).

2. Click the Batch Entry Button.

The FlowPRA Batch Entry Screen is displayed:
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Notice that Fusion has automatically assigned a session name. Optionally, you can rename the session.

Note: A session ID or batch name must be unique to the Fusion database. If the session ID already 
exists, the software prompts you to rename the session. It is also highly recommended that 
you do not use any special characters in this field since they may serve a specific purpose 
as field separators.

3. Click the drop-down arrow in the Class column (on the extreme right hand side) to select the HLA 
class: Class I, Class II, Single Class I or Single Class II.

Note: If you need to import more catalogs, click the Download link on the FlowPRA home page. The 

catalog drop-down list may not be immediately updated if you downloaded the catalogs during this 

import session. You may need to click the Home button and then click the FlowPRA button again 

to return to the import process.

4. Use the drop-down menu in the Product Catalog field (on the immediate left) to select an appropriate 
catalog file to use for analysis:

 Accept the current date or select a different test date and click Next>. The analysis 
window for this session is displayed.

Note: In the Catalog drop-down field, Fusion only lists those product catalogs which belong to the 
HLA Class you selected in the Class drop-down field.
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 Each FlowPRA session consists of as many samples as you wish to analyze with the same 
catalog information. You may also begin FlowPRA analysis on previously existing, or pre-
viously entered batches by clicking the drop-down arrow on the right side of the Existing 
Batches field near the top center of the screen (shown below).

 If the existing batch is not displayed, adjust the date range of the Batch Date and click 
the Find button to locate the missing batch(s):

Note: If you need to import more catalogs, click the [Download] link on the MicroSSP Home Page. The 
catalog drop-down list may not be immediately updated if you downloaded the catalogs during the current 
import session. You may need to click the Home button and then click the MicroSSP button again to re-
turn to the import process.

Note: Data entry is required for any fields with an asterisk(*).

5. Click anywhere in the Session field to accept the name which Fusion provides in the Session* 
field, or modify it.

6. Click the down arrow to open a calendar and select a Test Date*. 

7. Enter a name in the Sample Name* field.

FlowPRA Analysis Screens

Analyzing FlowPRA samples is similar to the LCT product. Please follow the steps outlined in the LCT 
sections. 
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LCT Analysis

The LCT analysis feature of the program analyzes manually-entered reaction values as a new session. 
Analysis results are based on catalog specifications provided with the HLA Fusion software. 

There are a few things that should be completed or verified before you start an analysis session: 

 Make sure you have the latest catalog files, as well as NMDP code, local code (if used), or serology 
equivalent reference files before you analyze. You can download or update catalogs from the LCT 
Home Page.

 View and modify global product configuration settings before starting analysis. Global settings are 
displayed and be can be modified on the LCT Home Page. Global settings apply across all newly 
imported sessions.

 Save time importing catalogs and files by verifying that the default URLs and paths are pointing 
to the locations where these files are commonly stored on your system or network. These settings 
can also be modified in the General Configuration section of the Fusion default Home page.

Note: Some of the above tasks require you to have Supervisor User privileges. You may have to 
verify with your supervisor that these tasks have been completed.
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TThhee LLCCTT HHoommee PPaaggee

Starting LCT Analysis

Acquiring LCT Data

1. Select LCT button from the home page panel or the Fusion toolbar .

The LCT Home page is displayed.

Note: If you are not using the default Fusion user interface, the data and links shown on the right 
side of the window are not displayed.

Note: Open worksheets and probe/primer sheets to verify the accuracy of revision numbers 
(these documents do not contain a revision number in their filename).

CClliicckk ttoo ooppeenn tthhee
CCaattaalloogg MMaannaaggeerr

wwiinnddooww

CClliicckk ttoo ooppeenn tthhee UUppddaattee
RReeffeerreennccee FFiillee wwiinnddooww

CClliicckk ttoo mmooddiiffyy
LLCCTT GGlloobbaall
sseettttiinnggss

CClliicckk tthheessee
lliinnkkss
ttoo ddiissppllaayy tthhee
sseelleecctteedd
ccaattaalloogg,,
wwoorrkksshheeeett,, oorr
pprroobbee//pprriimmeerr
ddooccuummeennttss..
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3. Click the Batch Entry Button.

The LCT Batch Entry Screen is displayed.

Notice that Fusion has automatically assigned a session name. Optionally, you can rename the session.

Note: A session ID must be unique to the Fusion database. If the session ID already exists, the 
software prompts you to rename the session. It is also highly recommended that you do not 
use any special characters in this field since they may serve a specific purpose as field 
separators.

5. Use the drop-down menu in the Catalog field to select a catalog file.

Note: If you need to import more catalogs, click the Download link on the LCT home page.

The catalog drop-down list may not be immediately updated if you downloaded the 
catalogs during this import session. You may need to click the Home button and then click 
the LCT button again to return to the import process.

4. Accept the current date or select a different test date and click Next>. The analysis window for 
this session is displayed.
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LCT Analysis Window

Each LCT session consists of as many samples as you wish to analyze with the same catalog information.

LCT Session Summary Screen

The Summary Table can be launched by clicking a session in the Navigation tree. It lists each sample in 
the session. This option allows you to quickly analyze a session, and save it for later review and final 
assignments.

 Double-click a sample in the Summary Table or a data point to go directly to the analysis screen 
for this sample.

 Scroll left or right to view all of the Summary Table fields.

 Click the Field Chooser button to the left of the column heading row. The Field Chooser
window is displayed. In this window, you can select or clear the check boxes next to column
headings to include or exclude those columns from the Summary Table. Selecting or clearing 
check boxes in this window instantly updates the table.

LLCCTT SSeessssiioonn SSuummmmaarryy TTaabbllee

FFiieelldd CChhoooosseerr DDoonnoorr PPRRAA FFiieellddss
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LLCCTT SSeessssiioonn SSuummmmaarryy eexxppoorrtteedd aass aa sspprreeaaddsshheeeett ffiillee

LLCCTT SSeessssiioonn SSuummmmaarryy PPrriinntt PPrreevviieeww

Note: If you do not see a particular field available through the field chooser, and you are sure it 
should be there, go to C:\HLA Fusion\temp and delete the file named X_X_X(antigen 
type)_Layout.xml.

 Click on any column header of the Summary Table to sort the table by 
that column. The arrow in the column header indicates the sorting 
order—up for ascending and down for descending. Columns can also 
be dragged-and-dropped to change their order.

 The session summary table columns and order can be modified. 
When you close the Field Chooser, a pop-up message displays to let 
you choose whether or not to save any changes you made. If you click 
Yes, your changes are saved for all future LCT session summaries on 
this same computer until further modifications are saved.

 Click the Export button to save the Summary Table on your 
computer or the network (default location is C:\OLI 

FUSION\data\report). The file is saved in Excel (*.XLS) format.

 Click Print to print out a report of the Summary Table.

 Click Preview to view a report of the Summary Table.

 In the print preview window, the page view slider on the left allows you to select different pages of 
the report.

LLCCTT SSeessssiioonn SSuummmmaarryy
FFiieelldd CChhoooosseerr
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 The Summary Table columns and order can be modified. You can save any modifications you 
make to the layout by clicking the Save Layout button . Your changes are saved for all 
future LCT session summary tables on this same computer until further changes are saved.

 If you want to exclude a sample from an analysis session, select the Exclude check box next for 
that sample. The sample is still displayed on the Reports sample list, so to prevent it from being 
included in report data, do not select that sample during report creation.

Note: Certain columns of data are considered key, and cannot be excluded for longer than the 
current display of the Summary Table. If you exclude one of these fields, its column is not 
displayed until you navigate elsewhere in the application. If you return to this Summary 
Table from a sample analysis window or the Navigator, that column is re-displayed. The 
data columns considered key is product-specific.
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Using the LCT Analysis window

For each LCT sample in the current session, you can view the test data, adjust the cut-off, and assign 
screening results. There are several tasks you can perform from the LCT analysis window:

 Review data and assign specificities

 Circle antigens in the specificity table

 View molecular specificities

 View screening results

 Add comments and mark the sample for more testing

 View a report for the current sample

LCT Analysis Window

RReeaaccttiioonn
IInnppuutt PPaannee

AAnnaallyyssiiss
ttoooollss

SSttaattss
TTaabbllee

CCoommmmeennttss AArreeaa
((ddoouubbllee--cclliicckk ttoo eexxppaanndd iitt))

CClliicckk ttoo ddiissppllaayy
%% DDoonnoorr PPRRAA

SSeelleecctt iiff mmoorree
tteessttss aarree
rreeqquuiirreedd

CClliicckk ttoo
ddiissppllaayy rreessuullttss
aass RRaaww ddaattaa

SSaavvee aanndd
CCoonnffiirrmm
bbuuttttoonnss

FFiinnaall
AAssssiiggnnmmeenntt
aarreeaa

CCRREEGG BBaarr

SSppeecciiffiicciittiieess

AAnnttiiggeenn SSeeaarrcchh bbooxx
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sseettttiinngg
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%% DDoonnoorr PPRRAA
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RReeaaccttiioonn IInnppuutt &&
AAnnaallyyssiiss ppaannee

AAdddd TTrraayy IInnffoorrmmaattiioonn ssccrreeeenn

Reaction Input and Analysis Pane

The pane in the upper left of the window displays each bead grouping of the test on a separate tab. Each 
bead is listed with specificity and reaction button.

To switch between panes, click on the tab of the selected bead group.

When clicked, the reaction for the selected bead switches between the following numbers and colors:

 1 (green)

 8 (red)

 6 (orange)

 4 (gold)

 2 (light blue)

 0 (gray)

 If you change a reaction button, the focus shifts to the next button.  You can also manually type 
in reactions instead of clicking buttons.

 This panel launches the analysis of the current sample using the latest changes in reaction.

 If the sample has not been analyzed yet, the button is labeled Analyze. If analysis already exists 
for the sample, then the button is labeled ReAnalyze. This button is only enabled when a 
Sample ID has been entered. If a sample ID has not been entered when this button is clicked, the 

sample ID field is flagged with !, and no analysis is performed.

Adding Tray Information

You can add information about the current tray, such as expiration date, by clicking the +Info button 

. The following dialog box is displayed when you click this button, allowing you to add information 
about this sample tray.
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Find Antigen 

To enter multiple antigens, use a space to separate antigen entries. All entered antigens are circled in the 
specificity field. Clicking on the labels for Tail Analysis Results, Epitope Analysis Results, or Final 
Assignment creates circles around the specificities listed in the results area. Clicking on the “Exclude 
Antigen” label circles the excluded antigens.

Note: If you use the Find Antigen feature while the window is displaying molecular specificities, 
you cannot see the circled antigens until you deselect the DNA check box.

1. From the analysis window, type antigens or CREG groups (e.g., 1C or 2C) into the field next to the 

Find Ag (Antigen) button. 

2. Click the Find Ag button to circle the entered antigens or CREG groups.

Click the Find Ag button again to remove the circles form antigens in the specificity field.

CREG Table

The CREG groups are displayed at the top of the table, with the specificities for the group displayed 
below. Specificities are highlighted in one of the following colors.

Note: If you want to hide the display of the CREG bar, click the CREG title at the top of the 
window. A dialog box displays asking if you want to hide the CREG bar. Click Yes to hide it. 
To re-display it, click again on the CREG title and click the Yes button to show it.

 Purple = positive assignments from the Epitope Analysis Results box

 Pink = Tail assignments that are masked by Epitope analysis

 Blue = Cw assignments

 Green = Bw4 and Bw6 assignments
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BBeeffoorree SSoorrtt bbyy wweellll iiss sseelleecctteedd –– iinn oorrddeerr ooff rreeaaccttiioonn..

AAfftteerr SSoorrtt bbyy wweellll iiss sseelleecctteedd –– iinn oorrddeerr ooff wweellll ppoossiittiioonn..
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tthhee CCRREEGG
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ssppeecciiffiicciittyy
aarreeaa aabboovvee..

1. Click a CREG group or antigens to circle the corresponding specificities.

2. Right-click an antigen to move the specificity to the Final Assignments box.

Do the following if you want to use a different CREG table:

1. Click the LCT home page button, or select Utilities > Antibody Product 

Configuration > Set Analysis Configuration.

2. From the Home page, click the Edit link to display the 

Analysis Configuration Settings dialog box. (This 

dialog box is displayed already if you are accessing it 

through the Utilities menu.)

3. Select a table from the CREG drop-down list.

4. Click Save.

Sort by Well Position

This button appears when the histogram is currently sorted by reaction. When clicked, it sorts the 
histogram in order of well position, and the button is labeled Refresh.

1. From the analysis window, click the Sort by Well Position button .

2. To return to sorting by reaction, click the Refresh button .
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Select Minimum Positive Threshold

You can change the minimum positive threshold using the pull-down menu.

 From the analysis window, select a new positive threshold from the Threshold drop-down list, next 
to the analysis tools near the top of the window. The sample is re-analyzed according to the new 
threshold. The effects of the threshold change is seen in the result boxes.

Exclude Antigen from Analysis

All antigens entered are excluded from analysis. To enter multiple antigens, use a comma to separate 
antigen entries. 

1. From the analysis window, click the Excl. Ag. 

button . The Exclude Antigen popup box is 

displayed.

Type in antigens to exclude and click OK. Valid characters for the Exclude Antigen text box are alpha-

betic and numeric characters, spaces, commas, backspace characters and the carriage return.

Note: To also exclude all typing antigens for the associated patient, select the Exclude Patient 
Typing check box.

The sample is re-analyzed, and the excluded antigens are listed in the Excluded Antigens field under the 
analysis statistics box.

SSeettttiinngg tthhee MMiinniimmuumm PPoossiittiivvee TThhrreesshhoolldd

EExxcclluuddee AAnnttiiggeenn sseettttiinngg
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RRaaww DDaattaa TTaabbllee

To include these antigens again, click the Excl. Ag button again, click Clear to remove antigens from the 
field, and then click OK to re-analyze with these antigens included.

Include/Exclude Cw

You can choose to include or exclude Cw antigen specificities from analysis.

1. Near the top of the analysis window, select the Cw check box to re-analyze with Cw 

specificities.

2. Clear the Cw check box to re-analyze without Cw specificities.

Raw Data Table

Positive beads are displayed in red text. Rows highlighted in yellow have normalized values over the 
minimum value entered in the Min Value box. Changes made to the normalization formula and 
minimum normalized value apply only to the raw data table and not to analysis.

1. From the analysis window, click the Raw Data button in the bottom right of the analysis window 

to display raw data table.

2. Click on a header to sort the table by that category.

3. Click in the upper right corner of the table to close the window and to return to analysis.
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LLCCTT RRaaww DDaattaa RReeppoorrtt

DDPPRRAA ppoopp--uupp mmeessssaaggee

Raw Data Report

For easier navigation, exporting and printing, you can create a report containing raw data information for 
the current sample.

1. Once the Raw Data Table is displayed, click the Report button in the bottom right portion of the 

Raw Data Table window to display a report of the raw data.

Donor PRA

You can display the percentage of PRA from available donors in the system or from selected donor 
groups who match the computer-assigned antibodies for the current sample.

Note: To select a donor group(s), select Utilities > General Settings. To create a donor group, 
select Patient Info > Manage Patient, select Donor in the Patient/Donor field, and fill in 
the donor group field.

1. For Single Antigen or PRA analysis, click the DPRA button .

A pop-up box displays the percentage of matching donor PRA and the total 

number of donors that were considered in the calculation.

2. Click OK to close the box.

The percentage and number of donors remains displayed next to the Donor PRA
button.
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SSttaannddaarrdd ccoommmmeenntt ffiieelldd

Calculated PRA

You can perform Calculated PRA (CPRA) analysis by clicking on the CPRA button, found to the right 

of the DPRA button on the lower left panel. Clicking the CPRA button will calculate PRA (UNOS calcu-

lator) using unacceptable antigens assigned to the patient record.

To perform Calculated PRA (CPRA) analysis using the unacceptable antigens for the patient,  

1. From within the Final Assignment box, select several antigens by highlighting them, then 
right-click and choose “Add Unacceptable Antigen.” 

2. Click the CPRA button. The percentage score 
will  appear next to the CPRA button.

Adding Comments to Samples

Sample comments are displayed for the sample’s results in the current analysis session in all analysis, 
data look up and reporting functions in HLA Fusion.

1. In the analysis window, type sample comments into the Comments field below the Assignments 

area.
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Comments are only saved when you click Save.

Flagging a Sample for Further Testing

Marking a sample for more testing displays the More Tests check box for the sample’s results in the 
current analysis session in all analysis, data look up and reporting functions in HLA Fusion.

 In the analysis window, check the More Tests check box 
located below the Assignments area.

Printing the Current Analysis Window

The Print Screen button prints the currently displayed analysis window.

 From the analysis window, click the Print Screen button on the toolbar to print the current 
analysis screen.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 240

PPrreevviieeww oorr PPrriinntt RReeppoorrttss

Previewing and Printing Reports

To view or print an Antibody Screening Mixed Data report for 
the current sample, use the Preview Report button on the 
toolbar.

 In the analysis window, click the Preview Report button 

or Print Report button to display a list of reports you 
can print or preview for the current sample.

Making Final Assignments

Final assignments can be made from either the Tail or Epitope results lists. Once a specificity has been 
moved to the Final Assignments area, it is no longer displayed in its initial results box. You can select 
more than one specificity in a given results field by holding down the Ctrl key and clicking multiple 
specificities.

From the analysis window, do one of the following to make assignments:

 Double-click an antigen specificity in the Tail or Epitope Analysis results box to assign the 
specified antigen to the Final Assignment field.

 Click to highlight the specificity and click the Assign Single button to move it to the Final 
Assignment field.

 Click the Assign All button to the right of the Tail or Epitope list to move all the current 
results on that list to the Final Assignments field.

 Right-click on a specificity, or CREG group on the CREG Table to assign it to the Final 
Assignments area.

Manual Assignments

Manual assignments can be entered in the field below the Final Assignments results field. Enter 
multiple manual assignments by leaving a space between each specificity.

1. From the analysis window, type a manual antigen specificity assignment in the field under the Final 

Assignment box.
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MMaannuuaall
AAssssiiggnnmmeenntt
AArreeaa

Click the Assign button , just above the Manual 
Assignment field, to add the assignment to the 
Final Assignment results field.

Assigning Negative Sample Values

You can assign a negative value to a sample even if analysis shows some positive results.

 From the analysis window, click the Assign -ve button , located just above the Manual 
Assignment field, to assign all samples on the Final Assignment results box a negative value.

Removing Assignments

Specificities can be removed from the Final Assignments results field. You can remove more than 

one specificity by holding down the Ctrl key and clicking each specificity you want to remove.

 From the analysis window, click to highlight specificities on the Final Assignment list (hold down 

the CTRL key to select more than one), and click the Remove button, located below the Final 
Assignments results box.

Saving Assignments

Lab technicians and supervisors can save analysis results for further review and approval. Saved samples 
are available for confirmation only by a lab supervisor 

 From the analysis window, click the Save button , located in the bottom right corner of the 
analysis window to save analysis results for all the specificities currently listed in the Final 
Assignments field.

Fusion automatically moves you to the next sample.

For confirmation, a supervisor needs to access the sample for which you saved the assignments. You can 
return to the sample any time prior to confirmation if you need to make changes. Click the Reanalyze

button and then the Save button again.

Confirming Assignments

Lab supervisors can confirm analysis results. When they do so, samples are marked as Confirmed. The 
Confirm button is purple when you view a confirmed sample.

 From the analysis window, click the Confirm button , located in the bottom right corner of 
the window, to confirm all analysis results that have been saved in the Final Assignments results box. 

You automatically move to the next sample to continue confirming results.

When you first return to a confirmed sample, you see that the Confirm button is now shaded purple 

to let you know it has been confirmed before.
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Navigator Right-Click Menu Options for LCT Sessions

Analysis options are available through the Navigator—whether you are in the LCT session summary view 
or on an analysis screen for a sample. By right-clicking on either a session or a sample in the Navigator 
window when either a session summary or analysis window is displayed, you access menu options that 
allow you to affect your LCT analysis sessions before or during analysis.

Reanalyze with New Catalog

Allows the session to by re-analyzed using a new or updated catalog file.

1. Rename the session.

2. Click the drop-down arrow in the New Catalog ID field, and select a new catalog from the list. 

3. Click the Analysis button. 

The session on which you right-clicked is reanalyzed with the catalog file you just selected.
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SSiiddee--bbyy--SSiiddee aannaallyyssiiss

CCuurrrreenntt
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PPrreevviioouuss
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Sample-Level Options

The Related Records and Side By Side Analysis menu options are available if you right-click on an 
active sample in the Navigator (first activate the sample with a left click):

Related Records

A related record is a record that is associated with the current sample by patient or sample ID. 

Note: This option is also available by using the Related Records toolbar button .

 Select this menu option to load all records related to the current sample into the Sample drop-down 
list. Use the sample navigation arrows to display the analysis of each related record one by one. 

 To go back to viewing the samples in the current sessions, click the <<Summary link at the top of 
the window.

Side By Side Analysis

Use this option compare the current sample analysis with one previously conducted. 

Note: This option is also available by using the Side By Side Analysis toolbar button .

1. Right-click a sample from the Navigator. A list of available samples is displayed.

2. Select a previous sample analysis from the displayed list to compare to the current one. The two 
analysis windows are then displayed in a comparison window. Each window can be resized and 
moved by dragging and dropping. Click the Side By Side Analysis toolbar button to cancel the 
comparison display.
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Reports

HLA Fusion™ provides different report formats in which to output your analysis data and results. From 
the Reports menu you can do the following:

 Create, print and export reports for analysis data for all supported products.

 Create custom reports for which you determine content type.

 Create reports for electronic submission, such as NMDP HML reports.

 Store as many as 18 reports in a My Favorites list for convenient access.

 Modify the appearance of any report, such as fonts, formatting, and background colors,
(supervisors only).

In addition, the following are a few considerations before you create reports in HLA Fusion:

 The report date is in a different font than the other report contents. This is by design to allow the 
Crystal Reports date field to be displayed in PDF format in various language and regional settings.

 Please verify the reports and the data during the installation and validation process.

 All report files are made available to you so that you can arrange and size the fields to meet your 
needs.

Note: To view reports, your computer must have some form of printer driver installed. If you do 
not have a printer driver installed, you can download a free copy of PDF Distiller from 
Adobe.com, or Microsoft Office Document Image Writer from Microsoft.com. In addition, 
you can print and export these reports from the analysis or batch summary window.

Sample IDs, Patient IDs, Well IDs, Alleles, Serology, and so forth are sorted 
alphanumerically in reports, just as they are on other HLA Fusion forms and lists.
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Using the Reports Window

The following sections describe how to create, save and print a report containing your analysis data. Here 
are the main steps you must take to create a report from this window:

1. Select a report type.

1. As needed, select criteria to refine report input, such as date range.

2. Select the sessions or samples to include in the report.

3. Select the View Report or the Export Report button

Accessing the Reports Window

Access the Reports window in one of two ways:

 On the home page, click Reports button on the Fusion Explorer.

 Or click , on the Fusion menu bar.

The Reports window is displayed, with a list of any sessions that fall within the date range (based on 

the session date range set in the Find dialog box). If no session are displayed, try modifying the 
date range.
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Select Report Type

 Select a report from the report type menu options displayed at the top of the Reports window. 
The list of sessions in the right pane of the Reports window is filtered to display only the ones 
related to the selected report type.

Refine Report Input

If needed, use the left panel of the Reports window, to further filter the sessions you want to include in 
your report. There are a number of criteria you can set:

1. Enter a Patient ID, Session or Sample ID 
fields, or browse for the information with the 
Browse button.

2. Adjust the date range. Use the drop-down 
calendars in the Session Date fields to select 
a different start and end date.

3. Enter or browse for specific sample or session 
characteristics or status (see below).

4. Once you set criteria and click the Find
button on the left panel of the Reports 
window, the session list in the right panel of 
the window filters accordingly.
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Session/Sample Selection

 In the Samples/Sessions list, click the + sign next to any session to expand the display to show its 
samples.

1. Select the check boxes next to each sample you want to include in a report. Select the check box 
next to a session ID to include all of its samples. (Deselect the check box of any sample or session 
you do not want to include in the report.)

2. If at least one sample has been selected for a session, the Include cell for that session is 
highlighted with grey. If all samples for a session are selected, there is a check box in the Include 
In cell.

3. (Optional) To view all the samples available, or to view only the samples you have selected so far, 
click the Samples tab and select or deselect the check box for Show selected samples.

4. Alternatively, you can right-click on a session or sample and apply one of the following:
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 Select All: select all sessions and samples for 
inclusion in the report.

 Deselect All: deselect all sessions and samples 
from inclusion in the report.

 Analysis Select: specify the analysis product 
report type (LABType, Micro SSP, LABScreen, 
etc.)

 Category Select: choose the report category—
molecular or antibody.

Note: To create a separate report for each selected sample, select the check box next to 1 
Sample per Report.

View, Print or Export Reports

 Once you have the report type and all the samples selected, click View Report. The report is 
displayed in a separate window, the Report Viewer.
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The Report Viewer contains various toolbar buttons to allow you to export, print and navigate through 
your report. 

The functionality of these buttons is described in the following table:

To close the Report Viewer window, click the Close button in upper right corner of the viewer.

Toolbar Button What it Does

Export Report: Exports reports in one of several available 
formats including, Crystal Reports, PDF and Microsoft Word.

Print Report: Sends the current report directly to the printer.

Toggle Group Tree: Opens a tree panel on the left side of 
the Report Viewer window which lists all the samples 
included in the current report.

Report Page Navigator: If the report has multiple pages, 
these buttons allow you to move to the first page, the next 
page, the previous page or the last page.

Find Text: Clicking this button opens a text box which allows
you to search and find text throughout the report.

Zoom: Click the down arrow on this button to choose a zoom 
setting, view an entire report page, or view by the report 
page’s width.
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Export Report

1. Click the Export Report button when you want to export a report in one of several 

standard formats. The Select Output Directory and Save Type dialog box is displayed.

1. Enter a name for the current exported report, or browse for a report file to export. 

2. Select a format from the Save as type drop-down list (Excel, Acrobat, Word, or Rich Text 
format).

3. Click OK. By default, the file is saved in C:\OLI Fusion\data\report).

Accessing Reports from the My Favorite Menu

The My Favorite menu is a convenient way for you to access and generate the reports you use most. You 
can make as many as 18 report types available from the My Favorite drop-down, including custom 
reports. Adding to or deleting from the list is easy.

Adding Reports to My Favorite

1. Make sure you have selected the report you want to add to My Favorite (verify that its name is 

displayed in the Report Options section of the Reports window).
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2. Select My Favorite > Add to My Favorite.

The current report name is added to your My Favorite menu. When you want to generate this report, 
just click on its name from the bottom portion of the My Favorite menu.

Removing Reports from My Favorite

1. Select My Favorite, and select the report you want to remove from the list of reports at the 

bottom of the menu. The My Favorite menu closes.

2. Select My Favorite > Remove from My Favorite.

The report you selected in step 1 is no longer displayed at the bottom of the My Favorite menu.
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Reports Tools

Customizing Report Appearance

Note: You must be a supervisor-level user in HLA Fusion and have Crystal Report Designer 
software installed on your computer to use this feature.

This feature allows you to format the appearance of HLA Fusion reports to meet your specific needs. For 
example, you can change fonts, size and color as well as the location of text and data fields on the report.

 HLA Fusion automatically launches the report designer if it is installed in the default directory
(C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI 
4.0\win32_x86\crw32.exe).

 Use Notepad to open the OneLambda.Fusion.Interface.exe configuration file, located in C:\Program 
Files (x86)\One Lambda\HLA Fusion 4.0. Make sure that the Crystal Reports Designer path 

name is entered on the following line of this file (see figure below): 

<add key=”ReportDesigner” value=”C:\Program Files (x86)\SAP BusinessObjects\SAP 

BusinessObjects Enterprise XI 4.0\win32_x86\crw32.exe” />
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 Please note that all the report files used in HLA Fusion are installed in the directory C:\OLI 
Fusion\rpt\IVD 4.0, and they all have the extension of .rpt. These files can be moved anywhere 
for central access, but to do so, you must update the location (path) in the 
OneLambda.Fusion.Interface.exe file. 

 When you open a report to customize it, a backup copy is automatically created with the 
timestamp as the suffix of the report name. This allows you to retrieve the original report 
format, if needed.

1. Select Reports > Tools > Customize Report. 

Use the Crystal Report Designer tools to modify the appearance of your report.

Once you have made changes to the report format, save it. Make sure you do not change the name of the 
report file. Next time you run this report in HLA Fusion, the report will have the appearance you last 
saved in Crystal Report Designer.

Creating Custom Data Export Templates

1. Select Tools > Setup Export to customize report data export by setting up templates that 

determine the type of report data (session, sample, patient, results, etc.) is exported when you 

select that template.

The Export Data Setup dialog box is displayed, allowing you to select 
the name of the export template, the fields to be included, and the field 
order you want for the template. Select check boxes on the left to select 
category and fields. On the right side of the dialog box, drag and drop 
the fields, or hold CTRL and press the Up/Down arrow keys to change 
the order.
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2. When you are done, click the Save button.

The new template is added to available export templates from the Tools > Export Data menu.

3. When you are ready to export data, first select all the sessions you want to include from the 
available list. Then, select Tools > Export Data, and select one of the templates. The Export 
Data dialog box is displayed.

4. Select the format for the exported data—XML, CSV or Text. The exported data file is saved by 
default in C:\OLI Fusion\data\export.

Creating Custom Reports

Certain report types allow you to customize the types of fields to include.

Note: For Molecular Custom or Antibody Custom reports, you must make sure the Free 3 of 9 
Extended font is installed on your computer—otherwise, the barcode is not recognized. If 
needed, you can download this font for free at http://www.free-barcode-font.com/.

1. To create a custom report, select a report type containing the word “Custom” in its name, (e.g., 

Molecular Custom, under the Generic Typing report type menu).

2. Click the Setup button in the Report Option section of the window.
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The Custom Report Setup window is displayed, allowing you to customize report content by 
selecting from various categories and fields.

Custom Molecular and Antibody Report Setup

1. Enter a name or select one from the drop-down list.

2. Select the check box next to each field you want to include in this report.

Note: To include all related fields, you can click the Check All button to select all the fields in 
the category.

3. Click the Save button to save the custom report setup you have just selected.
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Sample Summary

The Sample Summary feature lists multiple samples and their typing results. 

 Select samples using the Reports window.

 Click the Sample Summary button. The Sample Summary window is displayed; it contains 
two tabs— Molecular and Antibody.

Molecular Typing Sample Summary

Selected antigen typing records are displayed on the Molecular tab of the Sample Summary screen. You 
can view typing information in a condensed format, as well as display more details for any sample.

1. Select samples using the Reports window.

2. Click the Sample Summary button. The default tab is 
Molecular.

3. Select an option from the Select Type of Data to Display drop-down list.
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The window displayed depends on the option selected.

 Click the Export button to export the displayed data as an Excel file.

 Click the DNA button to export molecular specificities as an Excel file.

4. Click the Close button in the upper right corner of the window to close and return to the 
Reports window.

Antibody Screening Sample Summary

Any selected antibody screening records are displayed on the Antibody tab of the Sample Summary 
screen. You can view screening information in a condensed format, as well as display more details for 
any sample.

1. Select samples using the Reports window.

2. Click the Sample Summary button.

3. Click the Antibody tab.

 Click the Export button to export the displayed data as an Excel file.

 Click the DNA button to export molecular specificities as an Excel file.

4. Click the Close button in the upper-right of the window to close and return to the Reports
window.
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View Records

The View Records feature presents typing results and analysis details for each sample selected. Sample 
information is shown for one sample at a time. From the View Records menu, you can view screening and 
typing records individually.

1. Select data records using the Reports window.

2. Click the View Records button.

3. Use the arrow buttons to navigate through samples.

4. Click the View Analysis button to open the analysis window for the current sample.

The analysis window can be resized.
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5. Click the Close button to close the window and return to the Reports window.

Patient Info

You can view patient records associated with selected samples by clicking on the Patient Info tab. 
Patient information can also be viewed by patient ID using the Patient look up function of the Patient 
Management menu. From the Patient Info menu, you can view Patient/Donor records.

To view patient information, you must select a sample(s). You can view, but not edit the displayed 
information.

1. Select sessions or samples from the Reports window that have an associated Patient/Donor ID.

2. Click the Patient Info button .

The Patient/Donor information screen is displayed.
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3. Click the Test Info tab to see that information for the current patient/donor. If more than one 
information card is displayed, use the arrow buttons to navigate through the patient records.

4. Click the Close button in the upper right corner to close and return to the Reports window.

Audit Trail Report

You can view and print a report of user activity for the current database. This data is only available if you 
have done the following:

 Set up and connected to an audit trail database (see the HLA Fusion Database Utility User 
Manual).

 Enabled Audit Logging from the HLA Fusion default home page.

Once you have completed the above, and wish to view audit log data, take the following steps:
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Access the Reports window in one of two ways:

 From the home page, click Create Reports.

 From the Fusion main menu options, select Reports.

Select Miscellaneous > Audit Trail Log. The Audit Trail Log dialog box displays.

 Use the drop-down arrow to select the User for whom you want to see database actions.

 Select the date range and options you want the report to include.

Click List to see the report. If you want to export the audit trail report to Excel, click Export .
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Report Types

There are several report types available. Although most report types are listed in this section, please note 
that because new reports are sometimes added between updates to this user manual, you may see more 
reports listed in the software.

Patient - (all patients in the Fusion database)

 Patient Summary - (summary of typing and antibody testing results associated with a patient)

 Patient Typing for Batch - (typing summary report over different loci for a set of samples, 
based on a selected session)

 Patient Custom - (you select the type of patient data to include for the selected samples)

Generic Typing - (typing data from analyzed LABType and MicroSSP samples)

 Molecular Custom - (you select the type of molecular data to include for a set of samples)

 Custom Typing Results by Sample - (you select the type of molecular data to include for se-
lected samples)

 Consensys Custom Report

 Allele Summary - (typing report of possible allele pairs and assigned allele code results for a 
set of samples)

 Allele Code - (typing report of possible allele codes and assigned allele code results for a set of 
samples)

 Molecular Typing Summary - (typing report of the possible allele code, assigned allele code, 
assigned allele pairs, assigned serology, and other assignments for a set of samples)

 Combined Sample – Generic Typing

LABType - (data from analyzed LABType samples)

 Panel Summary - (report of the final NMDP coded assignment and the positive probes for a 
set of sample in a session)

 QC Overview - (summary of  samples with low bead count, low positive control, pre-analysis 
global cutoff changes, as well as sample specific changes for a session of samples)

 Combined Panel Summary (NMDP) - (spreadsheet of final NMDP code assignments for sin-
gle or multiple sessions)

 Combined Sample - LABType
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MicroSSP - (data from analyzed Micro SSP samples)

 SSP Report - (detailed typing report for Micro SSP™ tests that may be customized)

 Custom SSP Report

Generic Antibody - (antibody data from analyzed LABScreen, FlowPRA, LAT or LCT samples)

 Antibody Custom - (User may customize a report for antibody data for a set of samples)

 Antibody Screening/ID - (antibody data report that is fixed in format)

 Antibody Screening Results - (summary table for a selected set of samples which includes the 
overall final results made, %PRA, other assignments, and comments)

LABScreen - (data from analyzed LABScreen samples)

 LSM Detail (detailed test information for antibody mixed analysis records)

 LSM Summary (overall test results for antibody mixed analysis records) 

 LSM Overview (overall tests results for antibody mixed analysis records including total num-
ber of positive, negative and undetermined results.  User may select the highest or lowest bead 
ratio found for each sample)

 Product Comparison

LAT - (data from analyzed LAT samples)

 LAT Custom

 LAT-Mixed Raw Data (results of multiple samples on an LAT-Mixed analysis tray, including a 
tray layout of the original raw data input and test results)

 LAT-Mixed (results of a single sample on an LAT-Mixed analysis tray, including a tray layout 
of the original raw data input and test results)

 LAT-Specificity Raw Data (Raw data results for LAT specificity or HD trays, including a tray 
layout of the original raw data input and test results)

 LAT Specificity (complete specificity report for LAT specificity and HD trays, including over-
all, tail, epitope, manual tail assignments, and test details)

LCT - (data from analyzed LCT samples)

 LCT Custom

 LCT Specificity (test details of a single sample on an LCT analysis tray)
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FlowPRA - (data from analyzed FlowPRA samples)

 Flow PRA Custom

 Flow PRA Specificity (test details of a single sample on a FlowPRA® analysis tray)

Specialty - (reports created for specialized purpose)

 Export Date

 User Reports (the following is a partial list of such reports) 

 Antibody Reaction - (summary table of computer specificity assignments based on reaction 
scores)

 SCORE - (export report used by SCORE software)

 LABType - (export report covering LABType results)

 LABScreen - (export report covering LABScreen results)

 Reaction Assignment Report - (export report including sample ID and reaction string)

 NMDP Code Report

The following specialty reports are customized for specific users:

 LBSW

 HML V0.2

 HML V0.3 

 LC 

 NBS 

 Thai Export 

 UMC-Utrecht Report 

 BML

 ABMDR

 CMDP

Statistical - (statistical or aggregate data for trending, measurement, monitoring, etc.)

 Allele Group Frequency (displays the frequency of allele groups based on the first two digits of 
an allele assignment for selected sessions or the database)
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 Allele Group Frequency Extended - (displays the frequency of allele groups based on NMDP 
code results or allelic level assignment for selected sessions or the database)

 Cutoff Adjustment Summary (summary of all cutoff changes made for selected sessions or 
based on a specific catalog file)

Miscellaneous - (reports that do not fall into one of the above categories)

 Database Information (describes the usage of the current database)

 Batch Data File Summary (a log of the status of all the sessions run in the system)

 Serological Equivalent (list of alleles and their serological equivalent definitions)

 NMDP Code (list of NMDP codes and their allele definition)

 Typing Query (database search report that lists the samples found for a selected allele)

 Audit Trail Log (a log with all specified activity for a selected users in the current Fusion da-
tabase)

My Favorite - (any of the above reports saved in a favorites list)

 Reports listed depend on what you have stored under this menu.
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Data Management

When you select the Data menu item, a window is displayed that allows you to manage session files, as 
well as create log files of session data. From this menu, you can delete, archive, activate, and move 
sessions to a different database. You can also map the alleles in a session to the new nomenclature 
format.
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Session Management

To manage your data at the session level, use the Data option from the HLA Fusion main menu. When 
you select the Data main menu, the Manage Data window is displayed.

Manage Session Data Window

 When you click Translate Alleles
, all final allele pairs and code for 

the selected sessions are converted to the 
new nomenclature format and stored in the 
database.

 When you click Move Sessions , 
you can select another Fusion database to 
which the selected sessions are moved.

HLA Fusion allows you the capability to 
create log files of your selected analysis 
sessions, which you can then print or 
archive.

1. Provide all necessary session input information by using the drop-down menus and search 
buttons on the left side of the Data window.
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Once a session is selected, its information is displayed on the right side of the window, the Session Info
pane, where you can add information.

2. Once you have all information you want to include in the log, click Save.

Once you have displayed the session log you want, use the Print Session Log, Archive, Active and 
Delete buttons at the bottom of the window to manage the log.

Note: Samples can also be deleted individually, without the need to delete an entire session. 
The only exception are LABType or Micro SSP samples that have been combined.

HLA Fusion allows you to move patient records.

1. Select Patient ID as the Sorted Select Level. The Select Patient window is displayed.

2. Select one or more patients.

The following window displays:

3. Select browse (...) in the Target Database field to select the database to which you want to 
move the selected patient records.

4. Once you have selected the target database, click Send to Target Database.
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IImmppoorrtt SSaammppllee LLiisstt SSccrreeeenn

Sample Management

In HLA Fusion, sample lists are an easy way to input a large list of sample IDs and other sample 
information into the database for use in analysis sessions. Sample lists may be in .xls, CSV or .txt file 
format. From the Sample List Import menu, you can import sample lists or edit sample lists prior to 
importation.

Note: Please verify all data you import as HLA Fusion performs minimal data validation upon 
import.

Importing Sample Lists

Sample lists are an easy way to input an extended list of sample ID’s and other sample information into 
the database for use in analysis sessions.

1. From the Main Menu, select Sample > Import Sample List. 

The Import Sample List window displays.

2. Click the Search Sample List button; browse for the sample list to be imported; and click 
Open.
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3. Type a name in the List ID field, and, if necessary, select a Lab code or Contact ID from the 
drop-down list.

4. Confirm sample information, and edit if needed.

5. Click to clear the check boxes of any samples you do not want to import.

6. Click Import List to import the selected sample lists.

7. Click Close to return to the Main Menu.

Information Formats for Sample Lists

The information inside a sample list you import in to HLA Fusion must be in one of the following 
formats.

New packing list format

This file gives the fields (in this order):

ShipmentLoc(1 – 13),SampleIDName(0198-0398-0),SampleType(AB, DR or AB/DR), 
TurnaroundTime(14, 21 or 14AB/21DR),DCN (3 digit).

Example line:

      1 - 13,0198-0398-0,AB/DR,14AB/21DR,074

Pack list: Old Standard ‘X’ samples

This file gives the fields (in this order): 

ShipmentLoc,SampleIDName,SampleType (1, 2, 3..., and an 'X' for AB/DR samples),DCN

Example line:

             1 - 12,0287-7867-8,X,074

Old packing list format, '11' for AB/DR samples

This file lists (in this order):

ShipmentLoc, SampleIDName, SampleType (1, 2, 3..., and an '11' for AB/DR samples), 
DCN

Example line:

             1 - 15,0287-0779-2,11,074
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Comma-Delimited Format

Each field is separated by commas. The use of quotes around a field is optional, and is required only if the 
contents of the field use a comma, which could confuse field separation. This file lists (in this order): 

ShipmentLoc, SampleIDName, SampleType (AB, DR or AB/DR), TurnaroundTime (14, 21 or 
14AB/21DR), DCN

Example line:

"1","12","0287-7867-8","AB/DR","14AB/21DR","074"

Tab-Delimited Format

Each field is separated by a tab. This file lists (in this order): 

ShipmentLoc, SampleIDName, SampleType (AB, DR or AB/DR), TurnaroundTime (14, 21 or 
14AB/21DR), DCN

Example line:

1 12 0287-7867-8     AB/DR   14AB/21DR       074

SDF Format

Each field is separated by commas. This file lists (in this order):

BoxSlot, DonarID, SampleType (AB, DR or AB/DR), TurnaroundTime (14, 21 or 14AB/21DR), 
DonarCenter

Example line:

     1120287-7867-8AB,DR14,21074

Local/Sample/Patient ID Only

This file is a Microsoft Excel file. This file lists (in this order):

Row 1:  Column Title “Local” and “Sample” and “Patient”
Column A:  LocalID
Column B:  SampleIDName (required)
Column C:  PatientIDName
Column D:  Date

Example:
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MMaannaaggee SSaammppllee ssccrreeeenn

Viewing and Editing Sample Information

Sample information can be edited, but associated patient IDs cannot—only new patient IDs can be added.

1. From the Main Menu, select Sample > Manage Sample Info.

2. Use the filters to find samples, and click View Sample.

Note: Wildcards can be used in the Sample ID field to widen the results.

3. Edit sample information.

Note: You can rename a sample by modifying the name in the Sample ID field. Sample IDs are 
listed alphanumerically, with all IDs beginning with numbers listed first.

4. Click Save to save. Or, click Delete to delete the sample.

5. Click Close to return to the Main Menu.

Note: You are not allowed to delete a sample that is part of a session that has already been 
analyzed.
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MMaannaaggee TTeesstt LLiisstt SSccrreeeenn

Test Lists

A Test List is a list of Sample IDs that can be used repeatedly to automatically write the sample IDs into a 
session analysis that can be read by Luminex®. It is a useful tool when you have a group of samples to be 
run on multiple tests.

From the Test List menu you can:

 Create new Test Lists

 View and edit existing Test Lists

 Delete Test Lists

 Export Test Lists to a .txt file

Creating New Test Lists

Test Lists must be created in the order in which the samples are to be analyzed.

1. From the Main Menu, select Samples > Manage Test List.

2. Type in a name for the new test list, and click Continue>>.

3. Search for samples to add to the test list using the search fields, and click Apply to view search
results.
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4. Highlight samples, and click Add>> to add them to the test list.

5. Click Save to save the new test list.

6. Click Close to return to the Main Menu.

Viewing and Editing Existing Test Lists

Test Lists can be viewed or edited at any time.

1. From the Main Menu, select Manage Samples > Manage Test List.

2. Use the drop-down list to select a test list, and click Continue>>.

3. Click Delete List to permanently delete the selected test list.

4. Click Close to return to the Main Menu.

Deleting Existing Test Lists

Deleting a test list removes the list from the database, but the sample IDs are not removed or changed in 
the database.

1. From the Main Menu, select Manage Samples > Manage Test List.

2. Use the pull-down menu to select a test list, and click Continue>>.

3. Add, remove or move samples as desired.

4. Click Save to save the new test list.

5. Click Close to return to the Main Menu.

Exporting Test Lists

Test lists can be exported for use outside of HLA Fusion only as a .txt files.

1. From the Main Menu, select Manage Samples > Manage Test List.

2. Use the pull-down menu to select a test list, and click Continue>>.

3. Click Export to export test list details to a .txt file.

4. If prompted to save the test list before export, click Yes to save and continue.

5. Select a location to save the test list and enter a file name for it.
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6. Click Save.

7. When prompted to create a Luminex Patient List input, click No.

8. Click Close to close and return to the Main Menu.
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Luminex Lists

HLA Fusion can create a Luminex List from a new or existing test list. You can use this list to quickly add 
information, such as sample ID, before you create a Luminex CSV output file. From the Create/Edit 
Test List window you can create a Luminex list.

Creating Luminex Lists

Luminex List files can be edited after they are exported, but changes are not reflected in the test list from 
which they were created.

1. From the Main Menu, select Samples > Manage Test List.

2. Use the pull-down menu to select a test list, and click Continue>>.

3. Click Export to export.

4. Select a location to save the test list to and enter a file name, then click Save.

5. When prompted to create Luminex List input, click Yes.

6. Click OK on the confirmation message to return to the Test List window.

7. Click Close to return to the Main Menu.

Create Sample Worklists

Sample Work list functionality 
in HLA Fusion software gives 
you the flexibility to assign 
various tests to selected 
samples. This information is 
used in designing plates for 
Luminex processing.
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1. Select Sample > Create Sample Work list from the HLA Fusion main menu.

Do one of the following to search for samples:

a. Click the Search by sample tab, use the search criteria to specify the samples that you 
would like to assign tests to, and click Search.

b. Click the Search by the test list tab and use the search criteria to specify the test lists that 
you would like to assign tests to, and click Search.

2. Select one sample, or select multiple samples (by holding and dragging the mouse). The selected 
samples are highlighted.

3. Now assign one or more tests by selecting the check boxes for the tests you want to run on the 
samples (listed under LABScreen/LABType/C1q Tests).

4. Once you are done assigning tests to all the selected samples, click Save to save the work list.

5. Click close at any time to exit the sample worklist window.

Create Plate Design

Plate Designer functionality in HLA Fusion software gives you the flexibility to organize and plan your 
samples in a plate format that is ready for processing through the Luminex system. You must first create 
a sample work list.

1. Select Sample > Create Plate Design from the main HLA Fusion menu.

2. Enter a name for a new plate, or select an existing plate name from the Plate Name drop-down 
list to edit a plate.

3. Select LABScreen, LABType or C1q from the Assay type drop-down list.

4. Do one of the following to search for samples:

 Click the Search by sample tab and use the search criteria to specify the samples that you 

would like to assign to the plate wells, and click Search .

 Click the Search by test list tab and use the search criteria to specify the test lists that you 

would like to assign to the plate wells, and click Search .
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 Click the External File tab and use the file import window to load external files containing 
samples in predefined file formats. Assign or reassign these tests to the samples in the plate.

The Luminex patient list and sample lists in .CSV format (Swisslab file format) are examples of 
predefined external file formats.

Please see the example figures below:
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5. Choose the fill direction for the plate design. You can select vertical or horizontal direction. 

6. Select one sample or several (by holding and dragging the mouse), and use the right arrow button 
> to assign these selected samples to a well in the plate. In the case of LABScreen assay the 
Secondary antibody IgG shall be assigned to each well of the plate design by default. Repeat this 
procedure until you have completed your plate design. To remove a sample from the plate, select 
the well or hold ctrl and click to select multiple wells that contain samples, then click X.

7. Click Report button if you want to view and print a 
report of your plate design information including
Well Position, Sample name, Patient ID and Test 
name. You can choose from two types of report
formats: List View, Layout View.
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8. Click on the Plate detail tab to view the plate design detail. You can also view the test 
assignment information and secondary antibody information.

9. Click on the secondary antibody tab (rightmost tab within Plate Designer) to change the 
secondary antibody only in the case of the  LABScreen assay type selection:

10. Click Save to save your plate design.
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11. Click Export to … (version of Luminex) to export a plate design so that it can be opened and 
used from the selected Luminex software. 

a. Click the Change Selection button (above) to select the Luminex software and target 
database. Select the available luminex version where you want to export the plate design. 
Select the database and save the changes by clicking on Save.

b. Click the Batch naming… button (left corner above) to configure automatic batch-naming.
A new data entry screen will appear (shown below). Enter the session name and choose the 
date format, seperator, and batch naming format. Click on Save then close:
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You can see the batch name information in the batch name column. Click on Refresh to 
update the template list from the luminex database.  You may select the template from the 
Template column, and edit a batch name in the Batch name column.

12. From the Plate Designer screen, click on Delete Plate to delete the plate design.

13. From the Plate Designer screen, Click on Close to close the plate designer without saving the 
plate.
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IImmppoorrtt PPaattiieenntt WWiinnddooww

Patient Information

HLA Fusion™ can store patient information and associate sample IDs with patients and donors. You can 
store all typing and screening information in one location for each patient.

Note: Please verify all data you import. HLA Fusion performs minimal data validation during 
import operations.

Importing Patient/Donor Lists

After creating a Patient/Donor List, you can import the information into HLA Fusion.

1. From the Main Menu, select Patient Info > Import Patient List. 

The Patient Import window displays:

2. Select the check box in the Import column for each patient you want to import.

3. Click the Import button to import checked patients.
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4. Click Close to return to the main menu.

Note: The HLA Fusion system checks the patient/donor lists you attempt to import to verify that 
all characters contained in the data are supported by Fusion. If your list contains 
unsupported characters, a warning message is displayed and the list is not imported.

Newly imported patient records display alleles in the new nomenclature format. Existing 
patient records display alleles with the existing allele format.

Managing Patient/Donor Records

The Patient/Donor Management menu allows you to manage one record at a time.

From the Patient/Donor Management menu you can:

 Add new patient/donor records

 Search existing patient/donor records

 Edit patient/donor records

 Associate patient/donor IDs with sample IDs

 Associate patient and donor records

 Assign a donor to the Donor PRA

 Print, export and archive patient records

Adding New Patient/Donor Records

You can add patient information using the Patient/Donor Information menu. This is the best option for 
adding a small number of patient records.
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Steps to Add New Patient/Donor Records:

1. From the Main Menu, select Patient Info > Manage Patient.

2. Enter an ID in the Patient/Donor field. The ID can be alphanumeric (contain letters and/or 
number),or click Search and select a patient/donor from the list.

3. Enter patient/donor information. Fields with an asterisk (*) are required.

4. Click Add New to save the data and add the patient/donor information to the Fusion database.

5. Click Close to close and return to the main menu.

Lookup Patient/Donor Records

This option allows you to browse through records or search for specific ones.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Enter a patient/donor ID and click Retrieve to display patient information. Or, click Search to 
browse patient records and lookup by name, patient ID, whether it is active or archived, etc. 



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 287

3. Highlight a patient record and click OK to display.

Editing Patient/Donor Records

Note: You must be a Supervisor in order to edit a patient/donor record.

All patient/donor information, (except patient/donor ID) can be edited.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Select a patient/donor record.

3. Select the check box next to Edit Mode. There is the same, Edit Mode check box on both tabbed 
forms.

4. Edit patient/donor information on one or both tabbed forms. Fields marked with an asterisk (*) 
are required.

5. Click Save to save your changes.

6. Click Close to return to the Main Menu.
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Associating a Patient/Donor ID with Sample IDs

A Sample ID cannot be associated with more than one patient or donor record, but a patient or donor 
record can have more than one sample ID associated with it.

From the Main Menu, select Patient Info > Manage Patient.

1. Select the HLA Tests Tab.

2. Click the Associate Sample IDs button.

3. In the Patient/Donor Sample Association window, highlight a sample ID and click> to add 
it to the Patient/Donor Sample List. (Click < to remove a highlighted sample ID from the
list.)

4. Click Save to save the data.

5. Click OK to return to the patient record.

6. Click Close to return to the main menu.

Translating Associated Patient/Donor Results to New Allele Code 

Patient or Donor results can be translated to update the allele code names to the new NMDP allele code 
format.
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The new format will affect allele code and allele pairs assigned to the selected patient/donor, and will be 
stored in the Fusion database in the new format.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Select a patient/donor record.

3. Click Translate Alleles.

4. Click Save to save data.

5. Click Close to return to the Main Menu.

Associating Patient and Donor Records

A Patient ID can be associated with more than one donor record, and a donor ID can have more than one 
patient record associated with it.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Select a patient/donor record.

3. Click the Test Info tab.

4. Click the Associate Donor IDs button.

5. In the Patient/Donor Sample Association window, highlight a Donor ID and click>to add 
it to the Patient/Donor Sample List. (Click < to remove a highlighted Donor ID from the 
list.)

6. Click Save to save data.

7. Click OK to return to patient record.

8. Click Close to return to the Main Menu.

Associating a Donor with Donor PRA Results

A Donor ID can be included in the calculation for Donor PRA percentage for the antigen products.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Select a donor, or create a new one.

3. Make sure the Patient/Donor filed is set to Donor.
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4. Select the Include in Donor PRA check box:

Printing Patient/Donor Records

HLA Fusion prints both Record Management tabs regardless of which tab is currently being viewed.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Select a patient/donor record.

3. Click Print to print.

4. Click Close to return to the Main Menu.

Exporting Patient/Donor Records

Patient/donor records can be exported individually to a CSV file. The file has the same format as a 
Patient List.

1. From the Main Menu, select Patient Info > Manage Patient.
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2. Select a patient/donor record.

3. Click Export to export.

4. Select a location to save the CSV file to and enter a file name. 

5. Click Save.

6. Click Close to return to the Main Menu.

Archiving Patient/Donor Records

Archived patient/donor records are not available for reporting or associating. You can still view archived 
records and reactivate them by clearing the archive check box.

1. From the Main Menu, select Patient Info> Manage Patient.

2. Click the General Info tab.

3. Select a patient/donor record.

4. From the Patient/Donor List window, select Archive from the drop-down Active/Archive
list.

5. Click Save to save.

6. Click Close to return to the Main Menu.

Deleting Patient/Donor Records

Patient/donor records can be deleted through the Manage Patient menu option.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Click the General Info tab.

3. Select a patient/donor record.

4. Click Delete to delete the patient/donor record from the Fusion database.

5. Click Save.
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Creating Patient/Donor Lists

The following is an example of a patient list that can be created and the guidelines for doing so. The 
patient list must be formatted for import via a program like Excel or Notepad and saved as a Windows 
compatible CSV file.

The first field/section must contain the names of the patient list fields, each separated by commas.

Note: Creating a new patient list can be made easier by first exporting an existing list into CSV 
format, and using the fields in that to build your new list.

Patient List Field Names and Format

PatientIDName,CategoryGrp,FamilyID,FirstName,MiddleName,LastName,Ssn,Dob,Gender,Ethni
city,Address,City,State,Region,Country,ZipCode,Email,Phone,WkPhone,Cellular,Fax,Emplo
yer,SpouseName,SpouseBloodType,EmergencyContact,EmrgncyTel,DCN,HospitalName,Division,
BloodType,Disease,RhBloodType,PatientDonorFlg,Associated SampleIDs,Associated
DonorIDs,HLA1_A,HLA2_A,HLA1_B,HLA2_B,HLA1_BW,HLA2_BW,HLA1_C,HLA2_C,HLA1_DRB1,HLA2_DRB
1,HLA1_DRB3,HLA2_DRB3,HLA1_DRB4,HLA2_DRB4,HLA1_DRB5,HLA2_DRB5,HLA1_DQB1,HLA2_DQB1,HLA
1_DQA1,HLA2_DQA1,HLA1_DPB1,HLA2_DPB1,HLA3,HLA1_DRB4,HLA2_DRB4,HLA1_DRB5,HLA2_DRB5,HLA
1_DQB1,HLA2_DQB1,HLA1_DQA1,HLA2_DQA1,HLA1_DPB1,HLA2_DPB1,HLA1_DPA1,HLA2_DPA1,HLA1_MIC
A,HLA2_MICA,HLA1_MICB,HLA2_MICB,HLA_KIR,ClassI_AbSpec,ClassII_AbSpec,MIC_AbSpec,Unacc
eptableAntigens,AcceptableAntigens,Notes,SHLA1_A,SHLA2_A,SHLA1_B,SHLA2_B,SHLA1_Cw,SHL
A2_Cw,SHLA1_DR,SHLA2_DR,SHLA1_DR345,SHLA2_DR345,SHLA1_DQ,SHLA2_DQ,SHLA1_DP,SHLA2_DP,D
onorType,IncludeInDonorPRA

Subsequent lines must list the actual patient information, alphanumerically, (can be letters and/or 
numbers) separated by commas. If there is no information for the patient in a particular field, that field 
still requires a comma as a placeholder.

Note: For all manual serology entries, the locus must precede the value. For example, for an A 
locus of value 23, you must enter A23.
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Calculated PRA

You can calculate the PRA (using the UNOS calculator method) within the Patient Information
screen.

1. From the Main Menu, select Patient Info > Manage Patient.

2. Click the General Info tab. The patient/donor information screen appears.

3. Select a patient/donor record, then click the HLA Tests tab.

4. Observe the previously assigned Unacceptable Antigens list near the bottom left of the screen. If 
you have not already conducted analysis previously and assigned Unacceptable Antigens to this 
patient, you will have to enter values manually here.

5. Click the CPRA button near the middle right hand side of the screen. The Unacceptable Antigens 
list is now used to calculate CPRA percentage score, which is displayed next to the CPRA button:
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If the “Show UNOS Web Calculator” checkbox is marked, the CPRA Web Calculator result window ap-

pears, hosted by an external website:

The blue refresh button updates the score to account for recent changes without requiring re-

entry of data into the calculator.
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PPaattiieenntt AAnnttiibbooddyy TTrraacckkiinngg wwiinnddooww

Patient Antibody Tracking

You can track antibody strength for each patient over a period of time. The information tracked is taken 
from the typing data stored in their Patient/Donor Info card and the antibody data in their analysis 
samples (LABScreen Single Antigen and LABScreen Singles) for the specified date range. Take the 
following steps to display graphs and data that track a patient’s antibody data.

Make sure you have patient and donor information entered into HLA Fusion. If not, you can import it 
from a patient list and/or manually enter the data on the Test Info tab of the Patient/Donor Info card. 
Patient and donor records must be associated.

11. Select Patient Info >Ab Tracking.

The Patient Antibody Tracking window is displayed.

2. Click the drop down arrow next to the Patient ID field to select from a list of patients stored in 
your Fusion database. Or click Search and search by Patient ID, First or Last name, etc. 

3. The Molecular and Serological Typing fields are automatically filled with available data for the 
specified patient.

4. Select the start and end date range from which you want to view sample antigen data for this 
patient (click the drop down arrows in the date fields to display a calendar).

CClliicckkiinngg tthhee SSaavvee bbuuttttoonn hheerree ssaavveess aannyy
ssaammpplleess lliisstteedd iinn tthhiiss aarreeaa ffoorr ffuuttuurree aannaallyyssiiss

aass ssaammpplleess wwiitthhiinn tthhee cchhoosseenn ddaattee rraannggee..
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5. You can select Secondary Ab or enter one of your own. This is a way to filter samples and it
means that samples you want to bring up must have this secondary Ab. Otherwise, they will not 
be available when Find is clicked.

 (Optional) You can display the percentage of PRA from available donors in the system or 
from selected donor groups who match the computer-assigned antibodies for the current 
sample.

6. Click the Donor PRA button to bring up the following dialog box from which you can select 
donor groups or All Donors.

The Donor PRA calculation is displayed next to the Donor PRA button.

7. Click the Find button to display a list of samples for this patient that are within the specified 
date range.
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Note: To add final assignments to a sample, double-click in the Final Assignment column for the 
sample to display the analysis window and add the assignment. Also, only samples with a 
date can be included in this tracking. If the Sample Date column is empty for a sample, 
click on the empty Sample Date cell and use the pull-down date-finder to add a date.
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IInncclluuddee AAnnttiiggeenn LLiisstt

8. Select the check box in the Include column for the sample(s) you want to include in the Ab 
tracking graphs and data. The graphs are displayed. (To display a specific type of graph, click on 
the associated tab). Select the check box for the antigen(s) you want to include in the tracking.

9. Select the formula to use for the graphs by clicking the drop down arrow in the Formula field,
(Default versus Raw). The formula can also be changed after the graphs are displayed if you 
want to compare the tracking with different formulas.



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 300
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You can double-click on a graph to expand it, and there are right-click options available from each 

graph (see graphic above). You can also use the expand/contract buttons in the upper right corners 
to expand the graphs.

 (Optional) You can add donor data, if desired, by using the drop-down arrow next to the Donor 
ID field to select from a list of donors associated with the selected patient. You can also create a 
new donor on the fly by typing a unique name into the Donor ID field and filling in the molecular 
and sero typing.

 (Optional) Enter a numeric value in the User-defined cutoff field. If you want to track the 
antibody signal strength with or without the cutoff applied, select or deselect the check box next 
to User-defined cutoff.

 (Optional) Select the check box next to Track DSA to track donor specific antigens. If this is 
selected and there are donor specific antigens that are not tested with OLI product kits, these are 
listed.

 (Optional) Select the DQA/DPA check box to include these in Class II tracking.

 (Optional) Manually enter the donor typing in the Sero Typing field.

10. Click the Data Table button to display a raw data table CSV file with the patient antigen signal 
over a period of time. The table can be printed or exported.
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Profile Management

HLA Fusion™ tracks all changes to analysis data made by users and allows added data security with a 

two level analysis result confirmation (Save and Confirm). HLA Fusion also stores general laboratory 

information to be used on reports including multiple contract lab codes.

User Management

From the Profile main menu you can:

 Add new users

 Edit existing user profiles

 Change passwords

 Reset passwords

 Archive users

HLA Fusion uses two user levels for added security and control of typing and screening results.

Supervisor can... Lab Technician can...

Modify all product configuration settings

Modify all product configuration settings—except to 
enable Auto Accept All and Computer Generated 
Serology for LABType and Micro SSP products

Save and Confirm analysis results Analyze data and save analysis results

Update reference files, such as catalogs 
and NMDP codes

(Only if authorized by the supervisor) - Update reference 
files, such as catalogs and NMDP codes

Archive catalogs Archive catalogs

Modify and delete session and sample data
(Only if authorized by the supervisor) - Modify and delete 
session and sample data
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Modify own & other user accounts Modify own account only

Change the Lab Profile Manage sample and patient information

Viewing the User List

The List User option displays a list of all users currently in the database, both active and retired. You can 
look up and select user profiles.

1. From the Main Menu, select Profile > List User.

2. Type in a name and click Search to search for current users.

3. Double-click to the left of a user entry to view the profile.

4. Click Close to return to the main menu.

Adding New Users

Supervisors can add new supervisor or technician level users. Technicians cannot add new users. Fields 
marked with an (*) are required.

1. From the Main Menu, select Profile > List User.

2. Click Add User to add a new user.

3. Enter new user information. 

4. Select the Active check box under the Role field to activate the user account. 

Note: If this is a lab tech profile and you want to allow reference file update and/or data 
management privileges for this user, select the appropriate check boxes.

5. Click Save to save the new user information and return to the main menu, or click Close to 
discard changes and return to the main menu without saving.

Editing User Profiles

Supervisors can edit the user profile of any user. Technicians can only edit their own profiles. Fields 
marked with an asterisk (*) are required.

1. To edit your own profile, select Profile > My Profile. 
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2. To select from a list of users to edit, select Profile > List User and double-click to the left of a 
user to select that profile. 

3. Edit user information.

Click Save to save user information and return to the Main Menu.

4. Click Close to discard changes and return to the Main Menu without saving.

Changing Passwords

Supervisors can change passwords for any user, but they must have the user’s old password. Technicians 
can change only their own passwords.

1. From the Main Menu, select Profile > My Profile.

2. In the user profile, click the Change Password button.

3. Enter the current and new passwords.

4. Click the Save Password button to change the password. Or, click Close to close and return to 
the main menu without changing the password.

Resetting Passwords

If a user loses or forgets their password, HLA Fusion can reset the password. The new password is the 
same as the user’s user name. Only Supervisors can reset a user’s password.

1. From the Main Menu, select Profile> List User and select a user.

2. In the user profile, click the Reset Password button.

3. Click Close to return to the main menu.

Changing User Privileges

Only Supervisors can modify a user’s privilege level.

1. From the main menu, select Profile> List User

2. Double-click to the left of a user to open their profile.

3. In the user profile, select the check box next to either Manage Data or Update Reference 
Files, or both, to give the selected user privileges for those activities within the Fusion 
application.

4. Click Close to return to the Main Menu.
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LLaabb PPrrooffiillee IInnffoorrmmaattiioonn SSccrreeeenn

Inactivating Users

Supervisors can inactivate users who are no longer using HLA Fusion. User information is still stored in 
the database, but the user is not able to log into the program.

1. From the Main Menu, select Profiles > List User and select a user to edit.

2. Clear the Active check box to deactivate the user.

3. Click Save to save user information and return to the main menu, or click Close to discard 
changes and return to the Main Menu without saving.

Note: If a User ID is still associated with analysis records, the User ID cannot be deleted.

Lab Profile

The Lab Profile menu displays the contact information for your lab, network information used by HLA 
Fusion, and NMDP contract lab codes. Most of this information is entered during installation, but can be 
updated at any time. Only supervisors can change the Lab Profile.

From the Lab Profile menu you can:

 Edit the Lab Profile

 Add, edit and remove Lab Codes

 Change the Network Path

 Change the Email Server Name
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Editing the Lab Profile

Laboratory information displays on most reports, and includes contact information for your lab. This 
information is initially entered during installation, and can be edited any time from the Lab Profile menu. 

Fields marked with an asterisk (*) are required.

1. From the main menu, select Profile > Lab Profile.

2. Edit lab profile information.

3. Click Save to save changes and return to the main menu, or click Cancel to return to the main 
menu without saving any changes.

Managing Lab Codes

Lab codes are used on NMDP reports to identify contract labs. Multiple lab codes may be entered and 
stored in HLA Fusion. You can select the lab code you wish to use when creating an NMDP report. Only 
the first three digits of a lab Code are used on NMDP reports; lab code descriptions are not included on 
reports.

1. From the main menu, select Profile > Lab Profile.

Add, edit or delete Lab codes:

 Click Add Lab Code to add a new lab code. Enter information into the new row.

 Highlight a lab code to be edited. Click Edit Lab Code to edit the lab code. 

2. Edit lab code information.

3. Highlight a lab code to be deleted.

4. Click Delete Lab Code to delete the lab code.

5. Click Save to save changes and return to the main menu, or click Cancel to discard changes 
and return to the main menu without saving.
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Utilities

HLA Fusion™ uses a variety of reference files for data analysis that need to be updated for new products, 
lots and revisions. You can also change many global product settings to customize analysis for your lab, 
and you can modify default system settings to reflect your personal or network file system.

Warning: Always use the latest reference files for analysis. Otherwise, analysis results may not be accurate.

Managing Catalog Reference Files

Catalog reference files contain all of the reaction-specific information needed for analysis, including the 
following:

 Bead and well specificities

 QC information

 Cut-off values

 Bead and primer information

Each new lot or revision of a product needs its own catalog file for analysis results to be accurate.

Updating Catalog Files from a Local or Network 
Drive

Lab supervisors can input new catalog files for use 
in analysis when new products, lots, or 
updates become available. Catalog files are 
also available on the One Lambda 
download site.

1. From the main or any of the product home 
pages, click the [Download] link, 
or from the main menu, select 
Utilities > Update Reference > 
Update Reference File.

The Update Reference File dialog 
box displays.
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If your serology information is outdated, or you have not imported it yet, a message like the one shown 
below is displayed. If you do not see this type of message, go to the next step. If you see the message, click 
OK to open the Serology Import dialog box.

Make sure the Catalog option is selected.

2. Using the file directory tree on the left, locate catalog files to be imported.

Note: To determine which catalog is the most recent available, HLA Fusion looks first at the lot 
number and then the revision number. An updated lot number gets flagged as the most 
recent version of a catalog, even if there is also an update to the revision number of the 
previous lot since you last downloaded catalogs.

3. Highlight the files you want to import, or click Select All to select all files listed.
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TTrraannssllaattee aalllleelleess OOppttiioonn

If you select a catalog to import that is in the old allele format, you are notified with a message. If you do 
not see this message, proceed to the next step. If you do see the message, select the translate option you 
want to use before going to the next step.

Note: If you select Yes or Yes All, the software will translate the old allele format into the latest 
format. For the Molecular products (LABType or Micro SSP), the software will drop the old 
format allele completely if it does not find a matching allele in the new format list. For 
Antibody products, if the software does not find a matching allele in the new format, it 
keeps the old format allele, but adds a colon.

5.  Click Yes, or Yes All to import the selected catalog files.

Note: Catalog import takes longer when you choose to translate alleles.

6. A confirmation dialog box displays import results, click Close.

7. Click Close to return to the Update Reference menu.

Imported catalog files can be used without restarting Fusion.

Updating Catalog Files from the One Lambda Download Site

 Product catalog files are available on the One Lambda download site 
(http://download.onelambda.com).

1. From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File. The Update 
Reference File dialog box displays.

2. Click Auto Update to open the One Lambda Catalog Updates Selection window.

3. Select the check box next to the files you want to import. Click the plus or minus signs on the file 
directory tree, to locate the catalog files for each product. You can also click Select All or 
Deselect All to select or clear all the check boxes at once.
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4. Click Import to import the selected catalog files.

5. When the confirmation dialog box displays import results, click OK.

6. Click Close and then Yes to return to the Update Reference menu.

Imported catalog files can be used without restarting Fusion.

Note: You can also click Go to OLI, click the links for the products and catalog files you want to 
import, and follow the download instructions.

If Auto Update does not respond, verify your network connectivity and that the URL you set 
for One Lambda in Utilities > URLs & Paths is correct.
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Updating Molecular Typing Reference Files

Reference files contain allele code and serology equivalent information used in analysis. It is important 
to update them regularly for accurate allele code and serology assignments.

From the Update Reference menu you can download the necessary files:

 NMDP codes

 Local codes

 Serology Equivalent files

Updating NMDP Codes from a Local or Network Drive

The National Marrow Donor Program (NMDP) provides a list of allele codes that can be used in 
molecular typing analysis. If you have a current list stored on your local or network drive, use this 
procedure to import it so HLA Fusion can access it. The most current NMDP code file is available on the 
NMDP download site.

1. From the main or any of the product home pages, click the Download link, or from the main 

menu, select Utilities > Update Reference > Update Reference File. 

The Update Reference File dialog box displays.

12. Select the NMDP option.
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13. Navigate to the NMDP file on a local or network drive, using the Import Directory tree.

4.   Click Import NMDP to import the selected file.

5. Click Close to return to the Update Reference menu.

Updating NMDP Files from the NMDP Website

Follow this procedure to import the NMDP list from the NMDP website.

1. From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File.

2. The Update Reference File dialog box displays.

3. Select the NMDP option.

4. Click Auto Update, which automatically imports the current NMDP file for use with HLA 
Fusion. Or, click Go to NMDP and follow the instructions for downloading an NMDP file from 
the website.

Note: If Auto Update does not respond, verify your network connectivity and that the URL you set 
for NMDP in Utilities > URLs & Paths is correct.

Creating a Local Code File

Local code files are created by individual labs; local codes are created to make ambiguous typing 
assignments easier to store and read. For example, ambiguities, such as B*1501/1501N/1502, can be 
condensed with a code to B*15AB for simpler record keeping.

1. Copy the local code template from the HLA Fusion CD to a local drive.

2. Use a text editor to edit the template and add code definitions.

3. Follow the example format, using a Tab to separate each field, and a slash to separate multiple 
values within a field:

 letter code <tab> numeric allele extension to which the code applies

4. Save the file as local_code.txt

See the next section, Updating the Local Code File, to import the file.
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Updating the Local Code File

After a Local Code file has been created, it must to be updated in HLA Fusion.

1. From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File.

The Update Reference File dialog box displays.

2. Select the Local Code option.

3. Use the Import Directory tree to locate and select the Local code file to be imported.

4. Click Import Local Code to import the selected file(s).

5. Click Close to return to the Update Reference menu.

Updating Serology Equivalent File from One Lambda Website

The Serology Equivalent file can be auto updated from the One Lambda download site 
(http://download.onelambda.com).

1. From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File.
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The Update Reference File dialog box displays.

2. Select the Serology Equivalent option.

3. Click Auto Update to open the One Lambda Catalog Updates Selection window.

4. Select the check box next to all files you want to import.

5. Click Import Serology to import the selected files. Catalog files are ready for use without 
restarting HLA Fusion.

6. A confirmation dialog box displays import results, click OK.

7. Click Close and then Yes to return to the Update Reference menu.

 If Auto Update does not respond, verify your network connectivity and that the URL you set for 
Serological in Utilities > URLs & Paths is correct.

Catalog Management and Information

Archive Catalogs

You can archive catalog files that are no longer used. The catalog information still exists in the database, 
but is not included in the list of available catalog files for analysis. Catalog files can also be restored for 
use in analysis.

1. From the Main Menu, select Utilities > Update Reference > Catalog 
Information/Management.
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2. Select the S (select) check box for the catalog files you want to archive, and click Archive .

3. When a pop-up message displays Data Saved, click OK.

4. Click Close to return to the main menu.

Note: When you import a new version of a catalog file, the system auto-archives the previous 
version.
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Un-Archive Files

Archived catalog files display an A in the Status column when you view the catalog list and the check 
box for Show Archived Catalogs is selected.

 From the Archive Catalog window, select the check boxes next to the catalogs you want to 
unarchive, and click Unarchive.

Viewing Catalog File Information  

You can view information about a catalog file and generate a report from the Catalog Information
menu. Catalog files displayed with an A in their Status column have been archived.

1. From the Main Menu, select Utilities > Update Reference >Catalog Management.

2. Click a column header if you want to sort the catalog file list.

3. Click Report to display a printable, exportable report of the currently displayed catalog 
information.

Deleting Catalog File Information  

You can delete a catalog file from the Catalog Management menu. Catalog files displayed with an A in 
their Status column have been archived.
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1. From the Main Menu, select Utilities > Update Reference >Catalog 
Information/Management.

2. Select the check box next to any catalog you want to delete.

3. Click Delete to remove the catalog information.

Reporting Catalog File Information 

You can view and report information about a catalog file and generate a report from the Catalog 
Information menu. 

1. From the Main Menu, select Utilities > Update Reference >Catalog Management.

2. Click a column header if you want to sort the catalog file list.

 (Optional) If you want a report in the old format, select the check box next to Old Format 
report.

3. Click Report to display a printable, exportable report of the currently displayed catalog 
information.

Associating Product Catalog Files and Luminex Templates

You can associate a catalog file with the Luminex template name used for a specific product. HLA Fusion 
automatically associates catalog ID and template names the first time you run the analysis for the 
product. After an association has been made, HLA Fusion automatically selects the catalog file associated 
with the template used in the CSV file when you start analysis. You can also manually add, remove, or 
change associations.

1. From the Main Menu, select Utilities > Catalog Template Association.

Add, remove or modify an association:

2. Add a New Association.

3. Select a catalog file.

4. Type in a new template name, or click Browse to select a Luminex template file (.lxt format) to 
associate with the filename.

5. Remove an Association.

6. Select a catalog file.

7. Select a template name and click Remove.

Modify an Association:
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1. Select a catalog file.

2. Edit existing template name(s).

3. Click Save to save changes.

4. Click Close to return to the Main Menu

Importing Allele Frequency Files (Demographic Frequency)

You can import allele frequency files to use in analysis based on demographics.

1. From the Main Menu, select Utilities > Update Reference Allele Frequency.

2. Select the Create Demographic Group option.

3. Click the browse button and locate Allele Frequency files.

4. Click Import.

When an Allele Frequency file is successfully imported, the groups it contains are listed in 
Demographic Group and Frequency in Database.

5. Click Save.
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If the header for the column of any allele frequency file you import is empty, the entire column is 
not imported into Fusion, regardless of any other data it contains. If columns are duplicated, Fusion 
gives you an error message and does not import the allele frequency file. 

The data contained in the Allele Frequency file may look similar to this graphic.

Updating Allele Frequency Files (Demographic Frequency)

You can modify allele frequency files before using them in analysis based on demographics.

1. From the Main Menu, select Utilities > Update Reference >Allele Frequency.
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2. Select the Update Alleles and Frequencies option.

3. Click the browse button and locate the Allele Frequency file you want to update.

4. Double-click on the file, or click Open in the browser window.

5. Do any or all of the following to modify the file:

 Add/delete alleles

 Delete existing demographics

 Change the allele frequencies

 Convert allele format

6. Click Translate Alleles

7. Click Update.

8. Click Close.
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Managing CREG List Information

You can modify existing CREG lists or create new ones for use in PRA and Single Antigen LABScreen, 
FlowPRA, LAT, or LCT analysis. Take the following steps to create or modify a CREG list:

1. Select Utilities > Update Reference > CREG Information Management. 

The CREG Management window displays.

2. Select an existing CREG group from the CREG Type drop-down list, or Enter a name for a new 
group in the New CREG Type field.

Do one of the following:

 Enter new or modify existing information in the Group Name and/or Group Detail fields 
and click Save.

 Highlight a row of existing group information, and click Delete Group.

3. When you have completed CREG group creation or modification, click Close.

Note: Please verify your data before saving, and please do not mix alleles with the older 
nomenclature format with alleles in the newer format within the same CREG table.
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Changing Product Configuration Settings

Changes to product analysis settings apply only to samples not previously analyzed. Previously analyzed 
samples must be re-analyzed for the changes to be applied.

From the Product Configuration menu you can

 Change Micro SSP product configuration

 Change LABType product configuration

 Change product settings for LABScreen Mixed analysis

 Change antibody screening analysis settings

 Change default negative serum values for LABScreen analysis

Changing Molecular Product Configuration

Changes to LABType and Micro SSP analysis settings apply only to samples that have not yet been saved 
or confirmed. To change analysis settings for previously saved or confirmed samples, you must change 
the settings from the product analysis window and re-analyze the sample.

1. From the LABType or Micro SSP home page click Edit, or select Utilities > Molecular 
Product Configuration >Molecular Analysis Configuration from the HLA Fusion main 
menu.

2. Select either LABType or Micro SSP from the Product Type drop-down menu.
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3. Change configuration values as needed.

 Save Force 1 Pairs stores force 1 pairs in the database during analysis. The force 1 pairs are 
also displayed in reports that contain this information.

 Allow Auto-Accept All can only be selected by someone with Supervisor user privileges, 
and allows you to select a button on LABType session summary to accept the batch analysis 
results for all samples.

 Computer Assigned Serology can only be selected by someone with Supervisor user 
privileges, and automatically populates LABType and Micro SSP analysis serology assignment 
fields, as well as stores results in the database. If this is selected, a warning message displays 
as a reminder that the assignments are estimates, and should not be accepted without 
verification.

4. Click Save to save changes.

5. Click Close to return to the Update Reference menu.
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Creating a Combined LABScreen Session Catalog

To run a Class I and Class II combined LABScreen analysis session, create a combined catalog to use for 
your session. You must use a Class I catalog file and a Class II catalog file that have the same positive and 
negative control beads, but do not have any other beads in common.

1. Select Utilities > Antibody Product Configuration from the HLA Fusion main menu.

2. Click Create Combined Products to open the Combined Products menu.

3. Select the first product catalog to be combined and click 

4. Select the second product catalog to combine and click .

The new catalog file name appears at the bottom of the selection menu.

5. Click Save to save the new combined catalog file for use in LABScreen analysis.

 Optional: Click Clear to reset the selections and start over.

6. Click Close .



One Lambda, Inc. | A Thermo Fisher Scientific Brand   HLA Fusion Version 4.0 User Manual

HLAF-MAN-v4.0.0-EN-00, Rev 0 (HLA Fusion User Manual v4.0) 324

SSeettttiinngg ddeeffaauulltt nneeggaattiivvee sseerruumm vvaalluuee

LLAABBSSccrreeeenn MMiixxeedd PPrroodduucctt ccoonnffiigguurraattiioonn

Changing LABScreen Default Negative Serum 

Negative control sera can be adjusted or added for each product or lot. You can change the trimmed 
mean fluorescence value for each bead individually.

1. Select Utilities > Antibody Product Configuration from the HLA Fusion main menu.

2. Click Set Default Negative Serum Value to open the Default Negative Serum Value screen.

3. Select a catalog file.

4. Select an existing negative serum, or

5. Select Add New NS Name from the pull-down menu to 
create a new negative serum.

6. Type a name for the new negative serum into the Current 
NS field.

7. Edit Default NS values for the desired beads.

8. Click Save to save the changes.

9. Click Close.

Changing LABScreen Mixed Product Configuration

You can change LABScreen Mixed analysis positive and negative 
threshold settings for each product or lot. The new cutoff threshold 
values are used in every analysis session for that product or lot.

1. From the LABScreen home page click Edit, or select 
Utilities > Antibody Product Configuration from the 
HLA Fusion main menu.

2. Click Set Mixed Product Configuration to open the 
LABScreen Mixed Configuration menu.
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3. Select a product catalog from the Catalog ID drop-down list.

4. Edit threshold values. For LABScreen Mixed catalogs, the threshold values can be set at the bead 
level.

5. Click Save to save values.

6. Click Close .

Changing Antibody Screening Analysis Configuration

Changes in the antibody screening analysis configuration are made by product type and apply only to 
sessions analyzed after the changes were made.

1. From the LABScreen, FlowPRA, LAT or LCT home page click [Edit], or select Utilities > 
Antibody Product Configuration from the HLA Fusion main menu.

2. Click Set Analysis Configuration to open the Analysis Configuration Settings menu.

3. Select a product type from the Product Type drop-down list.

4. Change values as needed.

5. Click Save to save values.

6. Click Close.
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Importing NS Files

Negative Serum (NS) files can be imported to be referenced during analysis.

1. From the Main Menu, select Utilities > Antibody Product Configuration.

2. Click NS File Import to open the NS File Import menu.

3. Click the browse button to locate and select NS files.

4. Click Import NS File.

When an NS file is successfully imported, it is listed in Existing NS Files.

5. Click Close to return to the Update Reference menu.
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Choosing General Settings

You can set a number of general system settings, including printer defaults and URLs and Paths.

1. Select Utilities > General Settings from the HLA Fusion main menu. The General Settings 
dialog box is displayed.

2. Use the drop-down menus, or select check boxes to make your selections on this dialog box.

3. When you have made all of your selections, click Save.

Printer Defaults

From the Printer Setup tab on the General Settings dialog box, you can select settings such as default 
printer and paper size, which will be in place when you print reports or do a print screen.

1. Select Utilities > General Settings, and click the Printer Setup tab.

FFuussiioonn GGeenneerraall SSeettttiinnggss
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2. Select from the following options for both the Print Screen and Print Report panels of the 
dialog box:

 If you want to see a print preview or print report dialog each time you print, make sure the Yes
option is selected. Otherwise, select No.

 If you do not want to select a printer each time you print, select the default printer and paper 
size from the drop-down menus.

Note: This default printer configuration may be overwritten by the specific page properties of 
certain reports.

3. Click Save .

Setting HLA Fusion Default URLs and Directory Paths

The URLs & Paths option under the General Settings menu allows you to set the default URLs for OLI 
and NMDP websites to download reference and catalog files, and product updates. This option also 
allows you to set the directory path where HLA Fusion, by default, stores catalogs, session/batch files, 
reports, etc. Modifying URLs or paths ahead of time allows you to avoid having to browse for files each 
time you need them.

1. Click [Edit]on the right side of the General Configuration panel of the HLA Fusion default home 
page, or select Utilities > General Settings from the HLA Fusion main menu.
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Select the URLs tab or the Paths tab.

2. Enter a URL and verify it works by clicking .For paths, use the browse button to locate 
the directory you want to use for the specified purpose (e.g., where you want to store reports when 
they are generated).

3. Click Save .

Activating Products

The Products Selection option on the Utilities 
menu allows you to activate or de-activate the 
various OLI analysis products that may be used 
with HLA Fusion.

1. From the Main Menu, select Utilities > 
Products Selection.

Select or clear the check box next to the 
product(s) you wish to activate or de-activate.

Click OK .
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Software Validation

The HLA Fusion software has functionality to help with the validation process required by Labs, Clinics, 
and hospitals seeking to comply with GCP, GLP and GMP. Validation of the HLA Fusion software for 
your lab environment for regulatory or performance reasons, can be automated by using the IQ 
(Installation Qualification) and OQ (Operational Qualification)options from the Utilities > Validation
menu. Your lab may choose to run these as a standard regulatory validation process, to help troubleshoot 
issues, or to provide information to prepare for a software upgrade.

IQ (Installation Qualification)

The IQ process assists you with installation qualification of HLA Fusion software by providing a built-in 
function. Once the Installation qualification completes, a results report is generated, which you can save, 
print or export to Excel.

Note: If your IQ results concern you, export them to an Excel file and e-mail the file to OLI 
customer support.

1. From the Main Menu, select Utilities > Validation > IQ.

The validation test runs. When it is complete, a report is displayed, with the following categories of 
data:

 Systems Information (e.g., operating system)

 Environment (e.g., directory path where the HLA Fusion program files are stored)

 URLs (e.g., the URL for the catalog download site)

 Database Information (e.g., name of the database)

 Number and types of files installed (e.g., dll)

 Lab Information (e.g., name and address of your lab)

 Analysis Configuration for each product (e.g., low bead count for LABType)

2. Choose to save the report, preview it, print it, or export it to Excel.
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Example IQ Report

IQ (Installation Qualification)

The IQ process assists you with the installation qualification by providing a built in functionality. This 
can be performed only if you have completed the IQ process as explained above. The installation 
qualification goes through a series of QA process to analyze pre-loaded batch and catalog, and compares 
them with pre-defined results.

Once the Installation validation completes, a results report is generated that you can choose to save, print 
or export to Excel. If the results concern you, export them to an Excel file and email this file to OLI 
Customer Support.

 From the Main Menu, select Utilities > > Validation > Installation(IQ).

The validation test runs. When it is complete, a report is displayed, with data regarding the operation of 
HLA Fusion in your computer environment.


